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I remember reading a Nicholas Carr article ‘IT
Doesn't Matter’ back in 2003, where he said IT is
commoditized and cannot provide a competitive
advantage. Now, even Carr is changing his tune. I
say he is about half right.

But will IT alone help? I don’t think so. IT alone
can no longer provide a competitive advantage
unless it is combined with smart people and busi-
ness processes. The giant companies of the world
have proven that IT is a key ingredient of the win-
ing business success recipe.

What's the recipe of a winning business?
Individual improvements and innovation is not sus-
tainable; over time it will be copied. The key is to
keep improving and innovating, better and faster,
and then no one can catch up.

How many enterprises look at their businesses
this way? Take a look at the stock exchange. The
Sensex is now on a roller-coaster ride. Now, having
said that, are we equipped to handle such large vol-
umes of transactions? Remember Tokyo Stock
Exchange? It just came down, couldn’t scale up to
handle large volumes of online trading. Are we
equipped to scale up?

On the other hand, the BPO industry is doing
well, what with companies doing an impressive job
of keeping their cost edge, thanks to the improve-
ment in management and technology. The sector is
one of the fastest adopters of technology to keep a
competitive edge. However, customers of these
companies, the foreign companies, are demanding
more and more for less. They want more sophisti-
cated work and the quality metrics among domes-
tic companies are not constant. Can these compa-
nies hone their competitive edge before the for-
eigners find a better alternative to India?

When a top official of the government of
Punjab said Chandigarh was going to be the next IT
hub of India, I was thinking of all the so-called ‘IT
hubs’ in India. There seems to be competition
between the states of India to create a ‘Bangalore’
in every corner of India.

The surprising fact is that it's working. It was
pleasant to see the IT parks in Punjab; similar parks
are being built across the nation. This reminds me
of the way there is a shopping mall in every corner

of all major cities in India. We seem to overdo cer-
tain things in all aspects and forget to do our home-
work well. Is this going to be the case with the IT
parks also? Are these technology ‘giants’ compro-
mising on the quality of service to create such a
multi-locational presence in India? We’ll have to
wait and watch how long this goes on.

The survival of business is all about being dif-
ferent and using technology to create a competitive
edge. This will set you apart. How is this possible in
such a dynamic market? Does technology alone
provide this ‘edge’? Or, is it a combination of vari-
ous factors aligned with technology that provides
it? Some of the key factors are innovation and
thinking out-of-the-box.

Keep asking this question—is IT keeping up with
my own innovative ideas? The new question today
is not ‘does IT matter?’ but ‘can IT provide a base for
my innovative ideas in business?’

Editorial
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being different and using technology to

create a competitive edge.
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FREE
Counter-Strike 2D 0.1.0.4
Counter-Strike 2D is a freeware
clone of the well known game
Counter-Strike. Experience the most
famous multiplayer game ever in a
top-down 2D perspective.

PCSX2
PCSX2 is a PlayStation 2 emulator
for Windows and Linux. The PCSX2
project attempts to allow PS2 code
to be executed on your computer,
thus meaning you can put a PS2 DVD
or CD into your computers drive,
and boot it up!

Soldat
Soldat is a
unique side-
view
multiplayer action game. It takes the
best from games like Liero, Worms,
Quake and Counter-Strike and gives
you fast action gameplay with tons
of blood and flesh.

Warsow
Warsow is a free standalone first
person shooter game for Windows
and Linux. It is based on the Qfusion
3D engine (a modification of the
Quake 2 GPL engine), and aimed on
the competitive scene, or the e-
sports community. Warsow is
developped under the motto “by
gamers for gamers” by a team
coming from all kinds of gaming
backgrounds.

DEMOS
Devil May Cry 4

In Devil May Cry 4 Capcom’s
gunslinging demon hunter Dante is
back, but this fourth chapter will
introduce a new hero, Nero, who
possesses a demonic arm that can
pull in enemies or use them as
projectiles. This demo allows you to
play ten minutes of Devil May Cry 4
gameplay along with a boss battle.

SimCity Societies
From futuristic metropolises and
fantastical haunted cities to obedient
authoritarian
states and
devout
contemplative
towns—what
kind of city to
create is up to
you. Choose
between
creative modes
or strategic modes that will
challenge you to keep your citizens
content and your budget balanced.
With this accessible, innovative and
versatile city-builder, you can choose
from more than 500 buildings to
create the city of your dreams.

Gaming
ESSENTIALS
.net Framework 2.0
You'll need the .net Framework to run
many .net-based applications,
including the Digit Software Archive

µTorrent 1.7.7
µTorrent is an efficient and feature rich
BitTorrent client for Windows sporting
a very small footprint. It was designed
to use as little cpu, memory and space
as possible while offering all the
functionality expected from advanced
clients.

Avast Home Edition 4.8
Avast Home Edition is a

Free, complete ICSA
certified antivirus
software for home
(non-commercial)

use. You need to
obtain a registration key

by visiting www.avast.com.

Comodo Firewall Pro
3.0.25.378
Comodo Firewall constantly monitors
and defends your PC from internet
attacks. 

Foxit Reader 2.3
Foxit Reader 2.3 is a free PDF
document viewer and printer, with
incredible small size, breezing-fast
launch speed and amazingly rich
feature set. 

Free Download Manager 2.5
build 758
Free Download Manager (FDM) is a full-
featured download accelerator and
manager. 

Irfan View 4.10
IrfanView is a fast and simple image
viewer and editor that supports all
major graphic formats.

Java(TM) 2 Runtime
You'll need the Java runtime to run
applications based on Java

K-Lite Mega Codec Pack 3.9.5
With the K-Lite Codec Pack you should
be able to play all the popular movie
formats and even some rare formats.
This package is mainly for power users
and people who do their own
encodings..

Opera 9.50
The new Opera 9 has
BitTorrent, Improved
rich text editing, Site
preferences, allows
you to add your
favorite search
engines, content

blocker, thumbnail preview, Widgets,
and also the old useful features like
pop-up blocking, tabbed browsing,
integrated searches, and more
.

Silverlight
Silverlight is a cross-browser, cross-
platform plug-in for delivering the next
generation of media experiences

Spybot Search and Destroy
1.52
Spybot - Search &amp; Destroy can
detect and remove a multitude of
adware files and modules from your
computer.

VLC Player 0.8.6h
VLC (initially VideoLAN Client) is a
highly portable multimedia player for
various audio and video formats
(MPEG-1, MPEG-2, MPEG-4, DivX, mp3,
ogg, ...) as well as DVDs, VCDs, and
various streaming protocols. It can also
be used as a server to stream in
unicast or multicast in IPv4 or IPv6 on
a high-bandwidth network.

WinRAR 3.71
WinRAR is a 32-bit Windows version of
RAR Archiver, an archiver and archive
manager. RAR files can usually
compress content by 8 percent to 15
percent more than ZIP files.

UPDATES AND ADD-ONS
Avast Update
This Avast update will update your
Avast antivirus signatures

AVG 8.0 Updates
The latest updates for AVG AntiVirus

Digit Software Archive 2006
Beta
This is a Beta version of Digit Software
Archive. It provides you a convenient
search tool to locate the software you
are searching for in the of Digit's CD
DVD, starting July 2005. Note: This
version of Archive requires you to have
.NET framework 2.0 installed. Uninstall
the previous version of Digit Archive if
installed before October 2006 before
installing this version. 

Irfan View 4.10 Plugins
All the IrfanView plugins you'll ever
need

McAfee Virus Definition
Updates
The latest updates for McAfee
AntiVirus

Norton AntiVirus Virus
Definitions Update
Contains the latest free virus databases
for Norton AntiVirus Virus (NAV)

Spybot S&D Updates
This updates the detection rules. 

Kaspersky Internet Security
7.0 Update
The latest updates for Kaspersky
Internet Security 7.0

MULTIMEDIA
AIMP 2.11
AIMP is a free audio player which sup-
ports a variety of audio formats.

Blender 2.46 for Linux
Blender is the free open source 3D con-
tent creation suite.

Daniusoft DVD Video
Converter Pack 1.4.0.0
Daniusoft DVD Video Converter Pack is
the ultimate converter suite which con-
sists of 4 useful products: Video
Converter, DVD Ripper, Audio Converter
and DVD Copy

n foobar2000 0.9.5.3
n Handbrake 0.9.2 for Linux
n YafRay 0.0.9
n Fraps 2.9.4

INTERNET
n Firefox 3 Release Candidate 3 for Linux
n Firefox 3 for Windows
n HLSW 1.2.1
n K-Meleon 1.1.5
n Miranda 0.7.7
n Pidgin 2.4.2
n NetDrive 1.0.0.28

Gtalk Labs Edition
Features of the Google Talk Gadget on your
desktop (emoticons, group chat, and
more!). 

SYSTEM
n Ad-Aware 2008 7.1.0.8
n Adobe AIR
n a-squared Free 3.5
n Avira AntiVir Personal
n Microsoft Baseline

Security Analyzer 2.1
n Microsoft Malicious

Software Removal Tool
n Microsoft Zune 2.5 x64
n Microsoft Zune 2.5 x86
n RocketDock 1.3.5
n SUPERAntiSpyware Free Edition
n ThreatFire

Gridmove 1.19.42
GridMove is a program that aims at making
windows management easier. 

JetAudio Basic 7.1.1.3101
JetAudio is integrated multimedia soft-
ware made up of a single compact rack.
Not only does it play various music and
video files, it also has features such as
CD burning, recording, and conversion to
other file formats. 

MagicDisc Virtual
CD/DVD-ROM
MagicDisc is freeware. It is very helpful
utility designed for creating and managing
virtual CD drives and CD/DVD discs.

Microsoft Pro Photo Tools
Microsoft Pro Photo Tools provides a set
of photography tools for photographers
such as to view, add, change, edit and
delete common metadata properties for

digital photos or pictures, and captures
RAW images. 

DivX Converter
Convert nearly any video to a DivX® video
by simply dragging and dropping it onto
the DivX Converter. To convert MPG, VOB,
TS and SVCD files to DivX with DivX
Converter, add the optional MPEG-2/DVD
Plug-in for $9.99.

Spyware Doctor 5.5
for Windows
Spyware Doctor is a top-rated malware
& spyware removal utility that detects,

removes and protects your PC from
thousands of potential spyware, adware,
trojans, keyloggers, spybots and track-
ing threats. Protect your privacy and
computing habits from prying eyes and
virtual trespassers with the help of
Spyware Doctor.

WindowBlinds 6.1 build 55
Customize the look and feel of Windows
XP and Windows Vista with
WindowBlinds. WindowBlinds can 'skin'
your title bars, push buttons, Start bar,
radio buttons, and nearly every other
part of Windows. There are thousands
of freely available skins to choose from.
Use WindowBlinds to make Windows
look like another operating system
(Mac, Linux) or give it your own unique
look and feel. 

Tools

Regulars
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HD
Big Buck Bunny

Kung Fu Panda

Entertainment

Fedora 9 DVD
Fedora is a Linux-based
operating system that provides
users with access to the latest
free and open source software,
in a stable, secure and easy to
manage form. We strongly
believe in the bedrock
principles that created all the
components of our operating
system, and because of this we
guarantee that Fedora will
always be free for anybody,
anywhere, to use, modify and
distribute.

PERSONAL
eHour 0.8.2
eHour application was
designed to be a Web-based
time tracking tool for
consultancy companies and
other project based businesses.  

Microsoft WorldWide
Telescope
The WorldWide Telescope
(WWT) is a Web 2.0
visualisation software
environment that enables your
computer to function as a
virtual telescope—bringing
together imagery from the
best ground and space-based
telescopes in the world.

Expressivo 1.4.1
Expressivo is a utility that lets
you listen to documents, e-
mails or Web pages. What’s
great is that it allows you to
convert text to MP3 files for
listening later with your
portable MP3 player.

Nero Linux 3.5.1.0
Based on the award-winning
current Nero Burning ROM
platform, Nero Linux 3 is the
most powerful and versatile
burning application available
for Linux, and the only

application to offer Blu-ray
Disc and HD DVD data burning
support.

SuperCat 4.4
SuperCat lets you catalog all
your disks, so you'll never lose
a file again. SuperCat 4.4 is
both easy to use for novice
users, and has powerful
features required by
professional users like network
administrators.

TOWeb 2.6.0.523
TOWeb is an easy-to-use
software for persons and
organizations wishing to
quickly create a Blog or a Web
Site without any Web
designing skills, without
dealing with Web
programming stuff, without
using a retouching software
for their pictures and without
being left alone in front of a
blank page with dozens of
options. 

DEVELOPERS
Adobe AIR SDK
The Adobe AIR SDK provides
the tools you need to package
and deploy Adobe AIR
applications, if you prefer
working with a text editor or
another development
environment.

Microsoft MSDN
Library
MSDN Library provides access
to essential programming
information, including technical
reference documentations,
white papers, software
development kits and code
samples necessary to develop
Web services and applications.
This is an updated version of
the MSDN Library for Visual
Studio 2008 Beta 2.

Microsoft Virtual PC
2007 SP1 x64
Virtual PC 2007 is a powerful
software virtualization
solution that allows you to
run multiple PC-based
operating systems
simultaneously on one
workstation, providing a
safety net to maintain
compatibility with legacy
applications while you
migrate to a new operating
system. It also saves
reconfiguration time.

Microsoft XNA Game
Studio 3.0 CTP
This is the first Community
Technical Preview (CTP) of XNA
Game Studio 3.0, giving you
the ability to build games for
the entire family of Zune
media devices.  This feature
gives you access to the
majority of the XNA framework
APIs while retaining a
seamless sense of integration
with the Zune media
experience.  

OpenSwing 1.6.4
OpenSwing is an open-source
suite of advanced graphics
components based on Swing
toolkit—these components
are more sophisticated of
those provided with Swing
and can be manipulated
directly inside the UI
designer of the IDE.
OpenSwing is also a
framework that provides
data binding mechanism
between components and
data model, based on the
MVC paradigm. Data model is
based on Java Beans (POJOs)
and it is supported in all
OpenSwing components, for
example components
container or Grid control.

3DPaintBrush
3DPaintBrush is an exciting
3D software that provides
you with amazing near
photo-realistic rendering
quality images and
animated movies starting
from your 3D models, in
real time.

Visual Paradigm
Suite 3.3
Visual Paradigm offers an
award-winning line of
standards-based visual
modeling platforms that are
easy-to-use, powerful and
yet selling at an unbeatable
price. Go to www.visual-
paradigm.com to get your
license keys.

DRIVERS 
ATI Catalyst 8.5
AMD’s  ATI Catalyst graphics
and HD video configuration
software delivers
unprecedented control of
performance and visual
quality with ATI Radeon
graphics processors.

DirectX 9.0c June
2008 Redistributable
Microsoft DirectX® End-User
Runtime provides updates to
9.0c and previous versions of
DirectX.

NVIDIA Forceware
175.16 for Windows XP
ForceWare software for
NVIDIA GeForce graphics
processing units (GPUs)
provides you with the best
combination of performance,
quality, and features

Realtek HD Audio
Codec 1.95
Audio Codec package for
Realtek's HD Audio. 

Productivity

Plus
25

Wallpapers

Plus
75

Wallpapers



taste technology at www.thinkdigit.com

Online

FEATURED TUTORIAL FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))

I've already posted my tutorials here. But as per
request I'm creating a new thread so that its easy for
new visitors to find what they are looking for.
This script will get get rid of all new weird theme and
bring back good old Kirsch theme. It also removes all
the ads and Think digit header. This is how it looks:
New theme: Webber. For Opera
IRC ppl gets special Evo theme.. 

Tutorial for Firefox:
1. Get stylish extension form here
2. Get the stylish script form here. Click the button

that says "load into Stylish". A window will pop up.
Click save.

3. Now reload the browser 

Update: I'll update the script time to time. In order to
update your script do following:
Go to manage styles (right click stylish icon at bot-
tom) > Find updates and update all. Thats it!

Without Stylish Extension:
1. Get the stylish script form here. Click "Show code",

copy and paste the code into a text editor and
name it some_file_name.css.

2. Save this file to your firefox profile > Chrome
directory. 

For windows its stored in \Documents and
Settings\user_name\Application
Data\Mozilla\Firefox\Profiles\xxxx.default\chrome. 
Vista: C:\Users\username\AppData\Roaming\Mozilla
For Linux, its
/home/<user>/.mozilla/firefox/xxx.default/chrome
3. In the chrome directory, create a file named

userContent.css. Edit the file and add the follow-
ing:

@import url("some_file_name.css");
Here some_file_name.css is the css file you have
saved before. Save it, restart Firefox.
For more visit:
http://www.thinkdigit.com/forum/showthread.
php?t=88205

18-05-2008, 
11:01 PM

amitava82
Alpha Geek

Join Date:
Jul 2004
Location: Rolling
Meadows, IL, US
Posts: 794

HHOOWW TTOO:: GGeett oolldd KKiirrsscchh ffoorruumm tthheemmee bbaacckk!!

Buying
decisions made

simple: check out
all the categories

in the Product
Review section
before buying

Check Out The All New ThinkDigit.com

India’s
largest and most

influential tech
forum continues

as before

Find the
best tech blogs

online, and
submit your own

blog for
consideration

Archives of
all past articles of

your favourite
tech magazine,

available online,
for free!

Quick and easy
registration process
that gives you access
to cool features

Exciting video content
from across the globe

Choose to download
from only the best
software on the Net

Buy and sell tech
products in the Digital
Marketplace

The all new Tech Q&A
Section allows anyone
to ask our panel of
experts questions.
Satisfaction
guaranteed!



12 DIGIT JULY 2008

A satellite for youth
India is all set to launch a satellite next year, which will be
sent into space to conduct experiments designed by
students from Indian and Russian universities. This satellite
is a brainchild of APJ Abdul Kalam and will conduct
experiments in physical sciences and aeronautics

Dangerous Liaisons
If you have visited a site ending with .hk, be careful
to scan the computer with anti-virus software.
According to a survey by McAfee 19 per cent of such
sites are harmful, making hk Web sites the top in the
list, up from 28th riskiest last year

The name Bill Gates
has been
synonymous with

Microsoft ever since the
company was founded.
He was the face of the
company and the one
who was at the receiving
end of both tech love
and monopoly lawsuits.
Now, with his
resignation from the
company on June 27, an
era is coming to an end—
both for Microsoft as
well as the tech world.

Starting out as a
partnership between an
engineer and a Harvard
drop out, making BASIC
compilers on Altair
machines, Microsoft
went on to become the
technology giantwe
know today, with Gates
reigning as the world’s
richest man for a
number of years. In the
course of the journey,
Microsoft earned its fair
share of controversies,
loyal supporters and
violent detractors. It has
seen its once
unchallenged hegemony
challenged by both
proprietary Apple, and the
open source Linux
movement. In the era of the
Internet, it has been
upstaged by smarter and
nimbler rivals like Google.
However, depite all these
deficiencies and failures,
Microsoft will still remain
the top dog of the tech

world for a very long time,
riding on the momentum of
products like Windows XP
and Office.

As a person, Gates does
not inspire fanboy-ism the
way Apple’s iconic CEO
Steve Jobs does. He no
longer has the Midas touch,
as Google’s Page and Brin
seem to have now. Neither
he nor Microsoft has

innovated anything terrific,
but what sets him apart
from the flock, especially
during the early days of
personal computing was the
ability to think like a
businessman and bring
complex technology to the
lives of the common man—
who never ventured beyond
operating the television.
Microsoft’s monopoly has

had another beneficial
effect—standardisation.
Before Microsoft took the
tech world by storm, there
were too many conflicting
standards, both in
hardware and software,
with little or no
interoperability between
them. Microsoft imposed
its own set of standards,
even though they turned
out to be flawed, and
made the world take
notice of the benefits of
different devices and
software being able to
talk to each other. 

After retiring from
day-to-day activities at
Microsoft, Gates plans to
spend most of his time
and money in
philanthropic work with
the Bill and Melinda
Gates Foundation. With
assets of nearly $65
billion, and generous
help from Warren Buffet,
this foundation is the
largest ever, in terms of
funds at disposal. The
foundation is engaged
mostly in tackling

diseases like malaria, AIDS
and tuberculosis in the
third world and has
significant media coverage.
Gates is also a frequent
visitor to India, and
recently gave $27 million
dollars in grant for
fighting HIV / AIDS in
India. Ultimately, Bill Gates
might be remembered
more for his philanthropic

Enter
FREE BILLY

Bill Gates Steps Down

n Microsoft to stop selling Windows XP operating system to retailers and computer makers soon n PS3 Network Will Offer News, Weather, Video
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activities, than for being at
the helm of the largest
tech monopoly in recent
years. And that’s a legacy
he would be more
comfortable with.

APPLE NEEDS DOCTORS

Worm
Hitting OSX

A pple users are known
for their pride when
it comes to anything

related to the company. Even
though any hardware that
comes with the Apple logo
costs an arm and a leg,
people have all sorts of
excuses on why it’s better
than others in the market.
Security is one of the most
touted reasons why people
would go with Macs than be
hobbled by Windows. The
plot however, has changed.

One reason for the Mac’s
low susceptibility to
malicious attacks is because
the OS is based on the UNIX
kernel, which is more stable
than Windows’ proprietary
architecture. Also, the Macs
with single digit market
share did not prove to be a
very attractive target for
professional hackers, who
usually aim at inflicting
maximum damage. In the
last two years, however,
things have changed.

The visibility of Apple
has increased in the
personal computing space.
The iPhone’s stunning
success has also contributed
a lot to the visibility of
Leopard, its operating
system. Restricted till now
to the personal segment,
Macs are being used in the
enterprise segment too. In
the server segment, for long
dominated by UNIX and
Windows, Apple has
released a slew of its own
products. Some of them are
used in mission critical role
in organisations, which has

raised the stakes a lot
higher in the cat-and-
mouse game played by
security researchers and
cyber criminals.  

The latest in the series of
malicious threats targeting
OSX is a Trojan horse named
ASthtv05. Analysts from
SecureMac, a security firm
has classified the Trojan as
critical and issued an all
points alert for it. This
Trojan can compromise the
latest patched versions of
Leopard and virtually take
control of the infected
computer. It gains
administrator privileges after
the user opens an infected
file. It then opens ports in
the firewalls, log keystrokes,
transmits usernames and
passwords, takes pictures
with the iSight Web camera
and turns on file sharing. It
also hides in the background
and might turn off system
logging, so that the user has
no way of knowing that the
computer is infected.

Uncovered in a hacker’s
forum, the source code of
this malware is freely
available. This has led
researchers to believe that
several variants of the
exploit code may ultimately
be found in the wild.
Currently Apple has not
said anything about this
threat, though SecureMac’s
security software can
disable the Trojan. However,
the researchers remained
confident that Apple would
release a patch for the
exploit as soon as possible.

Till then, Apple users
are advised to bite carefully.

HELP AT HAND

Browser For
The Autistic 

Autism is a condition
that prevents a
person from

enjoying effective social

Security Watch

Trouble in the router
Problem: 
Zlob, or DNSChanger is a
Trojan that uses a simple but
very powerful method to
divert traffic from infected
computers. This exploit
bypasses the operating system
altogether and changes the
DNS settings on the routers,
both wired as well as wireless
so that all traffic goes through
the servers of the attackers.

Zlob, one of the most
common trojans to infect
Windows machines is hidden
as a video codec that has to be
downloaded to watch video on
certain sites. Once the
malware infects the system it
looks for a attached router and
tries to guess the username
and password from a list of
matching combinations. Since
most users hardly ever bother
to change these factory
settings more often then not
the Trojan manages to sneakily
gain control of the router and
do its dirty work. 

All unencrypted traffic
that is either entering or
leaving the user's network
becomes vulnerable to
snooping and malicious
attacks. And the worst part of
this is that the user would not
even know of the security hole,
because even an anti virus
sweep on the infected system
would not uncover the worm
on the router. Also, in a
network, traffic can be
hijacked even if one computer
is compromised.

Solution:  
The solution to this exploit is
simple: users should change
the username and password of
the router. It is advised you
install latest system updates.
And for users who suspect that
their configurations have been
changed, they should go back
to the router's default
configuration.   

n Mobile phone operator Orange teams up with GotWind to produce charger powered by dance energy n Google announces Google Gadgets for Linux

NVIDIA CUDA
What is CUDA?
CUDA or Compute Unified
Device Architecture is a
software development kit, to
write C code for execution on
the Graphics Processing Unit
(GPU). It is developed by
NVIDIA and is an alternative
to Stream. 

Why is CUDA important?
CUDA is built to take
advantage of the processing
power of graphics cards, to
run resource hogging
applications. Doing this,
speeds up processing without
putting too much strain on the
CPU, keeps costs down, and
making the whole system
more energy efficient.

Where do CUDA-enabled
systems come handy?
Apart from games, CUDA-
enabled systems have wide
scope in applications related
to computational fluid
dynamics, digital content
creation, life sciences,
imaging, video and audio,
electronic design automation,
oil and gas, finance and
graphics among others.

Who can take advantage of
CUDA?
Anyone with graphic cards from
the G8X series onwards, can
take benefit of the CUDA SDK.
These include the GeForce,
Quadro and Tesla lines.

How can developers access
the SDK?
The CUDA SDK is available for
free download from NVIDIA's
Web site.

Which gaming components
have been successfully
implemented using CUDA?
The physics engine PhysX that
is used by a number of games
like Mass Effect and Unreal
Tournament III has been
ported for use in CUDA
compatible cards. Besides,
porting other games for
CUDA, new titles are expected
shortly.
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interaction with others. It’s
a brain development
disorder that may be
genetic, and requires life
long management. Among
other primary symptoms,
patients with this condition
are bewildered by choices
and wide variety of media,
something which is
ubiquitous when using a
computer and going online.
Being unable to access the
Net, sit in front of a
computer, or even a
television, is a pretty big

millstone and forces them
to be even less normal than
they are before. Since most
patients are diagnosed with
autism as children, it
means a life long aversion
to essential technology.

For parents and well-
wishers associated with
treatment of autism, there
is hope. A special browser
has been designed for
children suffering from
autism, which eases their
introduction to the
Internet. Designed by a

software engineer whose
own grandson is afflicted
with this condition, the Zac
Browser for Autistic
Children is free and
available for download at
http://www.zacbrowser.com/. It
is named after six-year-old
Zachary who was diagnosed
with autism, making him
confused and vulnerable to
attacks of frustration and
low esteem.

The Zac browser can
either be downloaded from
the Web site or run without
installing. It disables
unnecessary buttons on the
keyboard like the [Print
Screen] and also the right-
click option of the mouse.
Web sites with violent
images and / or
pornography are blocked. In
fact, the Zac browser only
allows a selected list of
child friendly Web sites
culled from reputed
resources. The icons are
larger than usual and also
look like real world objects
such as balls and pile of
books. The browser also

blocks all pop up and flash-
based ads that might
distract the users. Using the
browser, Zachary can now
listen to music and play
simple games, things that
he liked, but were too
traumatising to do, because
of being unable to navigate
complicated menus.
According to his parents,
television is still something
he can’t stand, but the
computer is slowly
becoming his new best
friend. Doctors hope that as
time passes, he would gain
enough confidence to go
into the big bad world of
ordinary browsers and
unfiltered content.

Doctors and child
psychologists are impressed
with the Zac browser,
despite it being not a one-
size-fits-all solution for
autistic children.
Researchers have long
looked at tools that can aid
these children to learn and
play online, but the results
have been unsatisfactory. A
lot of customisation is

A Round-up Of Technology News From Across The GlobeThe Digital World

AUSTRALIA
The Federal government
of Australia will conduct a
full review of the security
of public and private
sector information and
communications networks

JAPAN
Waseda University,
opened a campus Tuesday
in Second Life, an
Internet-based virtual
world operated by a US
company

BRAZIL 
Google signed an agreement
with Brazilian public
prosecutors to help combat
child pornography on its
social networking site Orkut

UK 
Bristol, London and
Southampton, now termed as
UK’s ‘fittest cities’ have bought
more copies of Nintendo’s Wii
Fit than any other city,
according to European online
auction site TeleBid

Taiwan
Yahoo! will host
its Open Hack
Day, an annual
event to
encourage
participants to
develop
innovative Web
applications

n Blizzard Announces Diablo III n US digitial music service Rhapsody embraces MP3 downloads without copy restrictions

UAE
UAE will develop its first green city
epitomising Green energy and
research on alternative energy at
Masdar
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Photograph Vinod Chandak Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

needed for autistic patients
to aid their online
expeditions, as autism can
have divergent and
sometimes mutually
contradictory symptoms.
However, the Zac browser is
definitely a good place to
start from.

EXTRA TIME

Kiss Of Life
For XP

Fans of XP rejoice. XP
has got a new and
rather long lease of

life until 2014. This seemed
unlikely till recently, as
Microsoft seemed hell-bent
on following the earlier
plan of going with support
for only one single OS. 

According to the
roadmap for introducing a
new iteration of Windows,
XP was supposed to be
phased out by the mid-
2008. As an OS from
Microsoft, XP had proved to

be the most stable, most
useful and best to have ever
come out of Redmond.
When Microsoft announced
work on Vista, enterprises
and private customers
expected a better product.
However, Vista turned out
to be a disaster. It was
delayed for five years and
the final product shipped
was too bloated and too
buggy. It was pretty to look
at, but demanded insane
hardware specs for what it
did. To rub salt in to  users’
wounds was also plagued
by compatibility issues and
security threats. The fiasco
with Vista has now led to a
popular term called
“vistaster”.

Microsoft suffered a big
blow, because despite its
ubiquity in the personal
computing space, the
enterprise segment with
volume licensing and long
term software deals was
essentially what brought
home the bacon. Businesses
were edgy because they

feared non-existent support
for XP would affect their
operations while Microsoft
feared that it would lose its
customers to Linux or
Apple, whose stock was
rising. The masses were
also rising, with an
Internet petition collecting
hundreds of thousands of
signatures as the doomsday
clock ticked. Meanwhile
people chose to swim
towards the drowning ship,
opting to downgrade from
their Vista to XP. In the
booming UMPC segment,
XP was not optional, but
also essential for Microsoft
to get a slice of the pie, as
machines like the EeePC
did not have the
horsepower to run Vista.
Microsoft was, for a
change, facing
competition, not from
others, but from an older
product of its own.

For a while, it seemed
that Microsoft was
determined to buck
popular opinion and

business logic. All the big
guys at the top, especially
CEO Steve Ballmer,
proclaimed the end of XP
would come on June 30.
Things looked
unchangeable and seemed
to be inscribed in stone. As
the whole world crossed its
collective fingers and
hoped that Microsoft would
not shoot itself in the foot,
the company finally read
the writing on the wall.
The recent move to support
XP, means that even though
Microsoft would not want
to dump Vista, they would
be forced to let it die a slow
death. As it is, the company
is engaged in development
of a new operating system—
Windows 7, which is
scheduled to be released in
2010. Microsoft hopes to
learn from the mistakes it
made in Vista, and so far,
the scene looks
encouraging. Things would
really be bad if Microsoft
had to extend the license of
XP a second time.

Last Month’s Winner!
No Winner!

E-mail your caption with the
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beatthat@thinkdigit.com
and win 
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n Google releases software module that turns Windows PCs into media streaming servers n Blizzard Announces Diablo III
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I STAND FOR CHANGE

Click Power

Barack Obama is the
Democratic Party
nominee to take on

John McCain in the
November US Presidential
elections. Obama created
history when he became the
first black candidate to bid
for the most powerful office
in the United States and by
extension, in the world. He

defeated former First Lady
Hillary Clinton in a long
acrimonious battle where he
started out as the underdog.
According to most political
pundits, he has a pretty
good chance of making it to
the Oval Office, riding on
his campaign of change and
his charisma.

However, there is one
more element that
contributed to Obama’s
surprise upset—the Internet.
Obama understood Web2.0

and the power of social
networking. He relied more
on grass root donors and
voluntary campaigners
rather than going by the
traditional route of
corporate donors and paid
lobbyists. His Web site,
www.barackobama.com was
the nerve centre of his
campaign, greater in
importance than any brick
and mortar office. He had a
social networking
component on the site
which at the last count has
more than 850,000
members. Most of these
people are really committed
and they usually have the
domino effect of turning
even more people to his
cause. Besides, with
thousands of videos on
YouTube panning Obama,
he has captured the
imagination of the youth
like no other political
leader has.

It’s not that Obama had
it all easy. His racial
background is the material
for many conservative led
slurs on the Internet. Here
too, Obama has things all
figured out. Aware of how a
negative story can get out of
hand if it got the right
number of eyeballs, the
Obama campaign has a
dedicated war-room that
scours the Internet for such
stories and promptly takes
various measures to put

fires out. The campaign has
also hired a Web
relationship management
company, which maintains
the official Web site,
counsels the campaign on
strategies to broaden his
mass appeal and reach his
message out to more people.
The Internet has enabled
Obama to raise funds of
more than $200 million, a
record. He is flush with so
much money that he has
refused to take state
funding worth millions of
dollars for the final
campaign and has donated
funds to the nearly empty
coffers of his bitter party
rival Hillary Clinton.

The current US
presidential campaign has
showed that a David can
beat Goliath even against
overwhelming odds, and
that too using
unconventional campaign
tools like the Internet. We
only have to wait and see if
Obama manages to keep the
fascination levels high and
keeps going until he gets to
the White House.

Supernova is what Nokia has
decided to call their upcoming

range of mobile phones. The news has spread rapidly and the
Internet blogs are already bubbling with activity. The first
models from this range are likely to be out in the third quarter
of this year.

The term Supernova automatically conjures up an image of
something unique and spectacular—something very different
from what we're used to. Nokia will bring four models in the
beginning which will be called with numbers like the 7210, 7310,
7510 and 7610 that people can relate with much easily. It turns
out these aren’t going to be some kind of exotic overpriced
exclusive phones for the wealthy. The costliest one of the four
phones is said to be released at a price tag of just $354 (Approx

Rs 15,000).
The features are a jump

from the previous phones.
Some of the features on the
higher-end model one can
expect are a 3.2 MP camera
and TV-out connectivity. You
still get the GPS maps and
the option to upload media directly to Web sites. So it all comes
down to fancy designs and cool names for colour such as fatal
red and bubble gum pink. These are phones for young men and
women. Fashion and design is the core of the range and Nokia
knows you want it! These can be yours very soon at some very
decent prices.

25% of the
Indian population

has access to
telephones. Of
this, 22% has

access to mobile
phones

1.4 billion
people, nearly one-

fourth of the
world’s population
will be connected
to the Internet by
the end of 2008

through more than
1.5 billion

devices

50% of online users in the
beginning of 2008 spent most of
their time playing online games

and using IM.

China, with 275 million is set
to be the country with the

largest Internet presence with
the US at second place. 

n Yahoo increases annual domain registration fees by $25 n Sony Ericsson is Greenest Electronics Company; Nintendo is “least green tech firm”

Nokia Supernova
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Recently, at the Go!
Print 2.0 event held
at Shanghai, HP

shared its vision on the
future of printing solution
that will transform the
way people see and use
printing devices. At the
event, HP launched 25 new
printing solutions
including new
LaserJet printers,
all-in-ones,
scanners, printing
management tools
and wireless print
servers. This is one
of the biggest
launches HP has
done in this
region so far. 

Speaking at
the event, Chris Morgan
stated that HP would
further drive its Print 2.0
strategy to accelerate
growth and continue its
leadership position in the
ever burgeoning SMB
category. The Print 2.0
strategy is built around
automating and
streamlining of customer
workflow, thus saving time
and money. 

With the launch of 25
new devices, HP has
specific products to cover
each department, right
from marketing, accounts
and administration. 

For SMB’s printing cost
is a key concern. HP’s
Officejet Pro line of
printers with higher
capacity
cartridges
capable of
delivering
roughly 2500
pages per
cartridge are best
suited for this
segment. The new

jumbo cartridge 88XL is
available in both black, as
well as colour and it will
be used in all the new
generation Officejet Pro
line of printers. 

The OfficeJet Pro L7950
all-in-one printer is the
latest in the series offering

capabilities, such as 35
PPM speed, Laser quality
output at 12 PPM, printing
of lab quality photos using
the built-in LCD screen and
versatile document feeder
for scan, copy and fax. This
AIO also has the duplexing
feature, thus saving paper.
It also consumes less power
than laser devices during
printing. 

The OfficeJet Pro K8600
uses the same printing
engine as the L7950 and
offers similar features and
speed. The optional
duplexing unit gives the
K8600 duplex printing
capability and saves paper. 

At 50 pages per minute,
the HP ScanJet N9120 is a
monster of a scanner, that
can scans A3 poster
documents as well.
Boasting of 100 pages a
minute of black-and-white.
With the right OCR

software from HP, the
ScanJet N9120 is the
ultimate digitising device.
Estimated price will be
around $3,999 (about Rs
1,70,518).

In most SMBs,
marketing collaterals are
often outsourced, as
creating them in-house
requires lot of resources.
To help such customers, HP
has their new CP1215
colour laser printer, which
comes with Business
Marketing design CD. This
makes creating marketing
collaterals, such as
brochures as easy as using
a template in MS Office.
The CD contains hundred
templates by Stock Layouts,

access to 20 free stock
images from
iStockphoto,
trial version of
Microsoft
Publisher 2007

and $50 off any
logo package from

LogoWorks by HP. 
On the monochrome

front, the P4515 with a
speed of 62 pages per
minute is one of the fastest
printers to come out of the
HP stable. The P4515 has
HP’s Instant-On technology,
and hence is capable of

delivering the first
page within 8

seconds. The
P4515 improves
on security by
implementing
PIN user
identification,
that is, one has
to key in their
PIN number to
retrieve any
print job. The
printer looks

impressive with the 500-
page, five bin paper sorter,
which is offered as
optional.

n Marc Andreessen, the former CTO of AOL, Joins Facebook's Board Of Directors n Citysense allows Cell Phones to track nightlife in US

HP’s Go! Print 2.0
HP’s mantra for small businesses: Optimising printing with clear focus on 
saving time and money

HP L7950 AIO - High speed printer
unit

HP K8600 - Money saver

HP N9120 - High speed A3 scanner

P4515 - Secure printing solution

CP1215 - Entry level versatile
colour printer
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There are war clouds on the horizon. To our regular
readers the ongoing battle of words and rattling of sili-
con sabers between NVIDIA and Intel would not come

as news. Intel is set to unleash its Larrabee processors in the
near future which will go against the graphic accelerators of
today; as manufactured by NVIDIA and AMD/ATI.
Meanwhile, the other side has been adding General Purpose
to their GPUs for a while now; the so-called GP-GPUs which
even today are all set to take over tasks traditionally
executed by the CPU. On a more general level, the entire
industry is moving towards massive parallelization—instead
of discrete processors performing specific tasks, we are look-
ing at processors that can wear multiple hats and churn
everything from physics, to sound, to graphics. 

But let’s limit the battleground to the CPU vs. GPU scene,
and as a subset to the diametrically opposite directions NVIDIA
and ATI are taking with their new generation hardware.

Meet The New Boss
The G80/G92 processors from NVIDIA have been unchal-
lenged both in pure performance and in the price-to-

performance ratio the past years. There has simply not been
a better card to get than one based on either the 8800-series
or the 9800-series. The G80 enjoyed a nice stint on the throne.

NVIDIA would like to repeat that success with their just-
released GTX 200 hardware. In many ways the new graphics
chip from the green team is a consolidation of their past
successes and their future aspirations. The GTX 200 is essen-
tially a more efficient G80/G92 core, and is simultaneously a
bigger version of its successful sibling. At 1.4 billion transis-
tors, the new core is a monster, and using a 65nm fabrication
process, NVIDIA claims that the GTX 200 is the largest and the
most complicated piece of silicon that they have yet produced.

NVIDIA’s ambitions with the GTX 200 chips is just as
large: not only do they plan to retain their crown in the
graphics industry, but they also hope to make substantial
inroads into the traditional CPU market with this new chip.
Somewhat amusingly, NVIDIA terms these twin goals as
Gaming Beyond and Beyond Gaming. Marketing monikers
aside, let’s take a close look at the changes wrought through
this new chip by dissecting its internals.

(Almost) Same As The Old Boss
The heart of the GTX 200 beats with the same chewy good-
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We take an early peek at the new graphics chipset
from NVIDIA. The GTX 200 series is big and fast, we

find out what makes it tick
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ness that made the G80 core so popular. But it’s
stronger and faster. Before we delve deeper into
its anatomy, it’s interesting to note that the way
the core has been designed, it can fulfill dual
roles. The GTX 200, by way of its massively
parallel transistors can either work in a graph-
ics mode, wherein it acts as in the traditional
programmable GPU sense; additionally, it can
double up duty in a “compute” mode in which
some parts pertaining to graphics processing
are turned off in favour and the chip acts as a
non-traditional general processor—capable of
churning through massively parallel tasks and
floating-point calculations such as those
needed to simulate high-level physics interac-
tions. This is where the Beyond Gaming /
Gaming Beyond roles arise from. 

Internally, the core of this processor is all
about threads. The core itself is mostly
comprised of ten clusters called Thread
Processing Clusters or TPC. Each of this cluster
is in turn made up of clusters of transistors
called the Streaming Multiprocessors (SM):
there are three SMs in each TPC, for a total of 30
SMs in each GTX 200 core. Each SM is further
comprised of many Streaming Processors or SPs.
There are eight SPs in each SM, making for a

total of 240 streaming processors for the entire
chip. In comparison, the GeForce 8 and 9 series
of cards had a total of 128 streaming proces-
sors—this is just one of the examples demon-
strating how the GTX 200 is a souped up version
of the older G92/80 core. 

This structure of 240 streaming processors
is where this chip from NVIDIA gets most of its
parallel processing strength. As we mentioned
earlier, the chip uses two different processing
models. For execution across the TPCs, the

architecture is MIMD (multiple instruction,
multiple data). For execution across each SM,
the architecture is SIMT (single instruction,
multiple thread). SIMD machines such as a
traditional CPU operate at a reduced capacity if
the input is smaller than the MIMD or SIMD
width. SIMT ensures the processing cores are
fully utilised at all times. 

For each SM, the chip can handle up to 32
groups of 32 threads, for a total of 1,024 threads
per SM. Since the chip has 30 SMs, it can in total
handle up to 30,720 threads in hardware.
Comparing this with the 12,288 maximum
concurrent threads that a GeForce 8800 GTX,
should give you an indication of the thread
processing capability of the current design
versus the older generation.

The GTX 200 breaks everything down into
threads and then leverages its inherent capabili-
ties to crunch them in parallel. The chip’s design
lends itself to complex integer and floating-point
math, memory operations, and logic operations.
Each core being a hardware-multithreaded
processor with multiple pipeline stages that
execute an instruction for each thread every
clock. Threads can be of various types which help
the chip with both graphic and traditional CPU
tasks including pixel, vertex, geometry, and
compute threads. Programmatically, thus, every
instruction is executed as a series of threads.
From the programmer’s perspective, SIMT allows
each thread to take on its own path. Since branch-
ing is handled by the hardware, there is no need
to manually manage it within the vector width.

According to NVIDIA, “GPU processing is
centered on computation and throughput, where
CPUs focus heavily on reducing latency and keep-
ing their pipelines busy”. All GeForce GTX 200
GPUs include a substantial portion of die area
dedicated to processing, unlike CPUs where a
majority of die area is dedicated to onboard cache
memory. Rough estimates show 20 per cent of the
transistors of a CPU are dedicated to computa-
tion, compared to 80 per cent of GPU transistors. 

With a thread-driven architecture, keeping
the transistors fed with data becomes very
important. While in CPU latency is reduced by
using onboard cache memory (which comprises
a significant percentage of a CPU die-estate), the
GTX 200 GPU dedicates its die area to computing
and thread scheduling units. Hardware thread
scheduling ensures all processing cores attain
nearly 100 per cent utilisation. The GPU keeps
itself fed and latency down by shuffling threads
across its TPCs—if a particular thread is waiting
for a memory access, the GPU can perform zero-
cost hardware-based context switching and
immediately switch to another thread to process.

The TPCs are not the only transistors help-
ing with the graphics processing. We can
consider the TPC structures to be a common
tool that the chip employs for both compute

and graphic tasks. Graphics processing though
also brings in the power of some dedicated
processing units such as the Raster Operations
Processors, or ROPs. The ROPs can be considered
as a painter’s workshop—it is where all the
vertices which are transformed and computed
in the TPCs come to be filled with colours and
rendered to give the pixels which will then be
used to create the final image. This final scene
is assembled based on color and position data
generated for each pixel. Anti-aliasing and
blending are done into the framebuffer (where
the final image is drawn) inside these ROPs.

The chip has eight ROPs in total versus the
prior generation’s six ROP partitions. The G80
core could output 24 pixels per clock and blend
12 pixels per clock; the GTX 200 chip is capable
of an output and blend of 32 pixels per clock.

While not performing graphics tasks, the
ROP structures are not leveraged for compute
calculations. In this mode, a thread scheduler
manages the threads. Texture caches are also
used to combine memory accesses for greater

efficiency to the read/write operations.
Furthermore a small cache of memory is located
within each of the SMs. This local memory is
used to share data between the eight SP which
constitute each SM without the need to call data
from an external memory subsystem. This goes
further to increase computational efficiency.

Other Structural Changes
An important change to the internals is double-
precision, 64-bit floating point computation
support. This addition to the architecture will
benefit mathematically intensive applications
such as those in high-end scientific, engineer-
ing, and financial fields. Each SM incorporates
a double-precision 64-bit floating math unit,
for a total of 30 double-precision 64-bit process-
ing cores. Each of these double-precision unit
performs a fused Multiply-Add operation that
fully IEEE 754R floating-point specification
compliant. The overall double-precision
performance of all 10 TPCs of a GeForce GTX
200 GPU is roughly equivalent to an eight-core
Xeon CPU, yielding up to 90 gigaflops.

This new chip also adds to the framebuffer—
this is the video memory of a graphic card.
While SLI implementation of previous genera-
tion chips have memory up to 1GB, the gigabyte
is shared across the chips which comprise the
multi-core setup in an SLI mode—practically
thus, memory available to each core is around
512MB. The GTX 200 chip however, makes full
use of a 1GB framebuffer. This is of huge bene-
fit to current and future games, especially since
the variety of textures used by modern games is
only increasing. For example normal maps are
used to enhance surface realism, cubemaps for
reflections, and high-resolution perspective
shadow maps for soft shadows. This means
much more memory is needed to render a
single scene than classic rendering which relied
mainly on the base texture. Apart from this
modern engines make use of advanced tech-
niques such as deferred rendering which is also
benefited by the addition to the framebuffer’s
size. Deferred rendering in particular
consumes an immense amount of video
memory and memory bandwidth, especially
when used in conjunction with antialiasing. In
addition to the increase in memory, the path to
the memory has also increase inside the GTX
200 chips. In these new chips the memory inter-
face width is expanded to 512 bits, up from 384
bits in previous-generation GPUs. This has been
achieved using eight 64-bit-wide frame buffer
interface units. This increase in the interface
width has meant a greater memory bandwidth.

Brains To The Muscle
With its 65nm fabrication and a 1.4 billion tran-
sistor count, the GTX 200 is expected to run hot.
Indeed, the TDP of the chip can get as high as
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236 Watts! However, NVIDIA has taken a holistic
approach to power management and the actual
thermal profile of the chip will vary greatly
depending what it will be used for.

Broadly, the chip operates under four differ-
ent thermal envelopes:
l Idle/2D power mode (approx 25 W)
l Blu-ray DVD playback mode (approx 35 W)
l Full 3D performance mode (up to 236 W)
l HybridPower mode (effectively 0 W)

The HybridPower mode is enabled when a
GeForce card is used in conjunction with
special nForce motherboards: in this case, the
onboard graphics chipset is used for 2D tasks
and the dedicated graphics card is effectively
switched off.

While HybridPower might be considered a
feature outside of the GTX200—the chip itself
has several tricks up it sleeve to reduce power
draw. For one, when running 3D applications,
the driver can seamlessly switch between power
modes based on GPU utilisation. These new

chips come with activity monitors which act as
watchdogs over the traffic inside the GPU.
Based on the activity reported, the GPU driver
can dynamically throttle the performance
mode by making changes to the clock speed
and the voltage level—all transparent to the
user. This behind-the-scene speed throttling
goes a long way to supplying just the needed
juice to the GPU and keeping the temperature
and the power draw down. Apart from this
throttling, the GPU also has clock-gating
circuitry, which effectively shuts down blocks
of the GPU which are not being used at a partic-
ular time, further reducing power during peri-
ods of non-peak GPU utilisation.

Compute This
NVIDIA wants to take its GPU outside the graph-
ics processing threshold. It has already taken
steps to that end—the largest being the intro-

duction of its C-like CUDA interface for
programmers. Where NVIDIA would like to see
its GPU (and ATI too, as a matter of fact) is more
general computing. To this end some programs
have already been showcased—traditional tasks
which are either accelerated greatly or
completely executed on the GPU. Adobe, for
example, showcased a version of its Photoshop
application which was GPU-accelerated and was
capable of quickly loading and editing a 442MP
file, at 2GB size. The edits done were rudimen-
tary—zooming in and out, rotation and so on.
But as a taste of things to come it was an
impressive display, given how slow Photoshop
can get while manipulating large images.
Another piece of software used the GPU to
encode video files faster than real-time play-
back, yet another was a ray-tracing application
which made use of the GPU. Other tasks the
GPU is being called for include protein folding
via a Folding@Home client and physics simula-
tions for liquids, soft bodies, and fabrics. 

Compete This
There are to be two variants based on the GTX
200 chip—the GeForce GTX 280 will be the
higher-end part (priced at around $650), and the
GeForce GTX 260 will lose some of its compo-
nents and be priced slightly lower (at about
$399). Early benchmarks show the GTX 280 to be
on par with the 9800 X2 cards on some tests,
and ahead of the X2 in others. Going on the data
that’s out there, NVIDIA might just lose its price
to performance crown to its rival’s graphic
chipset. ATI/AMD has taken a completely differ-
ent approach to designing its graphics part. No
technical information is available to make an
objective analysis between the two approaches,
but from a holistic point-of-view: while NVIDIA
has taken the bigger, more powerful approach;
ATI has gone down the smaller, scalable route.
ATI’s new chip—the RV770 seems designed to
run in pairs and efficiently. Early tests put the
RV770-based, single chip solution the Radeon
HD 4850 within range of the 9800GTX, and at
$200 or less. The 4850 in crossfire configuration
gets within touching distance of the GeForce
GTX 280, and at $100 less. AMD/ATI will also
release a $300 card the Radeon HD 4870 which
will run two RV770 chips on the same graphics
card and will come equipped with GDDR5
memory—about 80 per cent faster than GDDR3
used in the GeForce cards.

One thing’s for sure—things are certainly
heating up in the graphics market. At one end
you have the ATI and NVIDIA rivalry, which has
already lead to price drops from the NVIDIA
camp; on the other hand you have the upcom-
ing challenger to the market—Intel. Who knows
what that will bring to the scene? Well, cheaper
prices for sure. This is exciting times for us
consumers indeed!

agent001@thinkdigit.com

Features of future games
such as Far Cry 2 will
demand an increase in the
number and size of
textures. The GTX 200
chip can support up to 
1 GB video card memory



to each office’s décor and
colour. Senior management have individual
offices, otherwise two or three other employ-
ees may share a room, albeit with excellent
desk segregation. This is done to aid concen-
tration, and maintain human contact
throughout work hours. Throughout the tour
of the building, we saw many examples of a
home-like environment, from the do-it-your-
self fully stocked kitchen, to the lounge,
replete with pool and table tennis tables,
chairs, large screen TV, and arcade games.
Equally cool, was their gaming den, a large
hall-like room with some 16 gaming setups.
Each setup consisted of an Xbox 360, a PS3 and
an SLI-configured HP Blackbird PC complete
with quad core processor and 4 GB of memory!
By now, you’re thinking “Wow! Wouldn’t I like
to work there”. Don’t berate yourself up for
any disloyal thoughts. You aren’t the first to
consider such possibilities (shhhh!).

After a brief tour that included a peek at
their fully equipped gym, the guys at Epic
were ready to talk about something we all
love—games. But first, a little background
lesson. Tim Sweeney, CEO and founder (1991),
of Epic Games, has been designing games from
his college days and is a die-hard gamer in his
free time. Epic games (then called Epic
MegaGames) itself kicked off with Jill of the
Jungle way back in 1992. Their first huge title,
(and one we all remember and relate to), was
Unreal (1998), was possible due to the teaming
up of Epic with two gifted individuals—Cliff
Bleszinski and James Schmalz.

Once inside their conference room, we
settled into comfy sofas. The walls were liber-
ally plastered with art work and renders from
Epic’s upcoming title Gears Of War 2 (GOW 2).
There were soft drinks, burgers and other
snacks, well within arms reach, throughout
the session. The current focus of Epic is very

obviously on GOW 2.
For those who don’t know,
the original GOW (released in
November 2006) was one of the
best X360 titles till date. In fact,
GOW alone accounted for a
noticeable hike in the sales of
the console after its release.
Although the sequel is set for
November this year, we’re told
that the game is ready, and test-
ing and fine tuning gameplay is
currently in progress. The team has
been at work on this prequel, the origi-
nal. For us, GOW was one of the best
efforts at a third-person shooter on any
console, simply because of the amazing player
control and camera angles. In fact, we fondly
remember the happy hours spent at GOW, and
quite a few of our team got hooked on the
game. In short, GOW came close to delivering
a PC-like third person experience. But as Cliff
Bleszinski (“Cliffy B” to everyone) says, “the
best is yet to come”. The team is candid about
the shortcomings of the first title,  and it’s
obvious they won’t repeat the same mistakes
with GOW 2. It’s clear that their work is their
passion, and everybody seems thrilled to be
asked about the game itself. Even silly ques-
tions we put forward are answered patiently
and accurately.

Having played GOW so much, we put
forward the obvious—How is GOW 2 better?
Epic answers “In every way”. We want specifics
particularly of the eye-candy variety. Mike
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W
hen it c

omes to gaming, most of us,

(and we include ourselves), are a very

choosy bunch. We wait fo
r a title

 for

ages, and after getting our paws on a copy, and

spending an hour playing the game, we’re

either with a grin on our faces...or not. In
 event

of the latter, the game is proclaimed a failure

and dismissed. What is also forgotten, however,

is the sheer volume of sweat and human perse-

verance that went in from inception to comple-

tion of the game, and the labour of love that

developers put in throughout its development.

The idea to visit a game studio to find out

exactly what goes on there, began sometime in

mid-March. We decided to visit Epic Games (of

Unreal Tournament fame) headquartered in the

tiny, picturesque, and very green township of

Cary—which itself is a suburb of the much

larger City of Oaks a.k.a. Raleigh, North

Carolina. Connected by flight via the Raleigh-

Durham airport. Cary at first glance seems a

quaint place with a miniscule populace—a

conducive atmosphere for game development

in our opinion.

After a hearty American-style breakfast, it

was tim
e to behold the lair of Epic itself. T

he

first im
pression, (and one that lasts), given off

by the surroundings, the building and the

people themselves, is of a very casual, and laid

back atmosphere underlining a very profes-

sional outfit. 
The grounds, complete with open

lawn and a basketball court at the rear of the

building and parking at the front that shows

off some amazing gardening skills, add to the

effect that the management at Epic wanted to

create, “a place that’s soothing to the soul.”

Inside the building, a quick look at the

work area shows a very fresh and different look

Designing a modern game is no easy task (as we discovered!).

To unearth how these marvels are made we travelled half way around the

world to one of most reputed development studios in the business.

Read about our Epic journey…
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Capps, President of Epic Games gives it a shot—
“The answer is the Unreal 3 engine”. But that
was used for the original game too, our plain-
tive protest. What’s new? “You want it, you got
it!”—with those ominous words hanging in the
air Mike rattles off about the various technical
aspects of GOW 2. Here are the words straight
from the man’s mouth:
1. Ambient Occlusion / Post-Processing Filter:
Unreal Engine 3 (UE3)’s ambient occlusion tech-
nology renders an approximation of global
illumination by calculating the accessibility of
each pixel. The result is increased perception
of geometric shape for the entire scene,
including dynamic characters. The effect is
scene-independent and operates with constant
memory and performance overhead with no
pre-processing.
2. Advanced Character Lighting:
Improvements to the UE3 character lighting
system enable the engine to more accurately

synthesise complex
light environments. Fill
lighting is added using
the increased accuracy
to maintain the
contrast of character
details. Character shad-
owing accuracy has also
been enhanced.
3. H i g h - d e n s i t y
Crowds: UE3’s new
crowd system with
flocking technology
can simulate in real-

time hundreds of characters within a scene.
Battling the Locust Horde in the original Gears
Of War often involved attacking five or six
enemies at once, and it’s now possible to have
masses of enemies onscreen at once.
4. Dynamic Fluid Surfaces: The water technol-
ogy in UE3 breathes life into liquid surfaces.
Sophisticated water physics combined with
realistic specular and environment reflections
produce a realistic, liquid-like feel.  Characters
have dynamic interactions with the water and
this adds a layer of realism.
5. Matinee improvements: Matinee is used to
build real-time cinematics that play back in-
engine. This UE3 system has been substantially
improved to give artists movie director-class
control over all of the objects in a scene, as
well as cameras and cuts, plus we have added
an in-engine, real-time preview feature that
plays back all the visual effects of a cinematic.
6. Soft body physics: Through the incorpora-
tion of Aegia’s soft body physics simulation
technology, UE3 can realistically simulate elas-
tic and deformable objects, and thus produce
more organic game worlds. Players can inter-
act with flexible objects, and gelatinous
surfaces can exhibit sticky properties.

7. Destructible environments: UE3’s new frac-
turing tool and, enable developers to take
virtually any existing mesh, slice it up into as
many fragments as desired, and destroy struc-
tures. This structural analysis tool produces
far more realistic, destructible environments.

He continues: “Many gamers still consider
the original Gears of War to be the technical bar
for next-generation gaming—and that was our
first Unreal Engine 3 title. We’ve been working
on the technology for two years, so of course,
there are tons of great new features. It’s also
been greatly optimised, which helps us to
make Gears of War 2 even bigger and badder
than the first game”.

After that rather lengthy description and a
look at some of the screenshots, and in game
footage of GOW 2, it is time for a little break,
hosted by Cliffy B, as we’re led through the
corridors of the building for the second time.
We’re at the front lobby now and the time is
around 1 pm. Several employees are just enter-
ing the building. Cliff reiterates the casual
work timings, “They leave late, (incidentally, 7
pm is late for them!), so they’re in late as well.
The core working hours are 1.30 pm to 5.30
pm, and we try to ensure our presence during
these hours, otherwise it’s mostly cool”. The
back of the building has a rather large open-
air veranda with a few chairs and tables spread
around. Someone asks what is perhaps the
most clichéd question ever—what are the three
best things about working here?

Cliffy replies: “One, the people... I work
with the most intelligent and talented people
in entertainment, and every day is filled with
challenges and surprises that keep me on my
toes. Two, the environment... our office feels
professional, yet cosy. There are no cubicles,
and food is provided during the busier times,
and everyone’s got action figure and lastly
creative freedom. Lastly, Epic builds our own
universes, and thus, we have enough wiggle
room to dream big”.

A couple of questions more about Epic’s
prosperity after their recent success with GOW
and the just released Unreal Tournament 3 had
Cliffy joking “Our car park has been upgraded
quite a lot over the past two years, with many
faster, more expensive cars”. We share a
moment of mirth and head back inside. En
route their press room, we make a quick stop at
Cliff’s office. His desk itself is huge, strewn
with magazines, odds and ends, and to top it
all, a multitude of action figures—Cliffy is a
proud collector of more than 150 such action
figures. A pretty impressive looking PC with a
large monitor dominates one side of the desk
and the action figures take up another third,
along with tons of images depicting concept
art from titles he’s worked on, including
Unreal Tournament 2003, UT 2004, and Gears of

War. His desk is his den, and obviously the
heart of his productive soul.

After a little more talk about GOW 2, and
the technical aspects of the Unreal 3 engine,
we went for a late lunch. During the healthy
yet sumptuous meal, we got talking again:

Does game development follow a particular
procedure? Are there any stages to the proce-
dure? If so, what are they?

Mike Capps: There most certainly are
procedures and stages to the process. It’s like
creating any other product. There’s a lot of
hard work, and most of us put in very late
hours, but since we all love what we do, we
have loads of fun too. Game development is a
complex and expensive process. Most ideas
never become reality because today’s top-tier
games cost tens of millions of dollars (and
years!) to develop, and the respective market-
ing budgets are just as costly.

OK, so what about those stages?
Capps: Ah yes! For us, the first stage is the

pitch. Epic continuously canvasses its employ-
ees for fun and original game concepts, and
these ideas require extensive evaluation. These
concepts are narrowed down through discus-
sions, in which everyone is allowed to partici-
pate. The submissions are then presented for a
more formal evaluation for key stakeholders. If
the concept is scrapped at this stage, we start
from scratch and the process mentioned above
is repeated. If a concept is greenlit, or
approved for production, the game-to-be
moves into pre-production. Everyone has to be
totally committed to a concept before it gets
greenlit for production.

During pre-production, (Stage 2, in-case
you were counting!), producers and designers
create design documents and technical spec-
ifications based on the development time-
line. It’s essential for large teams to assess
the myriad needs during these early phases
in order to maintain quality and keep games
on schedule.

At this point, we start getting the idea that
game development isn’t all fun and (pardon the
pun!) games, and there seems to be a whole lot of
work involved, with close teamwork and coordina-
tion between teams. We questioned Mike a bit more
on what a design document is.

Capps: Design Documents are sort of a
wish list for components and essential
elements that the game should contain or
implement or include. Technical specifica-
tions include the nature of the engine, the
special effects, physics and other specifics
like shading, lighting and damage models to
be used.

The next stage involves game production.
Full-on game production involves implement-
ing features described in the design docu-
ment, and it’s a constantly evolving process as

features may be added,
dropped or modified
depending on time or
t e c h n o l o g i c a l
constraints. The
production stage can
be broken down into
phases called alpha,
the first playable
version of a game, and
beta, the playable
version complete with
features and assets.

Capps adds that
Epic’s motto is polish,
polish and polish. To
further quote him
“When a game reaches
beta, it may contain
bugs or gameplay
balancing issues, so we
spend a lot of time
tweaking gameplay
and optimising levels
to satisfy internal
expectations and standards. Quality assur-
ance testing is a challenging process that can
last six months or more. Our testers bang on
our games, time and again to ensure that we
have explored every possible decision and
taken every path in-game to ensure a smooth
and exciting user experience”. This is an
important stage for a thoroughly professional
outfit like Epic, especially considering the
scale of the games they work on, and even a
single overlooked aspect could cause a lot of
problems. We’ve all played games, which have
certain levels beyond which progress is impos-
sible due to a bug, or a game crash, or a part
of a level that may be inaccessible, and we
know how annoying that can
be.

Whew! Is that all? We ask
hopefully. Not quite, Mike
quips—there’s Post Production
which wraps up with the end
of QA testing, submission to
console certification when
appropriate, and approval for
manufacturing. Once this
transpires, the game is sent to
the manufacturer for replica-
tion, and packaging materials
are printed as well.
Components are then assem-
bled, packed, sealed and
shipped to retailers.

Then there’re a lot of other
concurrent processes in addi-
tion to game development.
While making a game, there
are teams of external

A typical designers desk is never complete without
action figures

A few of the Epic team caught just after we
emerged from our hands-on with GOW 2

Typical Epic productivity dens

Entertainment galore...Epic plays as hard as they
play...err work
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The Indian Angle: Trine Studios, Mumbai

S
o what’s the game development
scene in India like? We spoke to Somil
Gupta, Managing Director, Trine

Animation Studios Ltd, Mumbai about
their organisation, gaming in general, and
upcoming titles.

Trine consists of a team that is 80
members strong. 70 of these are develop-
ers and animation artists. Sangam Gupta,
Somil’s brother and Trine’s CEO tells us that
their strategy is to attack the international
market with localised content, somewhat
like what the Japanese have done with
ninjas and samurais in their games.

The stages involved in game develop-
ment according to Somil are Conceptual
design, preproduction, production,
alpha, beta, gold.

When asked about game titles, Somil is
all about the Indian angle to gaming. He
feels Indian folklore, locations, and even
mythical events all have enough subject
matter to capture the interest of the
Indian gamer. We seem to agree that an

Indian flavour to such games is certain to
attract a larger audience in India, espe-
cially, those completely new to the world
of games. From a marketing standpoint,
this strategy could well work in Trine’s
favour, and succeed where other Indian
developers have failed.

Trine’s current flagship is called
Legends of Great India and is an RTS game
based around mythical and religious char-
acters like Hanuman, Ganesha, Rama and
Arjuna. The goal of this game is to save
India from all evil including Ravana and his
minions. Get set to use a fantastic array of
powers and control armies of hundreds of
troops. Although the plot may seem simple,
it’s the implementation that we’re inter-
ested to see when this game is finally out.
Somil tells us they use cutting edge graph-
ics in their titles and this game is based
around DX 9 SM3, and even DX 10 imple-
mentations are being experimented with.

The other two titles in development
are Streets of Mumbai, which is an NFS

Carbon-like game based around the
streets of Mumbai, as we know, which are
home to many (sometimes) illegal races.
In this game, you can upgrade and mod
your car with cash you acquire by winning
street races. There are as many as 20 cars
to choose from and a variety of eye-candy
mods like rims, paint jobs, lights, hoods,
side skirts and bumpers to choose from.

Wings of Control the other game Trine
is working on, is an aerial combat based
game focussed on tactical dogfights. You
can choose from between seven models of
fighter planes, and the game is based
around an alternate world scenario where
you fight for aerial domination. This title
promises to be a LAN gamers delight.

With some rather unique titles in the
pipe, we’re really interested to see where
Trine takes this bold initiative. For us
gamers, more game studios in India can
only be a good thing, as competition will
lead to improved content, and gameplay.
All we can tell Trine is to “bring em on”.

marketers, retailers, buyers, distributors,
hardware vendors, and other specialists in the
channel, working to guarantee a successful
product launch.

The amount of work involved in actually
creating a game, let alone promoting, circu-
lating and distributing it, seems mind
boggling. Considering that the development
cycle for a single game could be as long as
four years there’s a huge timeframe involved
in each of these stages. Loads of work and
sleepless nights are expected, even for a team
that is as gifted as Epic’s team of program-
mers, designers and testers. 

It was now quarter to three in the after-
noon, and we were shown into a large dark-
ened hall. This, according to Cliffy is where all
the parties and frag fests occur. There were
four rows of desks, each with five chairs
neatly arranged. Each seat had an X360
hooked up to a small 22-inch LCD TV, and
(surprise!) GOW 2 was running on each of
these systems. It seems the Epic team had
arranged for us to go head-to-head, and there
were four five-man teams organised, most of
the players were of course Epic and Microsoft
employees, who from the looks of it, had
spent several hundred hours apiece on the
original game. The prize for the winning
team—an X360 Elite console system for each
player—wow! A few sniper headshots and gory
chainsaw melees later, it was clear that our
team sucked. However, the forgiving nature of
Epic’s team and GOW 2, allowed us to improve
somewhat and our team managed to reach

the finals where we lost spectacularly to a five
man squad solely from Epic. Their role in the
company—game testers—damn!

After this three-hour session, a few people
stayed behind, to play the game some more.
Although this isn’t really a preview, our
impression is Gears Of War 2 seems a lot more
polished and balanced than the original.
There’ve been minor tweaks done to map visi-
bility around the character. The player-
controlled character’s body movements them-
selves have been subtly reworked. There’re a
couple of new weapons including a well done
(pun intended) f lame thrower, and each
weapon gets a new, gorier finishing anima-
tion. There’re also a couple of new map styles
for the multi-player components. The single
player campaign is equally robust, and we’re
told, more movie-like in terms of plot twists.

By around 6:30 pm we were done, after
which we had a quick snack and a Coke with
Epic, discussing our impressions of the game
and exchanging opinions. Another half hour
later, we were aboard a bus to our hotel room.
Thus, concluded a tour, which has left many
good impressions firmly entrenched in our
noggins. Firstly, games aren’t easy-to-design (a
gross understatement this). Secondly, Epic’s
working environs totally rock! Thirdly, GOW 2
seems the real deal, and all set to make an
even bigger splash than it’s predecessor did
back in 2006. Lastly, November can’t get here
soon enough! 

michael.browne@thinkdigit.com



33DIGIT JULY 2008

Digital Passion l Open Source Matters

Aasis Vinayak

R
ecently, I launched the alpha release
of Integle—an Intelligent Search
Engine based on artificial intelli-
gence—(www.integle.org), and have
many volunteers for the project. In

fact, I’m really looking for someone to do the
design work, as I want to have a decent lay out
(rather than that of Jade) and wanted to imple-
ment the libraries of the new language (that
may solve the current rendering issues and I
need not use PHP to deliver stuff). 

Alexandre Oliva of FSF Latin America, is
associated with the kernel-libre project of
GNU. This project aims to remove all the non-
free part of the code. Due to the huge inflow of
e-mails that I have been receiving, I inadver-
tently missed out on a mail from him. I
wanted to have a look at the automation
scripts that they were using for the process. He
gave me all the relevant info that I wanted,
and I learned more about the deblob-main
that can be used in the deletion-process of
non-Free bits from the Linux kernel. The script
will, in turn, utilise deblob-<kver> and
deblob-check (you can cross check whether
a source file contains any remaining or suspi-
cious firmware).

My motive was something else. I could
apply some tools while experimenting with
another project of FSF—Coreboot (www.
coreboot.org), earlier known as LinuxBIOS. The
project is aimed at replacing the standard
BIOS firmware, found in most computers, with
free software. It has many other features other
than being absolutely free software. It boots
faster (3 seconds to Linux console!) and is writ-
ten in C (contains virtually no assembly code).
Further, it averts the need for very slow / buggy
/ proprietary BIOS. 

The Coreboot project started in 1999, in the
Advanced Computing Laboratory at Los Alamos
National Laboratory. I experimented with it on

an AMD Geode LX (x86-compatible system-on-
chip microprocessor) and found it to perform
better. Similar was the response of some of my
friends who dared to have a trial in Intel
Pentium II / III (Emulation) configurations. 

Coreboot usually loads a Linux kernel, but
it can load any other stand-alone ELF
executable bits and pieces. For example, it
performs well with Etherboot, which can boot
Linux from a boot server or ADLO for Microsoft
Windows 2000 / XP and OpenBSD. Coreboot is
supported by motherboard vendors like MSI
and Gigabyte (and even Google partly sponsors
the venture). They offer Coreboot next to their
standard BIOS. 

Another related project is the Open
Firmware project (or OpenBoot) by Sun
Microsystems. It is a standard, defining the
interfaces of a computer firmware scheme. It is
being used by many giants like Sun, Apple,
IBM, and most other non-x86 PCI chipset
vendors. The Open Firmware even allows the
system to load platform-independent drivers
straight from the PCI card. It can be accessed
through Forth language (structured imperative
stack-based computer programming language)
shell interface. 

The majority of implementations provided
by OpenBIOS rely on a supplementary lower-
level firmware for hardware initialisation like
Coreboot. LANL, AMD, Coresystems GmbH and
Linux Networx, Inc contributed much for these
projects. Some vendors helped by providing
specifications of the hardware interfaces for
some of their latest motherboards.

However, Coreboot may work in desktop
PCs, servers, clusters, embedded solutions,
STBs / HTPC or thin clients, but not for my
laptop. Oops! Still I have to use the buggy BIOS
for my debian-powered HP DV2713TU. I have
only two ways towards a resolution—wait for
Coreboot to come out with a solution, or join
the project and contribute—then wait for the
stable release. I prefer the latter.

readersletters@thinkdigit.com
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Maal
Drool

The Buzzball
We don’t know if you’ve ever heard of
Zorbing—the act of placing oneself inside a
ball, and then rolling that ball down the
hill—a concept cooked up by some rather
nutty Kiwis. The downside of this is that
you need (a) a hill, and (b) someone to
push you down it. Enter the Buzzball—
instead of leaving the passenger at the
mercy of gravity, it consists of two motors—
connected to a wheel each—which let the
passenger (now driver) control the motion
and direction of the Buzzball. The driver
will also be able to control the Buzzball by
shifting his weight, and execute exotic
manoeuvres including (but not limited to)
triple-puke-inducing-barrel rolls. 

&
Scream

Shout!

Keymat YALOS
Diamond
When you love bling, all else ceases to exist.
When you hear of the Keymat YALOS Diamond,
the average geek thinks, “Diamond screen?”
and promptly faints. The YALOS, however, has
other plans. Sure, it’s a nice screen, but the real
value lies in the plating of white gold and the
encrusting of over 160 diamonds—four grams of
the stuff, in toto. At $130,000 (Rs 55,90,000),
the YALOS is the Vertu of the HDTV world—
whether that’s a good thing usually depends on
whether you can afford it.
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Ferguson Hill FHOO1 Horn
Speaker
It isn’t just the beauty of these speakers you must admire—
there’s also the fact that instead of using huge amplifiers for
loudness, they use acoustic horns that you can’t help but stare
down. The FHOO1 goes loud with even a teeny five watts,
delivered by a clear, low-power amplifier. A pair of 1.65 metre-
tall speakers retails for a little less than 10,000 pounds (Rs
8,50,000), and may need to be accompanied by the FHOO2 bass
units (if you don’t like the horns’ bass delivery) at 2,500 pounds
(Rs 2,12,500) for a set. Just keep your eyes peeled—wouldn’t
want to walk into those transparent cones now, would we?

Why waste the iPod’s audio quality on solid-state transistors when you’ve got this aluminium-
clad, vacuum tube-toting amplifier just waiting to give you the pure, distortion-free audible
goodness that only a vaccum tube amplifier can? Not only will it render your high-bitrate
audio with incredible quality, the amplifier also compensates for the shortcomings of 128
kilobit (ick) MP3s. It is, after all, German. The line-in jack will also let you connect things that
aren’t iPods—all at the reasonable price of $4,000 (Rs 1,72,000).

CXC Motion-Pro II Simulator
Ah, the wonderful race car simulator—the dream of every
geek who ever played Need for Speed. CXC’s Motion-Pro II
has a 5.1 surround sound system aided by vibration
transducers—so you can feel your engine roaring under your
hindquarters—and a full-motion simulator that’ll throw you
back when you accelerate and jerk you forward when you hit
the brakes. You also get a beautiful, gaming-grade 46-inch
HDTV; if you’re loaded, you’ll get three! Each Motion-Pro is
built to order (including seats built for your waist size), so
we’re guessing that the price is considerably higher than
what we’re imagining right now.

Hammacher Schlemmer Triode-Tube iPod Speakers



Nash David

With a global village like ours, what
better role in your life can we as your
technology navigator play, than

making it an even friendlier place! We believe
learning newer languages always forge better
ties and improve relationships irrespective of
barriers. No longer should a Spanish dama hesi-
tate to learn how to make aloo parathas from her
new online friend, a traditional kudi from
Amritsar. Besides, our very own Mr.
Chattopadhya from our good old City of Joy,
should not feel dumbstruck when negotiating
on a deal in not-too-far Thailand.

The Learning Process
There is no single or perfect way to learning.
Needs differ, and so do solutions. There are vari-
ous methods you can adopt to learn a new
language. You may go the purist’s way of
systematically learning the alphabet, then
mastering words, and then moving over to
sentences. Finally, cautiously proceeding

through getting the grammar right. On the
other hand, some people believe in being prac-
tical, that is, getting straight to the point—
learning what you need in daily conversations,
and then managing your way through life!
Finally, there is one more path you can choose
in your quest to overcome your hurdles because
of inferior linguistic skills. Make new friends,
who speak the language of your choice, and by
mutual sharing, enhance your skills. Sounds
good… right?

The Learning Resources
If those learn-in-30-day-books were really all that
effective, this article would not be warranted,
neither would there be a vast storehouse of
resources available online. We believe you’re
already aware that there is no shortcut to success,
but hard work. We’re just showing you where and
how to get there. In the bouquet of offerings that
the Internet provides, we present three valuable
sites—BBC Languages (www.bbc.co.uk/languages),
Live Mocha (www.livemocha.com) and Before You
Know It (www.byki.com).

Digital Tools l Jumpstart
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You got the
whole world in
your hands…,
and so the song
goes. It sounds
familiar too. This
is, certainly a
small world
getting even
smaller, in the
Internet age
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First select the language you want to
learn. Say for example, you want to learn
Spanish, just click on the link that says
Spanish under Free Language Software
Downloads. Enter your e-mail address to
receive the download link. Once you click on
the link sent to you to for verification, down-
load the installer that follows. Once you run
the setup, BYKI automatically downloads the
required files needed for a smooth study. The
installer by itself is just 105 KB. However, the
files that it downloads can go on for quite a
while, especially if you have a slow Internet
connection. You’ll be reminded of your typi-
cal Yahoo! messenger downloads.

Once the files are completely downloaded,
you have software residing on your system—
you no longer need Internet access, neither
are you pressurised to learn in any time
frame. You can use the software for as long as
you wish—it’s fully functional, completely
free, with no time limits.

With BYKI, learning a language gets really
exciting. The striking difference is that you’re
not distracted, as you don’t really need an
Internet connection once you have downloaded
the files and set up the software. It plays you
the audio recorded by a native speaker. BYKI
proceeds in steps—the test gets stringent with
each passing stage. You need to review your
cards, recognise, know, produce and finally
own your cards. 

Say for example, we’re learning the days of
the week. Then in this case, you’ll be flashed
seven cards with the names of the day written
in Spanish as well as English. Once you’re
familiar with the cards that you have, it
proceeds with the test.

While recognising, you’re given the
option to think and are given the choice of
verifying whether you guessed it right. This
way, although you’re being tested, it’s
not obvious!

In the Know It stage, you’re shown the word
in Spanish. You need to type the English word
for it. Similarly, in Produce It, you’re shown the
English term, and you need to reproduce the
Spanish term. This way with all permutations
and combinations, your ability on a particular
subject is thoroughly scanned.

We believe it would be grave injustice to
compare these resources among themselves,
because as we said earlier—needs differ and so
do solutions. So while one site may appear a
boon to one person, it just may not work out
for another. To get the most out of these
resources and to learn faster, select the
resource of your choice depending on the way
you respond faster. If you’re more comfort-
able with a friend teaching you, then Live
Mocha is certainly the place for you.
Similarly, if you’re one of those who get
distracted easily while browsing and need
some time of concentration to be able to
learn, BYKI is definitely your solution.

Another reason for BYKI is if your language
isn’t covered in the other two sites, which can
most probably be the case if it is some rare
and exotic language! At the end, if the
language that you intend to learn is one of
the popular ones, then it is, in all probability,
covered by BBC Languages. Additionally, it
has a vast range of resources—grammar,
dictionary, TV and radio programmes, etc.
The opportunities are literally endless, and
you would certainly feel the culture of the
country lighting up as you go about studying
its language.

There’s more to Spanish than uno, dos
and tres! 

nash.david@thinkdigit.com
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Mind Your Language!
British Broadcasting Corporation—if you don’t
know them, you have no excuse. As far as cre-
dibility, quality and authority is concerned,
we can take their word for it, irrespective of
the language.

BBC offers its services in a wide range of
languages—from Chinese, French, German,
to Greek and Spanish. Now considering you
want to learn French… or Francaise, then all
you need to do is click on Choose a
Language > French (FRA).

Once you’re at the page for the language of
your choice, it’s smooth sailing. Click on
Learn Online > Online courses. From here,
it’s all self-explanatory and meant to be that
way, so that you don’t have to be dependent
on anyone.

Click on start, and you’ll step in to a whole
new world. You’ll see many probable situations
that you could probably encounter in real life.
As an example, click on Short break in Paris
> Getting a snack. It shows you the most
common dialogues that could crop up in a
restaurant. For example, the waiter comes up
to you and asks—what would you like?
Considering you already know the tongue-
twisting names of dishes available on the
menu, you should be able to reply in crisp
French, “I’ll have a cheese sandwich”. In addi-
tion, it also has the pronunciation for the
keywords used in the conversation. This comes
in very handy, especially, with a language like
French—it’s written one way and pronounced
some other! If you have no prior knowledge of
the language, then use the audio clips, so that
you get the authentic pronunciation.

Livemocha
This site adds the benefit of collective intellect
in the form of social networking, to spice up
your learning experience. After registering on
the site and confirming your e-mail address for
authenticity, enter the languages you know
and the languages you want to learn. 

Live Mocha shows you a list of users with

the opposite needs. Say for example, you
know English and Hindi, and want to learn
German, then Live Mocha will show you all
the native German speakers who want to
learn English or Hindi. 

You get the best of both worlds. Not only
do you get authentic advice on the language
of your choice, but also get to make new
friends, who give you the consolation of talk-
ing to another human, rather that interacting
with a server.

Live Mocha brings you an easy-to-follow
inbox, through which you can monitor
exactly where you stand in your learning
curve. You get to see users who’re learning the
same language as you and users who speak
the same language as you. This way, learning
is easy and comfortable.

BYKI
The last site that we present here, has a dedi-
cate software for each language. The number of
them in total—a massive 64! As far as the
methodology goes, it’s quite similar to the
good old way that BBC follows. What sets this
apart though, is the host of languages. You get
dedicated software for each language. Go to
www.byki.com/default.html.

Digital Tools l Enhance

A cool and friendly look makes it easy to use

A vibrant site in the way it brings together people from across
the globe

Monitor your learning curve from a dedicated inbox

With a vast list of 64 languages available for offline learning, BYKI
has an added benefit.

With BYKI, you monitor yourself
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right-click menu gives you the most useful
commands arranged in a circle, which makes
them easier to access—once you get used to
them, you’ll subconsciously remember the
angle to move your mouse at. In the top-right
corner of the main viewport
(that’s where you can see your
model), you’ll see a cube with
arrows pointing to each side.
When you click on an arrow, the
view shifts to show you your
model from that angle—click on
the arrow on the top to see a top
view, for example. This, naturally,
is far better than fiddling with
View menus. 

The Alternative
Blender (www.blender.org) is an open source 3D
modelling tool that holds its own against other
professional tools as well. Its interface,
however, is even more incomprehensible than
Maya’s and can be very disorienting. Then
again, it’s free, without restrictions, and has a
bunch of plugins available for it. 

Opera
www.opera.com

Firefox may be the alternative browser of
choice, but it was Opera that started the

tabbed browsing revolution. Now, it features an
inbuilt e-mail client, IRC client and RSS reader.
It’s also renders Web pages faster than any
other browser. The latest version—9.5—also
features Opera Link, which lets you send book-
marks and other settings
online, and synchronise
them with other copies
of Opera you might
use—including Opera
Mini on your mobile. 

One of Opera’s
best features is its
support for mouse
gestures—you can
perform a multitude of
tasks by holding down
the right mouse button
and moving the mouse a
certain way. Holding down right-click, moving
the mouse downwards and releasing, for exam-
ple, opens a new tab. Other neat features
include Fast Forward, which automatically
detects “Next Page” links so you can navigate
forward using a mouse gesture instead of hunt-
ing for the link yourself. You can also set Opera
to masquerade as IE or Firefox for sites that call
it an “unsupported browser”.

Google doesn’t love Opera, though, so you’ll
find that Google’s online applications revert to

their older versions with Opera. However, by
using Mask as Firefox, everything sets itself right.

Keyboard Warrior’s Tip
Another important part of Opera’s awesome-
ness is that you can go through an entire
session of browsing without ever touching the
mouse. To cycle through all the links on a page,
hold down [Shift] and use the arrows to
move from one link to the next. The program’s
also smart enough to start highlighting only
links in the visible portions of the Web page.
Hit [Enter] to visit a link, [Shift] +
[Enter] to open it in a new tab, and [Ctrl]
+ [Shift] + [Enter] to open it in a new tab
without shifting focus from your current tab.
You can also use [1] and [2] to navigate
between tabs. 

The Alternative
Firefox (www.getfirefox.com) is the world’s second
most popular browser, and is catching up fast.
While it doesn’t have all of Opera’s features
when you install it, you can extend its func-
tionality using some of the many extensions
that enthusiasts are developing for it.

Google Desktop
http://desktop.google.com

It’s Google search. For your PC. How could it
not be filled with goodness? Google Desktop

starts where Windows’ (or Linux’s, for that
matter) default search ends. You also get a
Vista-like sidebar, complete with Google
Gadgets—though the gadgets available are
quite underwhelming. Even better, you can
turn off this sidebar and opt for the simple-
dialog-box approach. 

The simple [Ctrl] + [Ctrl] shortcut
becomes your ticket to everything—you can use
Google Desktop to launch applications, rifle
through your music collection, search for text
within documents, search the Web, even look
into your Gmail. Google Desktop caches every-
thing it indexes, so even if you’ve deleted a file,
the cache will let you view its contents. The
best part? All this happens as you type. 

Googler’s Tip
For Google Desktop to work effectively, it needs
to index your hard disc/s, which can take time.
Configure it to index all your discs (you can do
this in Preferences) and leave it overnight.
When you come back to your PC in the morn-
ing, you’ll have all you need at your fingertips.

The Alternative
Copernic Desktop Search (http://www.copernic.
com/en/products/desktop-search/index.html) is one of
the first desktop search applications to ever
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MojoPac
www.mojopac.com

If you’re the my-USB-stick-is-my-everything
type, this one’s for you. MojoPac is a utility

that installs on your USB drive (broadly, any
hardware that your PC recognises as a Mass
Storage Device—your phone, your PMP, and
more) and gives you a virtual Windows XP desk-
top on each computer you plug this drive into.
It’s almost like logging on to your own
computer—your settings, your wallpaper, your
programs, someone else’s hardware and some-
one else’s Windows XP.

Here’s how it works—MojoPac uses the
existing Windows OS on the host computer (the
PC you’re working on) to create a new working
environment for you. This environment is
insulated from that of the host PC, so none of
the changes you make to this environment
will affect the host PC. Your USB drive
becomes your new C: drive, which also means
you won’t have access to the programs
installed on the host PC—a security feature

that protects the host PC from your activities.
You can, however, install your own programs—
even games—in your environment just like
you would on any Windows PC, and they’ll be
available to you wherever you connect your
drive—it’s practically like carrying your own
computer around!

Traveller’s Tip
To optimise the performance of your drive,
open My Computer on the host PC, right-click
on your USB drive and choose Properties.
Under Hardware, select the USB drive and
choose Properties. In the dialog that pops up,
you’ll see that “Optimize for quick removal” is
selected by default—change this to “Optimize
for Performance”. 

The Alternative
There’s no tool that offers the virtual desktop
that MojoPac does, but if what you want is
the ability to carry your programs around
with you, there’s the Portable Apps Suite
(www.portableapps.com/suite), that bundles
Firefox, OpenOffice.org and many open
source tools that can be run off a USB drive

without changing the settings on your
host PC.

Maya 8.5 Personal
Learning Edition
http://usa.autodesk.com/adsk/servlet/index?
siteID=123112&id=7639525

Maya is among the best tools ever made
for 3D modelling, animation and

special effects. It isn’t, however, the easiest
to learn, and your only recourse (if you
wanted to go about things legally) would
have been to take some rather expensive
lessons. Maya Personal Learning Edition
(PLE), however, changed that.

Maya PLE is clearly geared to letting you
learn modelling only—while you get all the
tools you need to learn how to model in 3D,
many other options are quite limited—the
output resolution is limited to 1024 x 768 and
all your renders are watermarked. You won’t

even be able to save your work in the default
Maya file format—the PLE has its own .mp format,
which isn’t compatible with the commercial
version. Despite these restrictions, this still gets
our favour for the simple reason that it gives you
access to the same tools that the professionals
use. If you’re looking to make a career in 3D
graphics later in your life, knowing Maya is a big
plus. And then, there’s that interface.

The Alternative
Maya’s interface is more than unconventional,
but has some really neat tricks up its sleeve. The

Are you tired of
pretending to pay

for software? Is
the guilt too
much? Not

enough seeds?
Take a break and
check out some of
the best freeware
tools ever made
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musicengine/; formerly MusicMatch Jukebox) is
another media management tool we like—it’s
easy to use and does its job well. You can also
use it to listen to LaunchCast radio stations,
and it’ll change your Yahoo Messenger status to
show which song you’re playing (should you
choose this option). Only... it’s purple. Purple.

Joost
www.joost.com

Simply put, Joost is free TV. If you’ve got a
respectable broadband connection, you can

download the Joost client and watch shows
from all around the world, free of cost. Joost
uses peer-to-peer (P2P) technology to get your
video to you, so it’s acceptably fast even on a
256 kbps connection. The video quality isn’t
anything worth raving about, but is not too
bad—the price you pay for free access on a
comparatively slow connection. 

Joost gives you over 480 channels to watch;
how many of those are actually worth watch-
ing, we leave to you to find out. The categories
range from comedies to cartoons to documen-
taries and much more. You can even hack up
your own channel by choosing your favourite
shows and clubbing them together. The best
thing about Joost is that it’s completely on
demand—you can watch whatever you want,

any time you want, and end the show if you’re
not enjoying yourself. Unfortunately, you must
still deal with advertisements—that’s how the
company supports itself.

Viewer’s Tip
Using Joost is pretty straightforward, so we’ll
take a moment here to recommend Creature
Comforts under Cartoons & Animation. 

The Alternative
Move along now, nothing to see here.

Free Download Manager
www.freedownloadmanager.com

Free Download Manager (FDM) is one of the
most feature-packed download managers

we’ve ever used. It’s got all the essentials—the

ability to split downloads, use different
mirrors for the same file, download Flash
videos from sites like YouTube, even BitTorrent
support—and then adds a whole lot more. If
you enable FDM’s community features, you’ll
be able to see comments that users have left
for each download—these comments can be
quite helpful, steering you away from virus-
infected downloads or telling you how to run
an XP-only program under Vista. Another
feature we like, is the ability to preview the
contents of a ZIP archive and decide which
files to download. 

In its latest version, FDM also scans your
PC’s programs to see if you’re running the
latest version of everything—if you’re not, FDM
will download the necessary updates for you. It
also sports a Web interface, so you can start
downloads on your home PC from wherever
you have Internet access. 

If we were to gripe about anything, it’d be
that FDM’s clipboard monitor can get a bit
over-enthusiastic sometimes—we can’t count
the number of times it’s offered to download
download.php for us. 

Downloader’s Tip
Always—and this applies to any download
manager—change the number of simultane-
ous connections to a server to 10 by default.
This’ll make optimal use of your bandwidth,
which really means that other applications
won’t have as much luck getting data from
the Internet. 

The Alternative
Orbit Downloader (www.orbitdownloader.com) has
the same set of features, but doesn’t integrate
with Opera as well, and doesn’t have the
community goodness that FDM does.

nimish.chandiramani@thinkdigit.com

http://cdburnerxp.se/

We’ve become so used to
the copies of Nero that

come bundled with our CD
or DVD writers that an alter-
native is almost unthink-
able. CDBurnerXP gives you
the same features that Nero
Burning ROM does—burn
data on to everything rang-
ing from CDs to Blu-Ray discs, burn ISO images, create Audio CDs and so on.
The interface is a friendly drag-and-drop affair, so you don’t have to be an
expert to use it. 

At just 2.8 MB, CDBurnerXP doesn’t waste space with fancy features and
concentrates on what it does best – burn discs. This is one solid, straightfor-
ward tool that’ll prompt you to uninstall the bloatware that Nero’s become.

CDBurnerXP
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come into existence. In its current version, it
offers nearly all the functionality of Google
Desktop, minus sidebar and gadgets, and with-
out the ability to check your Gmail. 

AutoHotkey
www.autohotkey.com

If you’ve got mundane, repetitive tasks to
perform—and who doesn’t—AutoHotkey will let

you do them using any keyboard shortcut of your
choice. It lets you record keyboard and mouse
activity and repeats it as many times as you’d
like—much like macros in Word or Excel. It uses
its own scripting language, and once you master
it, you can create your own mini-applications
that’ll do anything you want them to—from
replacing a string of characters with a phrase to
looking up a highlighted word in the dictionary.

You don’t really need to learn AutoHotkey’s
scripting language to get started—it comes
bundled with AutoScriptWriter, which records
the macros for you. One of the first things we
do immediately after installing AutoHotkey is
to assign Windows key shortcuts to our
favourite applications—[Windows] + [O]
becomes Opera, [Windows] + [Q] becomes
Quake 3 and so on. Other such simple tasks
follow, but to really tap AutoHotkey’s capabili-
ties, you’ll need to learn the language—which,
fortunately, is fairly easy to learn. You’ll find a
detailed tutorial here: http://www.autohotkey.com
/docs/Scripts.htm.

Hotkeyer’s Tip
If you’re working on multiple PCs and want to
take your scripts with you, you can compile
them to make each script a standalone EXE—
just right-click on a script and choose Compile
Script! Once you’ve done this, you can run this
EXE on any PC, so your shortcut or text replace-
ment scripts can travel with you. They reside in
the system tray, and ending them is as easy as
right-click > Exit.

The Alternative
You can get your Windows key shortcuts with
WinKey (http://www.winkeymx.com/), but there’s
really no alternative to AutoHotkey that even
comes close to what it offers. 

Winamp
www.winamp.com

It’s easy to have forgotten about Winamp—
after Windows Media Player (WMP) was

finally able to manage your music library,
many of us didn’t look beyond. And, of course,
there were problems with the program itself.
Winamp 3 was a nightmare best not talked
about and Winamp 5 didn’t match the

performance of the original Winamp 2.8. Fire
up the new Winamp 5.5, however, and we’re
impressed once again.

For one thing, Winamp’s got a slick new
interface, but still gives you the choice to use
the original Winamp skin from way back
when. The Music Library adopts the now stan-
dard three-pane interface (artists, albums and
tracks) and lets you search for artists and songs

in real time. You can double-click on songs
to add them to the playlist—it doesn’t

sound like much, but this is a feature
many loved in WMP 10 and sorely

missed in WMP 11. You can even
manage your video collection,

apart from regular features
like ShoutCast support. And

then there’s the one killer feature
that sets it apart—GraceNote.

Song-hummer’s Tip
We all have our share of files called

Track01.mp3 by an artist we don’t know, and
quite often, these are songs we really like. With
Winamp, thanks to a tie-up with GraceNote,
you can now find out who sung this mysterious
song. In Winamp’s playlist, right-click on the
file you want to identify and choose Send To
> Autotag. Make sure you’re connected to the
Internet, and within seconds, you’ll see all the
song information you need. Apply the new ID3
tag and be on your way!

The Alternative
Yahoo! Music Jukebox (http://music.yahoo.com/

www.viksoe.dk/code/gmail.htm 

How much of your 6 GB (and growing) Gmail
mailbox are you really using? Gmail Drive is a

simple Windows shell extension that lets you use
your Gmail inbox as online storage. You simply
give it your Gmail username and password and
you’ll find another hard drive listed under My
Computer. When you upload a file, it appears as a
new e-mail in your inbox. To avoid the hassle of
seeing a new e-mail every time you upload a file,
you can create a filter in Gmail that archives all
such mail (the subject line contains “GMAILFS”). 

It may not be the most extensive tool ever
made, but Gmail Drive is the best way to use all
that free space that Google has so generously
given us all.

Gmail Drive
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Readers of Photojojo swear by this axiom and have prob-
ably gotten great results by following its advice. Pho-
tojojo, is a photography related site, which dishes out

advice on DIY
p r o j e c t s ,
photo tips
and equip-
ment for the
hobby and
amateur pho-
tographer. Its
USP is the
way the mate-
rial is pre-
sented—you
feel like you
are talking to
a very enthu-
siastic friend, who is also very witty. While one day the site will
discuss how to take great and abstract photos by throwing
your camera in the air and keeping it at long exposure,
another day will be a post that shows how to take great
product photos for auction sites. The store sells different
types of equipment like tripods, WiFi enabled memory cards
and photo frames. It delivers a bi-weekly newsletter and the
site’s forum is a great place to get answers to your questions.

Digital Tools l 3 Incredibly Useful Sites

Before starting off, let us make note of one thing—this site
will make sense to doctors and medical professionals.  If
you fit into the target demographic then you would be

very interested. This Web site is owned by the US government
and is a joint effort by US National Library of Medicine and the
National Institutes of Health. It houses one of the largest data-
bases of health related papers and books, and is accessible for
free. The search engine can be used without any registration.
However, you might want to register and sign up for a PubMed
update, so you get an e-mail every time new material is
uploaded to the database.

Even though we are not medicos, we decided to check out
the archive. The Limits tab has plenty of checkboxes which can
be used to narrow down your choice of papers or extracts.
Other links lead users to hardcore databases like a complete
collection of 3D macromolecular structures, genome sequences
and eukaryotic homology groups. They have a separate page

for human genome resources as well as a map viewer related
to genetic information of different species. Undoubtedly, a
great place for researchers, students and doctors alike.

http://photojojo.com/

http://www.ncbi.nlm.nih.gov/PubMed
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http://zenhabits.net 

Atypical office worker is stressed, anxious and jumpy.  How
many times have you got a severe panic attack when you
realise that you have a report to write, with very little time

left after a whole day spent surfing for cheap airline tickets! How
many mornings have you wasted looking at your cluttered inbox
while important work was pending?

If you identify yourself with these situations, then Zen Habits
(http://zenhabits.net) is the blog for you. Filled to the brim with

smart productivity tips, motivation hacks and health advice, thou-
sands of people have turned to it for answers to lead more ful-
filling lives. This blog takes its inspiration from the Getting Things
Done principle and takes it to a whole new level. Some typical arti-
cles on the blog are “How to Actually Execute Your To-Do List”,
“How Not to Multi-task” and “How to Become a Vegetarian, the
Easy Way”. This blog also treats contentious issues related to family
and day-to-day living. This site is highly recommended for those
who want to improve their quality of life.

One of the typical posts in Zen Habits

Social experiment with a cheap camera?

A section of the resources on this page 

Live life Zen like
Bhaskar Sarma

Sites that would make a difference in your life...
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Going Pro
I am buying a new PC. Which CPU is better–Quad-
Core Q6600 (2.4 GHz) or Core 2 Duo E8500 (3.16

GHz)? What is the difference in performance of both?
Please suggest a good motherboard and a good 3D
solution also. I also need a good cabinet and power
supply to go along with the rest of the system. My
target is Hardcore Gaming and support Vista Ulti-
mate, 3D photo and video editing, recent Linux OS
like Ubuntu, Fedora, Mandrake etc.

Souvik Mukherjee

You haven’t mentioned a budget for your
PC. Also, since you seem a lot more inter-

ested in Linux than gaming, I’m assuming
gaming takes second position to programming
and such. Based on your needs, I’m recom-
mending a configuration for you. Along with the
components mentioned, I’m suggesting memory
as well. As far as your query goes, a quad-core is
meant for those who are heavily into multi-
tasking. Very few applications that home PC
users use are coded to utilise four cores properly,
so a dual-core is enough for most users, and some
applications that benefit from clock speed incre-
ments will do better on dual cores which tradi-
tionally have faster clocks than quad cores. For
gaming dual cores are mostly faster except for a
few of the latest games which are coded to take
advantage of the two extra cores.

This configuration will give you a lot of pro-
cessing power and a good graphics solution. In
case you want more storage you could opt for a
500 GB hard drive for around Rs 3,900.

Best All-rounder
I am looking for a cellphone. My budget is
around Rs 10-11,000. It must have a good

camera, sound, screen, multimedia capabilities and
almost everything. I have selected SE K790i, Nokia
5700, and Motorola MOTOROKR E6. Are there any
better models other than these in the market? Which
one do you recommend? Your recommendation is all
that matters.

Nitish 

I’ve used SEs K790i and have nothing but
praise for the phone. It’s got a good

antenna that gives great voice clarity, battery life
is good, and the screen is crisp and colourful.
Music playback and camera quality are also top-

Want a tech product, but
don’t know how to go

about buying it? E-mail
agent001@thinkdigit.com

with your complete 
contact details, and he

might answer them here!
Please note that

Agent001 only answers
purchase-related

questions in this space.

Ask Away!

Ask Agent 001

notch. In comparison, the Nokia 5700 and
Motorola E6 lag far behind. To add to the K790i’s
list of advantages its light and ultra compact. A
cheaper option to the K790i is the K800i, which
lacks EDGE support, which is useless for most
people anyway. Expect to pay around Rs 10K for
the K790i and Rs 8K for the K800i.

Rocking In The Budget World
Hi, I am a big fan of Digit and have been reading
it since Standard 3. This is my first query letter

to Digit. I want to buy a flash based MP3 player
between Rs 8,000-12,000. I want decent playback
quality, video support, easy user interface, FM, FM
recording and voice recording capabilities. I would
like one which looks nice. I do not want to buy an
iPod. I have shortlisted the Cowon D2 and Creative
Muvo T200 (don’t ask why this). Is the Cowon D2 a
good choice? If so what is its official price?

Dhiraj Agrawal

I’m curious to know why you do not want
to buy an iPod. The iPod Touch is a great

sounding, fully functional PMP. Of course, it’s
beyond your price range as well. The Cowon D2
is an amazing PMP. Great quality and what’s
more impressive is a vast array of features in
addition to the ones you mentioned above. The
great plus point being memory expansion via SD
as 8 GB cards have become quite cheap. The D2
also has amazing battery life.

The last I checked the street price of the
Cowon D2 was around Rs 9,000 for the 4 GB ver-
sion. You can buy it eyes closed.

Overhaul!
I want to change my MSI 480 motherboard. Do
the new AM2 boards support AMD Athlon 64

socket 939 processor or I have to replace the
processor as well? Let me know my options along with
the product available in the market.

Dipak Kumar Show

No, the new AM2 boards are 940 pin-based
and support DDR2 RAM. So if you want to

upgrade, you will not only be buying a new moth-
erboard, but a new processor and memory as well.
If you are buying all three components anyway,
then I suggest you invest in an Intel-based system,
as you’ll get better bang for your buck. I’d recom-
mend an Intel P35 chipset based board—look for
the Abit IP35-E, available for Rs 5,000. For the
processor look for a Core 2 Duo E2180 if you’re
looking for extreme value; if you want perform-
ance, look at the Core 2 Duo E8400 for Rs 9,000. I
recommend 2 GB of DDR2 RAM—look for a fre-
quency of 667 MHz. Brands to look at are Tran-
scend and Kingston. Expect to pay around Rs 1,900
for 2 GB. If, however you’re looking only to replace
your motherboard and not your CPU or memory,
take a look at NVIDIA’s GeForce 6100 / 6150 based
chipsets. Expect to pay up to Rs 3,000. 

Component Suggestion Approx Price

Processor Core 2 Duo E8400 (3.00 GHz) Rs 9,000

Motherboard Abit IP35-E Off Limits Rs 5,000

RAM 2x1 GB DDR2 667 (Transcend) Rs 1,950

Graphics Card Gigabyte GeForce 8800GT Rs 11,000

Hard Drive Seagate 7200.10 250 GB Rs 2,200

Total Price Rs 29,150

Basic Gaming PC
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One of my friends wanted a cam-
era, and as luck would have it, I
was on my way out to get one for

a colleague when I got that call... 
Previously, anyone wanting a digital

camera would be pointed towards the
de facto 5 to 7 megapixel camera with a
3x optical zoom. But needs differ, and
vendors have done well to recognise
this fact. Although the larger semi-pro-
fessional DSLR cameras have always had
a multitude of settings in their exhaus-
tive and sometimes complicated
menus, I’ve found compact cameras to
lack many options—either in their
menus or in terms of usability. The com-
pact cameras today are another story. I
did a little surfing and came up with
quite a few cameras that were refresh-
ingly different. There are the ultra
zoom models—cameras with optical
zoom (ignore digital zoom claims
please) in the region of 6x to 12x, as
well as some compacts with smaller
zooms, but large resolution image
sensors. Then there are the ultra
compacts—about as big as the aver-
age cell phone.

Vendors will have you believe
that Kodak, Fuji and Nikon are entry
level or mid-range offerings—though
this isn’t true—probably because of the
cheaper models they stock from these
brands. One vendor told me, “People
who want higher-end models usually
ask for Canon or Sony, while those look-
ing for a budget camera prefer Kodak
and Nikon.”  My advice: ignore what
vendors tell you—most of them really
don’t know what they’re talking about.
Before you go out and buy a camera, do
your research, read our reviews and
make up your own mind. 

Among the ultra compacts, the first
brand worth mentioning was Canon with
their Digital IXUS series. The IXUS 800IS,
860IS, 900Ti and 950IS were all on display.
The 800IS is based around a smaller 6
megapixel image sensor and priced at 
Rs 12,000, while the 950IS is based around
a larger 8 megapixel sensor and priced at
Rs 16,000. Both cameras sport an optical
zoom of 4X—good for an ultra compact
camera, but strictly ordinary for a regular
digital camera. The more expensive SD
900Ti isn’t necessarily a better camera

with a 3x optical zoom and a macro
shooting range of not less than 5 cm. Its
selling point is the titanium body, which
isn’t worth it at Rs 18,000. The newer IXUS
860IS is available for Rs 15,500 and fea-
tures a 3.8X optical zoom. Sony’s T series
of cameras is even more attractive. For
one, they are tinier than Canon’s offer-
ings, and come in different colours. They
also have all the features that some larger
cameras lack—like the 5x optical zoom on
the Cybershot T300 (10 MP) and T200 (8.1
MP). Both feature Sony’s patented double
anti-shake blur reduction, which is fancy
handle for optical and digital image sta-
bilisation systems that these cameras
integrate. At
Rs 18,000 for

the T300, and Rs 17,500 for the T200, these
cameras vie for your cash. In addition, the
T200 features a touch screen, something
nifty to watch out for.

Among the entry-level cameras,
Nikon’s Coolpix L16 and L18 are avail-
able at Rs 6,000 and Rs 6,800, respec-
tively. Both have 3X optical zooms, the
former is a 7 megapixel camera, while
the latter is rated at 8 megapixels.
Kodak’s C713 (7 megapixel, 3X optical
zoom) is available at Rs 5,000 and
should be the minimum you should set-
tle for. Canon’s A470 was also on dis-
play, 7 megapixels and a 3.4x optical
zoom for Rs 5,500.

Among the ultra zoom models,
Kodak’s ZD710 (Rs 9000) is a spanking
new model with a 7 megapixel sensor
and a large 10X optical zoom. Even
more capable is Canon’s SX100IS,
which also has a 10X zoom and a slight-
ly larger sensor at 8 megapixels. Priced

well at Rs 12,500, it also features image
stabilisation, which is a plus when
using such long zooms. The largest
zoom-bearing model I could find was
the Nikon P80, which astonishingly
enough features a large 10 MP rated
sensor and an 18X optical zoom. It’s
priced well at Rs 16,000.

Among the regular cameras Sony’s
W300 impressed me with its sleek titani-
um-coated body, and a whopping 13.6
megapixel sensor and 3X zoom. Priced at
Rs 16,800, this camera is great for those
looking for something compact yet pow-
erful. The W200 (12.1 MP, 3X zoom, Rs
14,720) and W120 (7 MP, 4X zoom, Rs
9,000) were also on display although the
latter (W120) isn’t as impressively built as
the other two. Nikon’s P50 (8.1 MP, 3.6X
zoom, Rs 8,800) was another well built,
well laid-out camera and has a better grip
for shooting than the flat, compact
Sony’s, but isn’t as pocketable. The P5100
adds a larger sensor, that is, 10 MP to the
P50. The zoom is identical, as is build
quality, with a price of Rs 11,700.
Olympus’s FE310 is one of their entry
level offerings with some impressive
specifications at 8 MP, 5X zoom. It’s
priced extremely well at Rs 6,600. The
only minus is Olympus’ proprietary
memory standard—xD cards. Canon’s
A720IS was on display—a successor to my
now old A710IS. At Rs 10,400, and with an
8 MP sensor and 6X zoom, the A720IS is a
well-built and well-balanced camera in
terms of features and performance. A
whopping 12 MP rated A650IS, also fea-
tures a 6X zoom and is priced at Rs
14,000. This one also has a larger grip, a
consequence of it requiring four AA bat-
teries, rather than two, and features a
swivel viewfinder display. The A580 (8
MP, 4X zoom) was priced at Rs 7,700 and
the A590IS (8 MP, 4X zoom) was priced at 
Rs 8,600. Kodak’s M893IS is a neat look-
ing camera (8 MP, 3X zoom), but it’s not
as well built as some of the others.

I recommended the all round capa-
bilities of the Canon Powershot
SX100IS to my friend and he decided to
pick it up for this price. My colleague
at office decided he didn’t want the
extra zoom and went for the A720IS,
another great all rounder. 

agent001@thinkdigit.com
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I’ve got a hankering for the perfect picture
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This Type of Editing in the
Document. Once done, Word will
enable a drop-down list 

3. Using the drop down list, choose
Comments. Select Yes, start
using Enforcing Protection.
This will prompt the Enforcing
Protection dialog box.  

4. Enter a password in the box, Click OK
and save the file as Normal. 

Inserting Files

There may be a need when you have to
add a file to the current document or
append a document in the middle of
your document. This can be achieved in
the following manner:
1. Position the cursor where you want

the other file to be inserted.
2. Select the Insert tab on the Ribbon

and in the Text group, click the
down-arrow to the right of the
Object tool.

3. Choose the Text from File option,
which will open the Insert File
dialog box.

4. Select the file you want to insert and
click on OK.

Formatting Inconsistencies
(Blue Underline)

Word has its ways of error notifications
by way of marking errors with under-
lines—Red for spelling mistakes, Green
for grammatical mistakes and Blue for
formatting inconsistencies. While the
first you are important the third might
not be for most of us. There is a way to
stop them, here’s how.
1. Click the Office button and then

choose Word Options.
2. Click Advanced in the left hand

column and scroll to the Editing
Options section. Deselect Mark
Formatting Inconsistencies and
click Ok.

Putting Borders

You can add borders to your paragraph
or if need be to one entire page. Follow
these steps to do it.
1. If you are not planning to add borders

to all pages in your document then
position the cursor on the part which
will use borders

2. Go to the Page Layout tab of the
Ribbon and choose Page Borders
under the Page Background group.
It will open the border and shading
dialog box

3. Use the controls in the dialog box to
specify the border appearance. You can
also apply artistic borders using the
Art drop down list.

4. Use the Apply To drop down list to
select what parts of the document
should use borders and click OK.
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WORD 2007
Quick Access Toolbar

There are certain commands you might
want to add to the Quick Access Toolbar
for easy access. For example, to add the
Date & Time command: 
1. Click the Customize Quick Access
Toolbar button to the right of the
Office button and choose More
Commands.

2. In the Choose Commands From drop
down, select All Commands.

3. Choose Date & Time and click Add.
Click OK to add a Date & Time
button to the Quick Access toolbar; you
can add other commands in a similar
fashion as well.

Compare Documents

You can use Word’s synchronous scroll
to compare two documents:
1. Open both the documents 
2. In the View Tab, choose View Side
By Side under Window; both docu-
ments will be displayed side by side. If
you want to view the documents hori-
zontally instead, choose Arrange All.

3. To scroll the two documents together,
choose Synchonous Scroll under
Window in any of the windows.

Automatically Select Words

When selecting text from middle of a
word (usually to delete), Word 2007
automatically selects the whole word
and this extra-helpful feature tends to

be an annoyance. Here’s how you put an
end to it. 
1. Click on the Office button and choose

Word Options. 
2. In the list of options, choose Advanced

in the left hand column 
3. Deselect the Automatically
select entire word check box

Turn Off Paste Options

If you Copy-Paste information in Word a
small dynamic Paste Option menu
appears next to the just pasted informa-
tion, it distracts many but thankfully
can be turned off.
1. Click on the Office button and choose
Word Options.

2. In the list of options choose Advanced
in the left hand column 

3. Scroll through the various options
until you get to the Cut, Copy,
Paste, section.

4. Deselect Show past Options
Button

Controlling The Smart Cut And
Paste Feature

When copy-pasting any information into
a document, we unknowingly add or
remove spaces. For such situations the
smart Cut and Paste feature comes
handy. It needs to be turned on.
1. Click on the Office button and choose
Word Options.

2. In the list of options choose Advanced
in the left hand column 

3. Scroll through the various options
until you get to the Cut, Copy,

Paste, section.
4. Select the Use Smart Cut and
Paste check box to turn it on.

5. You can tweak it further to your liking
by clicking on the Settings button 

Creating A Proper Registered
Trademark Symbol

The registered trademark symbol can be
generated in Word by typing in (r)—how-
ever, the resultant mark isn’t super-
scripted. To do so, follow these steps:
1. Highlight the registered trademark

symbol that results after (r).
2. Press [Ctrl] + [Shift] + [+].

This will superscript the mark
3. Now click the Office button and then

choose Word Options.
4. In the left hand column select
Proofing and select the
AutoCorrect Options button.
Word will display the AutoCorrect tab
of AutoCorrect dialog box.

5. In the Replace box, type (r) and the
with box should already be filled with
the registered trade mark symbol in
the first if you had selected it in step 1

6. Make sure the Formatted Text
option is selected 

7. Click Replace. Word will ask if you
want to replace existing AutoCorrect
definitions. Click Yes; the old defini-
tion will be replaced.

Using A Non-breaking Hyphen

When Word 2007 calculates line length
it tries to break the line and wrap it to
next line on a space or hyphen.
However, sometimes you might not
want it to wrap at a hyphen—for
example, with telephone numbers.
Using a non-breaking hyphen is the
key—here’s how:

To create a non-breaking hyphen,
press [Ctrl] + [Shift] + [-]
instead of just the hyphen.

Limiting Edits To Comments

Any document can be protected by
making it read-only and adding a pass-
word. However, when you have group of
people reviewing the document, they
should be able to add comments, at
least. Here’s how to do it: 
1. Under the Review Tab, choose the
Protect Document tool. Word dis-
plays the protect document pane at
the right side of your document

2. In the Editing restrictions sec-
tion of the pane, choose Allow Only
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Ribbon Shortcuts
Key combination Function
[Alt]+[F] Office Button
[Alt]+[H] Home tab
[Alt]+[N] Insert tab
[Alt]+[P] Page Layout tab
[Alt]+[S] References tab
[Alt]+[M] Mailings tab
[Alt]+[R] Review tab
[Alt]+[V] View tab
[Alt]+[L] Developer tab

Function key Shortcuts
[F1] Invoke help

system
[Shift]+[F1] Context-sensitive 

help or reveal
formatting

[Alt]+[F1] Next field
[Shift]+[Alt]+[F1] Previous field
[Ctrl]+[Alt]+[F1] Display Microsoft 

System
Information

[F2] Move selection
[Shift]+[F2] Copy selection
[Ctrl]+[F2] Print Preview
[Shift]+[Alt]+[F2] Save
[Ctrl]+[Alt]+[F2] Open

[Shift]+[F3] Change case of 
selection

[Ctrl]+[F3] Cut selection to 
the Spike

[Alt]+[F3] Create a Building
Block entry

[Shift]+[Ctrl]+[F3] Paste informa-
tion from the 
Spike

[F4] Repeat last 
action

[Shift]+[F4] Repeat last Find 
or Go To 
operation

[Ctrl]+[F4] Close window
[Alt]+[F4] Quit
[Shift]+[Alt]+[F4] Quit

[F5] Go To
[Shift]+[F5] Return to last 

edit location

[Alt]+[F5] Restore program 
window size

[Shift]+[Ctrl]+[F5] Edit bookmark

[F6] Next pane
[Shift]+[F6] Previous pane
[Ctrl]+[F6] Next window

[Alt]+[F6] Switch between 
dialog box and 
document

[Shift]+[Ctrl]+[F6] Previous window
[Shift]+[Alt]+[F6] Previous window

[F7] Spell check
[Shift]+[F7] Thesaurus
[Alt]+[F7] Select next 

spelling error 
and display 
Context menu

[Shift]+[Ctrl]+[F7] Update links
[Shift]+[Alt]+[F7] Display Research

task pane

[F8] Extend selection
[Shift]+[F8] Collapse selection
[Ctrl]+[F8] (not assigned)
[Alt]+[F8] Display Macros

dialog box
[Shift]+[Ctrl]+[F8] Start COL 

selection mode

[F9] Update fields
[Shift]+[F9] Toggle display of

field code or results
[Ctrl]+[F9] Insert field code

braces
[Alt]+[F9] Toggle display of 

all field codes or 
results

[Shift]+[Ctrl]+[F9] Convert field to 
regular text

[Shift]+[Alt]+[F9] Run 
GOTOBUTTON or 
MACROBUTTON 
from a field

[F10] Show KeyTips
[Shift]+[F10] Display Context 

menu
[Ctrl]+[F10] Maximize document 

window
[Alt]+[F10] Maximize program 

window
[Shift]+[Alt]+[F10]Control Smart 

Tags

[F11] Next field
[Shift]+[F11] Previous field
[Ctrl]+[F11] Lock a field
[Alt]+[F11] Display VBA 

editor
[Shift]+[Ctrl]+[F11] Unlock a field

[F12] Save As
[Shift]+[F12] Save
[Ctrl]+[F12] Open
[Shift]+[Ctrl]+[F12] Print

Microsoft Word 2007 Shortcuts
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Time Lapse Photography
A quick, straightforward method to get time lapse photography 

There are many tricks and experi-
ments that can be done with digital

cameras, and time lapse is one of them.
Time lapse photography is great fun—
capturing a time frame using single
photos taken at intervals. All these
frames are put together to create a short
video clip. You don’t need any high-end
equipment to do this either—just a dig-
ital camera and a few free applications
here and there. You also need patience
and you need to be specific.

The Requirements
Getting to the specifics, you require a
digital camera for capturing the
images. You also need a tripod prefer-
ably, or a good stationary platform
where you can keep your camera for a
very long period. You need to down-
load the latest version of VirtualDub
(www.virtualdub.org). We’ll be using it
to encode the final video. You’ll also
need suitable codecs such as Xvid or
x264 installed on your PC. If you wish
to give your photos a slightly different
treatment, then an image editor such
as GIMP or even Photoshop will add
sparkle to it.

I’m Equipped…Now What?
First select a target object you want to
take the time lapse photo shoot of. It
could be anything—a busy street, a
blooming flower or even a lunar
eclipse. Place the camera on the tripod
or on a table at a suitable distance
from the target you are shooting. Be
extremely careful—you must not move
the camera from that position at all.
Remember that the camera has to be
in that position for a really long
period, so you shouldn’t be doing a
shoot like this on a rainy day. 

Setting An Interval
Depending on the type of object of the
time lapse shoot, you need to decide
an interval, after which the followings
shots will be taken. A time lapse of a
flower blooming in the morning could
happen in 5 hours, for example, so you
need a sufficient number of frames to
make up a good length time lapse. For
a good five second time lapse shot, you

would need a good 125 to 150 separate
photos if you want a video with a
frame rate of 30 fps. In this case, you
would need to take a photo every 2
minutes of the object.

Once that is decided, turn on the
camera’s image stabilisation feature
and use a two-second timer to prevent
any shake that might occur with you
press the trigger. Now it’s just a matter
of time and patience and clicking the
photos in time after every two min-
utes. Make sure you have a sufficiently
large memory card and the battery
fully charged so you don’t have to dis-
turb the camera anytime. Remember,
you don’t need to take photos at 8 MP
resolutions. Anything up to 3 MP
should be good enough—the final
result is going to be a video, not a
slideshow. Don’t change any settings
between photos.

Creating The Time lapse Itself
Once the shoot is done, copy all the
images from the camera to a single
folder on the computer. Make sure to
delete all previous photos taken on the
camera. At this point, you can use
Photoshop to adjust or fix any photos
that might have shifted. 

From here on, things get really
simple. Open VirtualDub up and click
on File > Open Video File. Make
sure the checkbox for
Automatically load linked
segments is checked. Browse to the
folder where the photos are stored and
choose the first image of the sequence.
Click on Open. Just be sure that the
images are numbered properly.

Creating The Video

With the sequence video imported into
VirtualDub, its time to select the codec
we want to use to export the video.
Click on Video > Compression and
then select a codec from the list. If you
have Xvid, select it and choose the
quality or bitrates at which you want
the video encoded. If you want a short
audio clip, you can add it by clicking
on the Audio menu and then on Audio
from other file. Select the file and
click Open. You can also add some
basic effects in VirtualDub by clicking
Video > Filters. When you are
happy with the clip, click on File >
Save as AVI. Choose a location and
click on Save.

A quick search for the keywords
‘time lapse’ in YouTube will show up
several examples of people trying it
with their own digital camera. Along
with some very interesting time lapse
sequences, you’ll be shocked to find
time lapse videos with people who
have been taking photos of themselves
everyday over a couple of years.
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1—Sort by title, A-Z
2—Sort by title, Z-A
3—Sort by visit date, most recent last
4—Sort by visit date, most recent first
5—Sort by URI, A-Z
6—Sort by URI, Z-A
7—Sort by visit count, ascending
8—Sort by visit count, descending
9—Sort by keyword, A-Z
10—Sort by keyword, Z-A
11—Sort by date added, most recent last
12—Sort by date added, most recent first
13—Sort by last modified date, most
recent last
14—Sort by last modified date, most
recent first
17—Sort by tags, ascending
18—Sort by tags, descending
19—Sort by annotation, ascending
20—Sort by annotation, descending

queryType options
0—Search only History
1—Search only Bookmarks
2—Search both

maxResults is the maximum number of
results you want. 

Tag Your Bookmarks

While we’re on the subject of bookmarks,
you should also know that when you
create a new bookmark, you now have
the option to tag it—you could tag book-
marks relating to your upcoming holiday
with “Monsoon Trip”, for example. Make
sure you separate each tag with a comma.
Now, when you type a tag into Firefox’s
address bar, the bookmarks with that tag
will come at the top of the list.

Find Faster

Instead of using [Ctrl] + [F] to find
a word in a page, you can use Firefox 3’s
new Quick Find to search within a
page—just hit [/] to begin. You can also
eliminate this step by enabling Type
Ahead Find. To enable it, type
about:config in the address bar, and
in the configuration page, look for
accessibility.typeaheadfind.
Double-click on it to set it to True. Now,
to search for a word in a page, just start
typing it, and quick find will find it for
you. If you only want to look for links,
also enable accessibility.typea-
headfind.linksonly (if you prefer
using a shortcut instead of this, hit [']
to start Quick Finding links). When
Quick Find has found your link, just hit
[Enter] to visit it.

Richer Results?

When you begin typing in Firefox’s
address bar, the results are a lot smarter
than just a list of previously visited sites.
To increase the number of these smart
(or rich, as they’re called) results, open
about:config in a new tab, and use
the filter to search for
browser.urlbar.maxRichResults
double-click on it to change the value to
anything you want.

Delete Meaningless Results

If you’ve mistyped a URL and visited it,
Firefox will still bring it up in your rich
results—clearly, you don’t want that
happening. To get rid of the entry, enter
the URL till you see the one you don’t
want, use the down arrow to select it
and hit [Delete] (on the Mac, you’ll
need to use [Shift] + [Delete]).
You’ll never see that URL in your rich
results again.

Ring In The Old

If you don’t like Firefox’s rich results
(displayed in what is actually called the
AwesomeBar), you can use the Oldbar
extension (https://addons.mozilla.org/en-
US/firefox/addon/6227) to get back to the
old “URLs only” address bar.

Gmail For mailto: Links

The ability to assign protocol handlers
programs that’ll accept links from dif-
ferent protocols like ftp, mailto and so
on—isn’t new, but thanks to Google’s
love for Firefox, you can now assign
Gmail as the default e-mail handler for
mailto: links. Open Gmail in a new tab.
In this same tab, enter this JavaScript
snippet: javascript:window.navi-
gator.registerProtocolHandler
(“mailto”,”https://mail.googl
e.com/mail/?extsrc=mailto&url
=%s”,”Gmail”). You’ll see a warning
bar at the top of the page, asking you
whether you want to add Gmail as the
default mailto handler. Select Add
Application, and you’re done!

Adding Sound To A Document

At times you may feel the need to add
multimedia to you document and it is
possible to add sound files to the docu-
ment; here’s how. 
1. Position your cursor at the point

where you want to insert a sound file.
2. Go to the Insert Tab of the Ribbon

and click Object in the Text group.
This will open the Object dialog box.

3. Browse and select the sound file to be
inserted and click OK. A Speaker icon
will appear at the insertion point. 

4. To listen to the sound, double-click the
speaker icon.

FIREFOX 3
Know Where You’re Going

You can set Firefox to tell you when the
site you’re viewing redirects to another
site—sometimes you may end up far
from where you want to be. To enable
this, go to Tools > Options (or Edit
> Preferences if you’re using Linux)
> Advanced. Under General, check
the box against Warn me when sites
try to redirect or reload the
page. Henceforth, you’ll get a warning
bar every time a site redirects you. 

Create Your Own Smart
Bookmarks

Firefox keeps a record of sites you visit
often, and generates a list of “Smart
Bookmarks” that you can access from the
Bookmarks toolbar. You can create your
own list of smart bookmarks using
custom queries instead of URLs as well.
Right-click on the Bookmarks toolbar and
choose New Bookmark. Use a descriptive
name for the bookmark, and under
Location, enter one of the queries below
(whichever suits your fancy, or tweak
them to get the results you want): 
lFor your 10 Most Visited Sites:
place:queryType=0&sort=8
&maxResults=10
lFor your 10 Most Recent Bookmarks:
place:queryType=1&sort=12
&maxResults=10
lFor your 10 Most Visited Sites with
“thinkdigit” in them:
place:queryType=0&sort=8
&maxResults=10&terms=thinkdigit

Here’s all the information you need
to build these queries:
sort options
0—Natural bookmark order

Importing the entire sequence of images
into VirtualDub

Selecting audio and video codecs for the
movie

Filters and effects can be added to enhance
the video

Get the old Firefox address bar back
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Advertisements are annoying to all
of us. They do create revenue for

sites, but most of the time , they are of
little importance to the user and all
they do is nibble away at your band-
width. Sometimes, they can show inap-
propriate content as well. We are going
to look at ways to disable or at least
hide the ads off the screen with pretty
much any of the most used browsers.

Ad Blocking In Firefox
Ads come in all forms and popups are
one of the most annoying ways of
which ads make their way on to the
screen. Firefox, like most other
browsers today, stops popups from
appearing on the screen.

For blocking of advertisements,
there is an extremely useful and well
known add-on called Adblock Plus. Get
it from http://adblockplus.org/en/. Click
on the Installation link to go to
that page to download the add-on. You
have to click on the Allow button on
the right top of the Firefox window to
permit the add-on to be downloaded
and installed. Restart Firefox.

Once Firefox starts, choose Tools
> Add-ons. Click on Options for the

Adblock Plus add-on. Click on Filter
> Add filter subscription. Use
the dropdown for Subscription title
and choose the lists you want to add
and click OK. Follow the steps to add
additional subscriptions. Once added,
click on Filters > Update all sub-
scriptions. Click OK.

Ads should now be blocked by
Firefox, and even if you do find some

ads that do make their way through
the filters, right click on the image of
the ad and click Adblock image…

Flash elements can also be disabled
by using the Flashblock add-on for
Firefox. This can be downloaded and
installed from http://flashblock.
mozdev.org. Flash elements will only
work when you click on them.

Ad Blocking In Opera
Opera has a built in popup blocker and
an ad blocking feature as well. Using
the ad blocker is as simple as down-
loading a text file and putting in the
right folder. Opera’s ad blocking works
by referring to a file called url-
filter.ini. There are many users
who keep regularly maintained lists of
ad hosts and domains. 

One of the most famous one and
most used ones is Fanboy’s Adblock
List (www.fanboy.co.nz/adblock/)
Click on the Install now link or visit
http://fanboy.co.nz/adblock/o
pera/urlfilter.ini. Save the file
as it is to a folder and then move it to
C:\Documents and
Settings\Your_User_ID\Applica
tion Data\Opera_folder\pro-
file. Linux users must copy to the
.opera folder. When done, restart the
browser and ad blocking will be
enabled. Visit the site from time to
time to update your ad block list. 

Ad Blocking In Internet Explorer
Internet Explorer has been heavily crit-
icized for letting popups and ads run
loose but it too has a 3rd party add-on
that users can download. It is called
IE7Pro and can be downloaded from
www.ie7pro.com. Click on the
Download Free, download the
installer and run it. In the last few
steps of the installation you will be
asked whether you want to enable
spellchecking and if you want to set
EasyHome as your homepage. Uncheck
the boxes if you don’t. Click Next and
finish the installation.

Restart Internet Explorer and you
will find an IE7Pro icon in the status

bar below or a button for IE7Pro
Preferences in the toolbar above.
Click it and then on AD Blocker.
Enable Flash blocker to block flash
items from web pages. You can also
add your own filters in the My
Filters tab. IE7Pro brings many
more features than just ad blocking to
Internet Explorer. Prefetching and
mouse gestures are just some of these
few features.

Universal Ad Blocking Across
Windows
Ads can also be blocked across all
browsers and applications running in
Windows. This is done through a file
called HOSTS that is located in
C:\WINDOWS\system32\drivers\
etc. Like the urlfilter.ini list
that was used for Opera, similar lists
are available for Windows. The list
redirects domains to other domains
or IPs. This way, none of the ads can
be downloaded to your browser.
Manual entries can be made by
opening the file in a text editor. If you
download a HOSTS file, copy it to the
path mentioned above.

It is also a good idea to also have a
spyware removal utility installed—they
not only block ads, but malware and
trojans as well. Spybot (www.safer-net-
working.org) for example is one of such
software. Keep it updated and run it
from time to time and keep safe dis-
tance from possibly dodgy links and
your PC should be just fine!
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Opera-like Searching

When you type a search term in
Firefox’s address bar, you’ll either get
an error or be taken to the “I’m feeling
lucky” Google result for that term. It’s
annoying that you’d have to change
focus to the search box, when both
Opera and IE support searching from
the address bar itself—in Opera, you
can precede the search term with “g”
to use Google, “y” to use Yahoo, and so
on. To get this in Firefox, first click on
the arrow next to the search engine’s
icon in the search box and choose
Manage Search Engines. Select a
search engine and choose Edit
Keyword. Enter a keyword of your

choice—”g” for Google, for example—
and click OK. From now on, when you
precede any search term with “g” in
the address bar, Firefox will send you
to the Google results for that term.
Repeat for all other search engines. 

Don’t Zoom The Images

When you hold down [Ctrl] and scroll
the mouse wheel to zoom into pages, you
might not want images to resize and get
distorted just so you can read text a little
better. To enlarge only text, go to View >
Zoom and choose Zoom Text Only.

Resistance Is Futile

It’s no coincidence that Firefox 3’s new
mascot is a robot. You see, Firefox wasn’t
created by humans! Just type about:robots
in the address bar to find a secret mes-
sage from the creators. They claim they
come in peace, but we know better...

EXCEL 2007

Adding Due Date Alerts

We all use Excel for keeping track of
personal finance—paying bills, for

instance—wouldn’t it be great if Excel
could alert you of an approaching due
date? Here’s how you do it:
1. Select the cell that contains the due

date and go to the Home tab.
2. Click the Conditional
Formatting option in the Styles
group and choose Manage Rules.
This will invoke the Rules
Manager dialog box.

3. Click on the New Rule button
4. Choose Format Only Cells that
Contain

5. In the Edit the Rule
Description area, make sure the
first drop down list has Cell
Value. The second drop down should
be set to Less Than

6. In the formula area enter
=Today()+7

7. Click the Format button and in the
colour drop down choose any colour
you like. 

8. Here, if the due date is within the
next seven days, it changes to the
colour you chose. You can create one
more rule and replace the formula
with Today() and changing the
colour to say Red, so if the date is
past due it will appear red.

Changing Gridline Colours

Command Shortcut 
Navigation 
Back [Alt] + Left Arrow

[Backspace]
Forward [Alt] + Right Arrow

[Shift] + [Backspace]
Home [Alt] + [Home]
Open File [Ctrl]+[O]
Reload [F5]

[Ctrl] + [R]
Reload (override cache) [Ctrl] + [F5]

[Ctrl] + [Shift] + [R] 
Stop [Esc]

Search 
Find [Ctrl] + [F]
Find Again [F3]

[Ctrl] + [G]
Find As You Type Link [‘]
Find As You Type Text [/] 
Find Previous [Shift] + [F3]
Web Search [Ctrl + [K]

[Ctrl] + [E]

Windows And Tabs 
Close Tab [Ctrl] + [W]

[Ctrl] + [F4]
Close Window [Ctrl] + [Shift] + [W]

[Alt] + [F4]

Move Current Tab Left [Ctrl] + Left Arrow
[Ctrl] + Up Arrow 

Move Current Tab Right [Ctrl] + Right Arrow
[Ctrl] + Down Arrow

Move Current Tab to Beginning [Ctrl] + [Home]
Move Current Tab to End [Ctrl] + [End]
New Tab [Ctrl] + [T]
New Window [Ctrl] + [N]
Next Tab [Ctrl] + [Tab]

[Ctrl] + [Page Down]
Open Address in New Tab
(from Location or Search Bar) [Alt] + [Enter]
Previous Tab [Ctrl] + [Shift] + [Tab]

[Ctrl] + [Page Up]
Undo Close Tab Ctrl+Shift+T 
Select Tab (1 to 8) [Ctrl] + [1] to [8] 
Select Last Tab [Ctrl] + [9]

Miscellaneous 
Complete .com Address [Ctrl] + [Enter]
Complete .net Address [Shift] + [Enter]
Complete .org Address [Ctrl] + [Shift] + [Enter]
Delete Autocomplete Entry [Delete]
Full Screen [F11]
Select Location Bar [Alt] + [D]

[Ctrl + [L]
Select Search Engines 
(when Search Bar is focused) [Alt] + Up Arrow

[Alt] + Down Arrow
[F4]

Firefox Keyboard Shortcuts

Block Ads Now!
Closing the gate to sneaky ads no matter what the browser

Adding subscriptions to Adblock Plus

IE7Pro blocks ads and adds several other
useful features missing in Internet Explorer

Add keywords for search engines
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By default, the gridlines are a boring
gray, and some people might want to
change the colour to, say, black or blue.
This how it is done:
1. Click the Office button and choose
Excel Options. 

2. Click Advanced in the left column
and scroll through the right list until
you see the Display options.

3. Ensure the Show Gridline check
box is selected. Then using the
Gridline Color drop-down list,
choose the colour you want to use and
click OK. 

4. When you want to hide the gridlines
you can simply deselect the Show
Gridline check box

Don’t Recalculate Now

When you change any cell in a work-
sheet, Excel automatically recalculates
the whole worksheet to keep it up to
date. But if you have a huge worksheet
or terribly slow computer, this behav-
iour will hog more time to calculate
than to enter data. One way to get over
it is to change the default behaviour to
manual worksheet calculation:
1. Click Office button and choose Excel
Options

2. In the left side column, click on
Formulas and scroll to Calculation
Options in the right side column.

3. Select the Manual radio button which
ensures the workbook calculation is
done manually. 

4. Click OK to complete. For manual cal-
culation, hit [F9] for the final
changes to reflect in the workbook. 

Error Checking

Excel checks each workbook for errors of
various kinds and these settings can be
altered if you like. 
1. Click on the Office button, then

click the and choose Excel Options
2. In the left side column, click on
Formulas and select Enable
Background Error Checking

3. You can select or deselect the rules in
the Error Checking Rules area as
per your needs

Changing [Enter] Behaviour 

Normally, when you hit [Enter] in
Excel, the cursor moves down but you
can change that behaviour. This tip
comes handy when your Excel work

spans horizontally and not vertically. 
1. Click on the Office button and choose
Excel Options to open the Options
dialog box. 

2. In the left side column, select
Advanced and look for Editing
Options.

3. The first option in Editing Options
section of the dialog box determines
whether the cursor should move or
not, if you select Move Selection.

4. Then select After Pressing Enter
Move selection and select the
appropriate direction in the drop-
down menu.

Displaying Full Screen

There may be times when you want to
see as much of the spreadsheet as pos-
sible. Switching to full-screen mode is a
good option and can be used as an add-
on to zooming. 

In the View tab on the Ribbon, select
Full Screen in the Workbook View
section. When done, simply click the on-
screen button to restore or press [Esc]. 

Viewing Multiple Worksheets
At The Same Time

At times you might have to view dif-
ferent worksheets of the same workbook
simultaneously—this can be achieved by
a small trick as soon below.
1. Open a single workbook.
2. Go to the View tab and choose New
Window under Window. Excel will
open the same workbook in another

new window.
3. Now, on the View Tab of the ribbon,

click Arrange All in the window
group and arrange both the windows
to your liking.

4. In each window, select a different
worksheet to view them together. 

Saving With A Thumbnail

When you use the open dialog box to
open any Excel workbook, some files dis-
play a preview of the workbook and some
don’t. If you want all your Excel files to
show a preview you need to save the pre-
view when closing the file. Here’s how:
1. First open the workbook and select
Office > Prepare >
Properties. Excel will display some
of the workbook’s properties.

2. Click the Document Properties
drop-down list (found at top-left
corner of the visible properties) and
choose Advanced. Here, make sure
the Summary tab is selected.

3. Select the Save thumbnails for
all Excel Workbooks check box
and click OK to close the properties
dialog box. 

Cycling Through Font Colours

Excel provides a tool you can use to cycle
though the available font colours.
Though it isn’t provided by default, you
can add it to the Quick Access toolbar.
1. Click on the Office button and choose
Excel Options.

2. Click the Customize option in the
left side column and in the Choose
Command From drop-down list select
Commands not in Ribbon.

3. In the list of commands select Cycle
Font Colour tool and click the add
button to add it to the right hand side
dialog box. 

4. The Cycle Font Colour tool will be
available on the Quick Access toolbar. 

Finding Cells By Colour

This can be achieved with the simple
find and replace dialog box. This is how
it is done;
1. Press [Ctrl] + [F] to invoke the
Find & Replace dialog box and
then select the find tab.

2. With nothing in the Find What box,
click on the Format button, which will
open the format dialog box.

3. In the Format dialog box, go to the

Fill tab and then select the appro-
priate colour.

4. Click on OK to close the Format dialog
and then choose Find All. The
address of all the cells with that par-
ticular colour will be listed in the find
and replace box. 

5. Select one and then press [Ctrl] +
[A] to select all other similar
coloured cells.

Indent Cell Contents

There might be time when you need to
indent contents in a cell—like when put-
ting down things below a main heading.
The easy way is to insert spaces, but it’s
just tacky. Here’s how you indent right:
1. Select the cells you want to format.
2. Click the small icon at the bottom

right in the Alignment group on the
Home tab. This will invoke the Format
cells dialog box 

3. In the horizontal drop-down list select
Left (Indent) or Right
(Indent), depending on how you
want to indent. 

Protecting Worksheet Names

In a collaborative environment where
workbooks are shared, you might want
to protect worksheet names. Here’s how:
1. In the Review tab, choose Protect
workbook in the Changes group. This
will open the Protect Structure
and Windows dialog box.

2. Select the Structure check box and
enter a password in the Password box. 

3. Click on OK. Excel will prompt to re-
enter the password; do so. 

Sort Data In A Protected
Worksheet

Once you protect a worksheet, Excel
stops users from executing variety of
tasks on the worksheet data. You can
still allow you colleagues to do some
basic operations and yet have the sheet
protected:
1. Under the Review tab, select
Protect Sheet.

2. At the bottom of the dialog box you
will see long list of check boxes.
Checking each box will allow the user
that particular operation. This way,
you can specify what all functions
the users are permitted to perform
on the worksheet.

Excel 2007 Shortcuts

We all love Opera’s speed dial—
quick shortcuts to up to nine of

your favourite Web sites. It was a fea-
ture in Opera Mini, and you’d use a
button on your keypad to select one of
these sites. On the PC, however,
there’s no reason you should be lim-
ited to nine options, though. To add
more rows and columns to Opera’s
speed dial, navigate to
C:\Documents and Settings\
[username]\Application
Data\Opera\Opera and open
speeddial.ini in a text editor. Add
these lines at the top:

[Size]
Rows=3
Columns=4

(or anything you prefer)

Bet You Didn’t Know

Shortcut Result
[Ctrl] + [Shift] + [(] Unhides any hidden rows within the selection.
[Ctrl] + [Shift] + [)] Unhides any hidden columns within the selection.
[Ctrl] + [Shift] + [&] Applies the outline border to the selected cells.
[Ctrl] + [Shift] + [-] Removes the outline border from the selected cells.
[Ctrl] + [Shift] + [~] Applies the General number format.
[Ctrl] + [Shift] + [$] Applies the Currency format with two decimal places 

(negative numbers in parentheses).
[Ctrl] + [Shift] + [%] Applies the Percentage format with no decimal places.
[Ctrl] + [Shift] + [^] Applies the Exponential number format with two 

decimal places.
[Ctrl] + [Shift] + [#] Applies the Date format with the day, month, and year.
[Ctrl] + [Shift] + [@] Applies the Time format with the hour and minute, 

and AM or PM.
[Ctrl] + [Shift] + [!] Applies the Number format with two decimal places, thousands

separator, and minus sign (-) for negative values.
[Ctrl] + [Shift] + [*] Selects the current region around the active cell (the data area

enclosed by blank rows and blank columns).
[Ctrl] + [Shift] + [:] Enters the current time.
[Ctrl] + [Shift] + [”] Copies the value from the cell above the active cell into the 

cell or the Formula Bar.
[Ctrl] + [Shift] + [+] Displays the Insert dialog box to insert blank cells.
[Ctrl] + [-] Displays the Delete dialog box to delete the selected cells.
[Ctrl] + [;] Enters the current date.
[Ctrl] + [`] Alternates between displaying cell values and displaying 

formulas in the worksheet.
[Ctrl] + [’] Copies a formula from the cell above the active cell into the 

cell or the Formula Bar.
[Ctrl] + [1] Displays the Format Cells dialog box.
[Ctrl] + [2] Applies or removes bold formatting.
[Ctrl] + [3] Applies or removes italic formatting.
[Ctrl] + [4] Applies or removes underlining.
[Ctrl] + [5] Applies or removes strikethrough.
[Ctrl] + [6] Alternates between hiding objects, displaying objects, 

and displaying placeholders for objects.
[Ctrl] + [8] Displays or hides the outline symbols.
[Ctrl] + [9] Hides the selected rows.
[Ctrl] + [0] Hides the selected columns.
[Ctrl] + [A] Selects the entire worksheet. 

If the worksheet contains data, [Ctrl] + [A selects the current
region. Pressing [Ctrl] + [A a second time selects the current
region and its summary rows. Pressing [Ctrl] + [A a third time
selects the entire worksheet.

[Ctrl] + [B] Applies or removes bold formatting.
[Ctrl] + [C] Copies the selected cells. 
[Ctrl] + [D] Uses the Fill Down command to copy the contents and format

of the topmost cell of a selected range into the cells below.
[Ctrl] + [F] Displays the Find and Replace dialog box, with the Find tab

selected. 
[Ctrl] + [G] Displays the Go To dialog box. 

F5 also displays this dialog box.
[Ctrl] + [H] Displays the Find and Replace dialog box, with the Replace tab

selected.
[Ctrl] + [I] Applies or removes italic formatting.
[Ctrl] + [K] Displays the Insert Hyperlink dialog box for new hyperlinks or

the Edit Hyperlink dialog box for selected existing hyperlinks.
[Ctrl] + [N] Creates a new, blank workbook.
[Ctrl] + [O] Displays the Open dialog box to open or find a file.
[Ctrl] + [P] Displays the Print dialog box.
[Ctrl] + [S] Saves the active file with its current file name, location, 

and file format.
[Ctrl] + [T] Displays the Create Table dialog box.
[Ctrl] + [U] Applies or removes underlining.
[Ctrl] + [W] Closes the selected workbook window.
[Ctrl] + [X] Cuts the selected cells.
[Ctrl] + [Y] Repeats the last command or action, if possible.
[Ctrl] + [Z] Uses the Undo command to reverse the last command or to

delete the last entry that you typed.
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The Geforce 9 had a really
short stay and NVIDIA

has released the GTX 280,
around the same time that
ATI launched their first card.

Zotac was the first to
send us their over-clocked
version of the GTX 280 that
they proudly call the GTX
280 AMP! These new cards
are crossing uncharted terri-
tories. The Zotac GTX 280
AMP! runs at a core speed of
700 MHz instead of the
default 602 MHz. Most num-
bers on the new card have
been doubled from what
was on the last 9800GTX.
The memory bandwidth has
been increased to 512 bit
and there is 1 GB of
memory on the card. An 8-
pin and 6-pin power con-
nector is required to power
the GTX 280 AMP!

It’s just not all about the
numbers. The GTX 280
absolutely destroys all pre-
vious records held by single
cards. To give you an idea,
the Zotac GTX 280 AMP! is

about 50 to 75 per cent faster
than the colossal 8800 Ultra
in most benchmarks. For
example, in one of our tests,
the 8800 Ultra scores around
100 fps in Prey at 1920 x 1200
with maximum detail and
4x anti-aliasing and 8x anti-
strophic filtering turned on.
The GTX 280 AMP! beat it
with a score of 173 fps. Even
Unreal Tournament 3 with all
the settings turned up gave
scores of 119 fps on the
Shangrila map at 1920 x
1200. 3DMark 2005 and 2006
scores increased as well, but
not to the extent of the real-
world gaming benchmarks. 

The card, in comparison,
runs cooler than the 8800
GTXs, more so when com-
pared to the 8800 Ultras. The
cooling solution on the Zotac
card is stock NVIDIA design.
The card is a little less com-
pact than the 9800GX2. It is
lighter, but consumes over
300 W when on load. In idle,
it drops to as little or lower
than a 9800GTX card. A

power supply
of at least 600 W is

highly recommended
to any future owners.

The Zotac GTX 280 AMP!
is a great card and we’re sure
some of the non over-clocked
versions are really good as
well. It would be terribly
wrong to say that the GTX
280 is not a good card.
There’s significant improve-
ment in performance.
There’s one major problem
right now, other than the
high power demands—the
price. The current price for

the Zotac
GTX 280 AMP! is a

whopping Rs 44,444, which
makes it way over the top in
terms of pricing. 

As things stand today,
the prices are exorbitant
and with ATI releasing
cards of their own priced at
much lower prices offering
better value for money, it’s
only a matter of time before
the prices for the GTX 280
drop. GTX 260s are expected
to hit the markets soon, so a
little caution at the
moment is recommended to
look out for some extreme
price drops.

Specifications
GeForce GTX 280 @ 700 MHz,
240 core processors, 1 GB
GDDR3, DirectX 10 support,
Unified Shader Model 4.0

Contact: ZOTAC International
(MCO) Ltd.
Phone: +91-11-46665666
E-mail: sales@zotac.com
Web site: www.zotac.com
Price: Rs 44,444

We test the latest hardware
and software products 
available in the market

Zotac GeForce GTX 280 AMP!
The New Big Daddy

BazaarBazaar

The ASUS Extreme Striker
II is the first nForce 790i

Ultra SLI-based board we
review this month. The
board is targeted at the
extreme high-end perform-
ance demanding enthusiast.

ASUS has implemented
several design changes. There
are loads of copper heat
blocks and pipes. To stop the
heat sink fins from
scratching, there are small
strips of flat metal on each
of heat sink, which also gives
them a very eye-catching
look. There’s even a glowing
Republic of Gamers logo on the
board. The main heat sink
also has a provision to attach
a water cooling kit—all the
necessary connectors and
washers are provided. 

The focus on overclockers
and enthusiasts is visible in

the CMOS. The first menu
that opens has all the over
clocking features and menus
right there. Overclockers will
love this board.  

Other than a minor
bump in the memory bench-
marks, there is no other real
improvement in the board.
Game benchmarks also
showed a 1 or 2 per cent
improvement in Doom 3.

ASUS’ energy saving EPU
is built into the board, but
there isn’t the Express Gate
features that allowed users
to use the computer and the
Internet, without booting
into an OS. SupremeFX II is
provided as an add-on
module for sound that goes
on to your motherboard. The
box comes with Company of
Heroes: Opposing Force and
Kaspersky Antivirus.

The 790i doesn’t offer
anything special today and
with DDR3 prices still not
affordable for the masses,
even the cheapest 790i
boards don’t impress large
numbers. The ASUS Extreme
Striker II doesn’t give a
bonus performance boost,
but it does give you a whole

lot of flexibility. The features
and quality of the board is
top notch, but at Rs 27,000, it
is ridiculously expensive.

Specifications
LGA 775 socket, Chipset: nForce
790i Ultra SLI, Up to 1600 MHz
FSB, Supports up to 2000 MHz
DDR3 RAM OC.

Contact: ASUS Technology
Pvt. Ltd.
Phone: 1-800-2090365
E-mail: media_india@asus.com
Web site: http://in.asus.com
Price: Rs 27,000

Features  
Performance
Build Quality
Value for Money
Overall 
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ASUS Extreme Striker II
Expensive Enthusiast DDR3 Platform

Kodak EasyShare V1073
Average Camera With HD Capabilities

With touchscreen
devices getting

cheaper and making their
way into every possible
gadget, cameras aren’t
being left out. Now, its
Kodak’s turn. The EasyShare
V1073 is an 11 MP camera
with a 3x optical zoom.

It is thin enough to fit
into a shirt pocket easily,
but that also makes it a
little difficult to hold with
a single hand. The touch-
screen also makes it diffi-
cult to use the camera with
just one hand. The power
and shoot buttons are posi-
tioned close to each other.
The 3-inch screen doesn’t
have great quality—it is
pretty difficult to use out-

doors even with the bright-
ness turned up high.

The quality of photos
isn’t too different from its
predecessors. The colours in
the photos are pretty nat-
ural but the sharpness will
likely be a little too much
for most people’s liking.
There is image stabilisation,
but images still end up a
little blurry in well-lit sce-

narios. There is very
little control given to
the user, so there isn’t

a lot you can experi-
ment with. 

One of the key
features  is the HD

720p video recording
resolution. A typical 25-

second clip is 43 MB in size.
The quality of the video
clips is pretty impressive. 

The touch screen makes
a few other features easily
accessible. For example, you
can actually type in a tag
for every single photo that
you shoot using an on-
screen keyboard. The high
definition video recording
is a feature that will
interest many. 

The price of Rs 13,999
is a fairly attractive price
for a camera with these
unique features. 

Specifications
11.11 MP 1/1.63 in CCD sensor,
3x optical zoom, 3-inch LCD
touch screen. 

Contact: Kodak India Pvt Ltd
Phone: +91-9820510322
E-mail: kgdinkar@gmail.com
Web site: www.kodak.com
Price: Rs 13,999

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

PREY—1920 x 1200
(4x AA , 8x AF)

Doom 3—1600 x
1200 (4x AA , 8x AF)

Company of
Heroes— 1920x1200 

(4x AA, 4xAF)

F.E.A.R—1600 x 1200
(4x AA, 8x AF)

Splinter Cell—1600 x
1200 (4x AA, 8x AF)
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NVIDIA’s only offerings
aren’t just the new

range of graphics cards, but
also motherboard chipsets.
The 790i chipset for Intel
processors is one of the top
models offered today, and
the Zotac nForce 790i
Supreme is based on it.

The board design and
layout is the same as the
stock layout used by
NVIDIA. There are no addi-
tional cooling enhance-
ments. There are plenty of
heat sinks and heat pipes
connecting them, but the
quality isn’t all that great.
The big difference in the
790i chipsets is that these
are DDR3-only boards.
There are four slots for up
to 8 GB of memory.

The board supports 3-way
SLI. The BIOS is clean and is
pretty standard with nothing

out of the way. There are sev-
eral over clocking features.
The HD audio solution is
based on Azalia and there is
a dual Gigabit LAN built into
the board.

In terms of performance,
it matches the P35 and X48
chipset motherboards that
we tested. Even the hard
drive marks matched other
motherboards of its class.
The drive index for our drive
showed 78 MBps but the
memory benchmark was a
tiny bit higher than the ones
on the P35 boards running
DDR2 memory. There was a
minor 5 to 6 per cent in the
memory benchmarks, but it
didn’t translate to perform-
ance in real world bench-
marks such as games.

The entire package
doesn’t come with anything
special, other than the usual

cables and back panels. A
WiFi kit is also included.

DDR3 is still very expen-
sive to consider and the price
of this board doesn’t help. At
Rs 19,899, it is an extremely
expensive proposition for a
performance rig, especially
with no clear benefits of
DDR3 visible at the moment.
Users thinking of investing a
lot in a long term 3-way SLI
rig running on DDR3
memory should go for this.

Specifications
LGA 775 socket, Chipset: nForce

790i Ultra SLI, Upto 1600MHz
FSB, Supports 3-way and Quad
SLI, 4 DIMM slots for 8GB DDR3
memory, Dual Gigabit LAN

Contact: ZOTAC
Phone: +91-9920675457
E-mail: sales@zotac.com
Web site: www.zotac.com
Price: Rs 19,899
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The E900WA is a 19-inch
widescreen LCD from

BenQ. A while back, we
tested the BenQ X2200W—a
22-inch LCD monitor,
which resembles this mon-
itor in the looks depart-
ment, at least. 

At first glimpse, the
designs are pretty identical.
The stand is standard
plastic without any special
treatment or design but it
is really flexible in
allowing you to tilt the
screen backwards and for-
wards. The screen cannot
be rotated in any other
direction, though.

The screen performs
fairly well even though
this is a TN panel. Viewing
angles are alright but there
is some visible backlight
bleeding along the edges of
the screen. There is also
some wavering interfer-
ence on the sides of the

screen in certain patterns
and the expected banding
in TN panels is there
towards the darker shades
of color is there, but is not
too noticeable.

There are speakers built
into the screen and a
3.5mm cable is used to con-
nect to it. There is also pro-
vision to connect an addi-
tional headphone. The
volume control is easily
accessible by the press of a
single button. The speakers
aren’t great, but they get
the job done for some basic
casual gaming and music.

There is an Auto
Adjustment feature which
automatically sets up the
monitor for you without
having to change the set-
tings manually. Using the
menus is simple and the
controls are placed on the
right of the monitor. The
interface itself is very

colourful and user friendly,
so pretty much anyone can
use it. There are plenty of
display modes geared
towards different kind of
viewing and each of these
can be switched to without
having to go through deep
into the menu.

There is just a VGA con-
nector available with this
screen. The biggest missing
feature in this monitor is a
DVI port which is a must
for any LCD screen today—
especially one that costs 
Rs 9,600. 

Specifications
19-inch widescreen, 1440 x
900, Contrast Ratio: 700:1,
Response time: 5ms.

Contact: Neoteric / eSys
Phone: 1-800-22-0808
E-mail: sales.enquiryin@BenQ.com
Web site: www.benq.co.in
Price: Rs 9,600

If you can find a tele-
phone line, you’ve found

an ADSL2 connection.
Country wide ISPs like
BSNL and MTNL provide
users with broadband con-
nections and every single
one has a DSL modem with
them.

The D-Link DSL-2640T is
an ADSL modem and a WiFi
router in one single solu-
tion. The router has provi-
sion for 4 wired ports and a
port for the telephone line.
This is an
802.11g
router. The
design is
the stan-
dard design
D-Link uses
for most of

its ADSL modems. Setting
up the router is incredibly
simple and the installation
CD guides you through the
setup. Unlike some of the
other D-Link models, this

one has no option to
connect the device
to the PC via USB.

The Web inter-
face is poor and has
a very amateurish
look to it. There are

plenty of features in the
interface though. There is
everything from firewalls
and port forwarding to
parental control built into it.

File transfers on a
wired network are fast. A
700 MB file takes around a
100 seconds to copy. There
are no visible latency
issues with the DSL-2640T.
One of the things you
notice is that the DSL-
2640T gets a little warm
even when idle.

At Rs. 3,200, it is
cheaper than some well
known brands, but you get
what you pay for. It is good

value for money, consid-
ering the number of

features it has. What
it doesn’t have, is an
attractive design so
you can keep it on
your table for
everyone to see. For

a user who has a multiple
PCs and a laptop, this ADSL
Wireless router makes per-
fect sense to buy. 

Specifications
Built in ADSL, 802.11g Wireless
LAN, 4 RJ-45 10/100 Mbps
ports, 
Maximum ADSL speed: ADSL2+
24 Mbps downstream and 1
Mbps upstream.
Dimensions: 142 x 109 x 31 mm,
Weight: 239.4 gms

Contact: D-Link India Ltd.
Phone: +91-22-30616666
E-mail: sales@dlink.co.in
Web site:  www.dlink.co.in
Price: Rs 3,200

Features 
Performance  
Build quality
Value for Money
Overall 
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D-Link DSL-2640T
Great Features, Good Value

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

The Transcend T.sonic 850
is an upgrade from the

T.sonic 840. The styling has a
few changes and the controls
that were on the side with
the 850 have returned to the
front of the player. Transcend
has also done away with the
840’s metal back—which we
liked because it gave it a
solid robust feel. 

An 1.8-inch
screen allows
you to watch
videos and read
text. While lis-
tening to music,
the screen is
used to display

the visualisation. The but-
tons feel good and the con-
trols are really simple to get
used to. The earplugs sup-
plied are pretty bad in
quality with a cheap feel to
them. The player is capable
of driving full fledged head-
phones as well. 

The player can be used
to view images and
movie playback as
well, but only one
format—MTV—is sup-
ported. Conversion
software is provided
for this purpose. You
can simply dump files
in to the player,
without the need of
any syncing software.
Books can be read as

well, but only TXT files are
supported. Data transfer
rates are perfect and the
player is able to skip
through songs and fast-for-
ward without any effort.
There is a protection cover
supplied with the player to
prevent any fine scratches
to the surface.

The player is available in
4 GB and 8 GB versions. We
received the white 4 GB ver-
sion, for testing and is
priced at Rs 5,500, which we
think is a little overpriced.
From a standpoint of a
T.sonic 840 user, there is
nothing in the 850 that will
convince you to move to it.
For anyone looking for a
decent-value-for-money

media player, the T.sonic
850 fits the slot perfectly.

Specifications
Capacity: 4 GB, Formats
supported: MP3, WMA, WAV,
MTV Dimensions: 81.5 x 41.5 x
12.7 mm

Contact: Mediaman Infotech Pvt ltd
Phone: +91-22-23828100 / 8200
E-mail:
sales@mediamangroup.com
Web site: www.transcendusa.com
Price: Rs 5,500

Transcend T.sonic 850
Expensive, But Still Good

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

BenQ E900WA
Value For Money

ZOTAC nForce 790i-Supreme
Costly, And Perhaps Early



People owning different
electronic appliances

such as TVs and set top boxes
know there’s an additional
burden of running around
for different remotes to con-
trol each one of them. The
Kameleon 8 URC 8303 is an
all-in-one remote to take
away all the hassles.

The device is sturdy and
built well with its alu-
minium body, but it’s also
is very large—to the point
where it’s a little difficult
to hold in your hand. The
most attractive feature
other than being able to
control the devices through
a single device is the
touchpad, with an attrac-
tive display. 

Setting up the remote
for the devices is extremely
simple and most of the but-
tons and menus automati-
cally show up on the
remote. The remote can also
be set up to learn from
other remotes. Every time
the device in use is
changed, the display also
changes the icons for them
accordingly. The remote’s
use isn’t limited to just TVs
and set top boxes—it can
even be used to control the
lighting of your room.

Other than the
touchpad buttons, there
are also hard physical but-
tons for changing channels
and adjusting volume
levels. Unfortunately, these

are really tiny and awk-
ward in a remote of this
size. The remote runs off
three AAA batteries. 

There aren’t a lot of com-
panies that sell all-in-one
remotes in India. The price of
the URC 8308 Kameleon 8 is
Rs 4,995 in the market,
which might make it seem a
bit expensive. However, it’s
worth every single penny if
you own many remote con-
trolled devices. The other
alternative for this kind of
remote are priced at much
higher rates. If you ignore
the size of the remote, then
it’s a really classy looking
product for your home.

Contact: One For All
Phone: +91-80-40351800
E-mail: ajit@uebv.com
Web site: www.oneforall.co.in
Price: Rs 4,995
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Kingston’s DataTraveler
400 is a product

focussing on the mobile
office-goer. Security is one
part of the concern and the
other being able to carry
data regularly and synchro-
nising it with their home
PC. We have the 2GB version
of the DataTraveler 400
here with us.

The design is sturdy and
the drive opens up on an
axis from its protection layer.
The DT 400 isn’t just about
looks. A thorough run
through the benchmarks
reveals it is also quite the
performer. In the sequential
file transfer tests, we were
able to write 100 MB files to
the drive in 8 seconds and
read off it in 3.6 seconds.

SiSoft Sandra recorded read
speeds of 33 MBps. Random
access times were also very
low at 0.4 seconds. Burst
speeds of 35 MBps were also
recorded in HDtach.

There are additional fea-
tures for security in the
drive. As with other manu-
facturers, there’s a utility,
which allows you to create a
secure partition. An addi-

tional utility called Migo
Sync is also bundled on the
drive. It allows you to select
folders on the computers
and sync data between mul-
tiple PCs. It isn’t just files
and folders that are syn-
chronised—it’s also data
from mail clients and
browsers. The application
itself is actually quite exten-
sive in features.

The 2 GB DataTraveler
400 is priced is priced at 
Rs 2,255. In comparison,
standard 2 GB flash drives
are available at giveaway
prices of around Rs 500. It’s
difficult to justify this kind
of price for 2 GB drives, even
though it’s a well per-
forming flash drive. 

Specifications
Capacity: 2 GB, Dimensions: 70
x 22.4 x 11.3 mm

Contact: Kingston Technology
E-mail: sales_india@kingston.com 
Web site: www.kingston.com
Price: Rs 2,255
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Build Quality
Value for Money
Overall 
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Kameleon 8 URC 8308
Mammoth All In One 

Kingston DataTraveler 400
Good Performer And Secure!

One of the things both
Intel’s 65-nm and 45-

nm parts have in common
is their over clocking poten-
tial, and as any Core 2 Duo
user will tell you, simply
buy a slower processor and
overclock it to faster speeds.
But you don’t want to be
over clocking uncontrol-
lably, as even Intel’s excel-
lent thermal thresholds are
easily crossed once the FSBs
and multipliers are
tweaked.

Thermalright is a known
vendor of high performance
CPU and GPU aftermarket
coolers. Their latest CPU
cooler—the Ultra 120
Extreme—is a massive tower-
like cooling solution fea-

turing six heat pipes. This
monster needs to be paired
with an equally space hog-
ging 120-mm fan to perform
at its best. Many users’ cabi-
nets also aren’t wide enough
to accommodate the high
Ultra 120 Extreme, so
Thermalright’s design engi-
neers came out with the
Ultima 90i. It’s much smaller
and weighs just 460 grams—
much lighter than the Ultra
120’s 790 grams. This cooler
is best used with a 92-mm
fan. It looks like a shrunk
down Ultra 120, and retains
the same six heat pipes.

To install this heat sink,
you’ll need to remove your
motherboard. This involves
the installation of a back

plate on the rear of the
motherboard. Though
tedious, this is the best
way to secure a CPU cooler.

We used this heat sink
with two processors—a
hotter, and older Core 2
Duo Extreme X6800 (2.93
GHz), and a newer Core 2
Quad Extreme QX9650 (3
GHz).

A difference of 24
degrees on an over clocked
quad core just says it all.
Even the older X6800 runs 22
degrees cooler at a clock of
3.5 GHz. Very impressive for
a cooler which weighs the
same as Intel’s stock cooler.
There are two issues we see
with users swapping out
their stock Intel coolers and
plonking this on—the
tedious installation, and the
absence of a fan with stock
package. A good 92-mm fan

from the likes of Panaflo or
NMB will set you back by a
cool Rs 600, which should be
added to the price of the
cooler. At Rs 2,500 for the
Ultima 90i, you’re looking at
around Rs 3,000 for the
entire setup. Good for over-
clockers, others give it a skip.

Specifications
Six heat pipe-based cooling
solution, weight—460 gm,
dimensions—115 x 55 x 139 mm 

Contact: Tirupati Enterprises
Phone: 9339207519
E-mail: mail@tirupati.net
Website: www.thermalright.com
Price: Rs 2,900

Thermalright Ultima 90i
Intel On Ice

Intel has recently
unleashed out many new

chipsets into the market and
the X48 is one of the latest.
MSI has released a board
based on this chipset—the
MSI X48C Platinum. The
board supports ATI’s
CrossfireX through two PCI-E
2.0 x16 slots.

The design is spruced up
with copper fins and heat
sinks. The feature that
makes the X48C special is
that the board supports
both DDR 2 and
DDR 3

RAM. There are two slots for
DDR2 and four for DDR3,
which allow for a maximum
of 4 and 8 GB of RAM
respectively. Both the RAM
modules will not operate
together and a separate
memory turbo cards are
provided to place in the
unused slots. 

The layout is clean
overall, but there are no clips
to lock cards in place. The
SATA ports are placed out

the way of the PCI-E slots.
Realtek’s ALC 888 is used as
the audio solution for the
motherboard, and it also has
Realtek’s 8111B Gigabit net-
working solution. At the rear
end, there is no shortage of
connectivity options. There
are eight USB ports and also
two PS2 ports for the key-
board and mouse, which had
become a rarity on some of
the newer boards.

The board performed
flawlessly in the tests. Once
again, there is little perform-
ance improvement over the
other chipsets and manufac-
turers. It lags a little behind

than the nForce 790i moth-
erboards in some of the

synthetic memory
benchmarks.

The X48 is
yet another

upgrade from the previous
X38 platform and brings
nothing special to the table
other than a few minor
upgrades. At Rs 15,500, it
isn’t mainstream material
either. It will, however,
interest users who want to
go to DDR3 when they get
cheaper—but as of now,
they’re happy with DDR2. 

Specifications
LGA775, Supports FSB up to
1600MHz, ICH9R Southbridge,
Supports up to DDR3 1600 and
DDR2 800, ATI CrossFire
supported.

Contact: MSI
Phone: +91-11-41758808 / 09
E-mail: marketing@msi-india.com 
Web site: www.msi-india.com
Price: Rs 15,500
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Overall 
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MSI X48C Platinum
DDR2 And DDR3!
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Overall 

RATINGSScores
Processor Core Speed Temperature Temperature

(Stock Cooling) (Ultima 90i)
Core 2 Duo X6800 2.93 GHz 61 deg 47 deg
Core 2 Duo X6800 3.5 GHz 71 deg 49 deg
Core 2 Quad QX9650 3.00 GHz 66 deg 48 deg
Core 2 Quad QX9650 3.81 GHz 75 deg 51 deg



Those who don’t own a
desktop today opt for a

basic notebook that they can
carry around instead.
Performance isn’t the neces-
sity for most of them, but
features are and this market
has been growing steadily.
The Chirag CD 18 is a laptop
targeted towards this kind of
consumer market. 

The CD 18 comes with a
12.1-inch screen that has a
resolution of 1280x800.
The screen quality is
average but viewing angles
are pretty poor. Being an
entry level laptop, there
isn’t a lot of firepower but
a 1.86-GHz Core Duo T2350
processor is much more
than enough for tasks. 
The graphics are powered
by the onboard ATI Xpress
200 solution. 

The design is compact
but the laptop is very thick.
The right top region of the

laptop gets warm pretty
quickly. The keys feel cheap
and so does the body mate-
rial itself. It feels like a
rather old outdated system.

The performance is as
expected. Far Cry at 640 x
480 with low quality gave
average frame rates of
around 26 fps. 3D Mark 2005
results matched some of
the other laptops of its
class, because of the
respectable graphics solu-
tion on the laptop. 

There are few missing
things—there is no inbuilt
Bluetooth, nor is there a
webcam. To make up for
that, there is an external
Bluetooth dongle provided
and a USB drive as well. All
the other regular features
are present.

An additional 512 MB of
RAM would give it some
more performance to com-
pare well with the other lap-

tops of its class, and it would
have enabled users to be able
to run Vista on it as well.

The CD18 is a 12.1-inch
screen which makes it a
fairly compact laptop in that
aspect. It still has a bad
design and feel, and seems a
little costlier than what it
should have been.

Specifications
Intel Core Duo T2350 1.86 GHz,
512 MB DDR2 RAM, 12.1-inch
screen, 1280 x 800 resolution

Contact: Chirag
Phone: 033-22134934
E-mail: info@rpchirag.com
Web site: www.rpchirag.com
Price: Rs 34,499
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Corsair is a respected
name when it comes to

memory and USB drives, but
power supplies? The HX620
ships in a strong, colourful
carton and the PSU is
encased in soft foam and
well-protected from damage.
A quality pouch has been
provided, which houses all
the modular cables and an
embossed 3D sticker
labelled powered by Corsair.

The unit itself has a
matte black finish that looks
rugged, no smudges here,
and even screws don’t leave
marks on this finish, so dura-
bility is not as issue. The unit
is heavy, and through the
honeycomb grille at the rear

part a PFC unit is visible. The
HX620 makes do with a
single 120-mm fan installed
in a pull configuration
meaning this fan should be
facing your motherboard
when the PSU is installed.
The modular cables are long
enough to reach all mother-
board connectors, and this
PSU supports 4x6 pin PCIe
connectors, so even cards
which require two 6-pin con-
nectors can be SLIed. Each
modular SATA connector
cable has 4 ports, so a max-
imum of 8 SATA hard drives
are supported. There is sup-
port for up to 6 PATA devices
too. The HX620 is 80 plus
rated, meaning it delivers an

efficiency of at least 80 per-
cent under all conditions.

We tried to load up the
HX620 with as many
devices as we could. A Core
2 Quad QX9650 (3.0 GHz),
ASUS 780i motherboard, 4
GB of DDR2 1066 MHz
memory, 2x NVIDIA
GeForce 8800GTX graphics
cards, two 150 GB WD
Raptor HDDs and a Sony
Blu-Ray writer. This config-
uration was then bench-
marked for a solid three
hours during which we had
no crashes and no restarts
whatsoever. It seems the
Corsair can really deliver
its rated wattage and for
sustained periods of time,
and this configuration will
simply blow most run-out-
of-the-mill power supplies
right out of the water. And
all the while the HX620 ran

cool (measured 42 degrees)
and quiet.

Unless you’re looking at
quad SLI or 4-way Crossfire
or 2x GeForce 9800GX2 /
Radeon HD3870 x2, or two of
the newer GeForce GTX 280’s
you will never need anything
more. For a single graphics
card this is more PSU than
you’ll probably need and its
smaller (by 100 watts) sibling
the HX520 will do the trick.

At Rs 6,500, Corsair has
delivered an excellent
power supply for those who
need medium to high quan-
tities of juice out of their
power supplies. If you plan
on building a powerful rig
this is a really good PSU to
invest in and worth every
bit of its price.

Specifications
620 watts, modular, supports
4x PCI Express connectors, 8x
SATA connectors, 6x PATA
connectors, 80 plus certified,
NVIDIA SLI certified.

Contact: Tirupati Enterprises
Phone: 9339207519
E-mail: mail@tirupati.net
Website: www.corsair.com
Price: Rs 6,900

The Motorola MotoYUVA
W230 is one of the more

basic GSM phones available
on the market today. Not
everyone uses their phone to
write long e-mails and play
games on them. 

The design of the phone
is plain and all the keys have
a heavy, but plastic feel to
them. The phone is thin and
lightweight. The screen is too
small to be of use for any-

thing beyond making phone
calls. The keys give decent
feedback too.

Coming to performance,
the interface itself is zippy.
There is no waiting for
menus and pages to load.
The quality of voice is also
good, without any unneces-
sary enhancements. The
signal strength is good, but
while speaking, there is
some instability and jitter.

The phone comes with a
set of earplugs that connect
to the phone using a 2.5-
mm jack. The quality and
clarity of the music played
from the phone is good, but
lacks bass. FM radio func-
tion is built in and it works

pretty well. The speaker-
phone is not very loud, but
it sounds nice too. Because
of these characteristics, it
makes a good music phone.
The only problem is that
the external memory card
supplied with the phone is
just 256 MB. The internal
memory onboard the phone
is a paltry 1 MB.

As an entry level phone,
the Motorola MotoYUVA

W230 makes good sense for
its performance, but the
styling could be a lot better.
For someone who needs a
phone purely to make calls,
the MotoYUVA W230 is per-
fect. The price of Rs 3,135
for a phone like this is
good, but there are a lot
other choices for the users.
Users might want to look
what kind of style suits
them best.

Specifications
Screen: 1.6 inch, Resolution 128
x 128, 65K colours, USB 1.1
connectivity, Up to 2GB MicroSD
supported, Dimensions: 45 x
110.97 x 14.7 mm

Contact: Motorola
Website: www.motorola.com
Price: Rs 3,135

Chirag CD 18
Cheap But Lacking Power

Corsair HX620
Highly Efficient powerhouse

System utilities have found
a market, just like

antivirus and backup solu-
tions. EASEUS Partition
Manager Server is one such
application. It is a disk parti-
tioning utility and the Server
edition is meant for the
enterprise market. 

Installation is simple,
and the software detects all
the partitions on the drive
properly. It supports all kinds
of drives, including USB and
Firewire. The core function

of the program is to parti-
tion the hard drive, and it
does that well. Partitions can
be resized and this is espe-
cially useful when you are
trying to install a Linux dis-
tribution for example. 

Partitions can also be
hidden and there are fea-
tures for scanning the disk
or partition for any errors.
An ISO image is provided for
those who want to use the
application through a
bootable floppy or CD.

FreeDOS loads and
the application
loads through it.
This is useful
when you lose a
partition and
require recreating
or resizing them.

EASEUS Partition
Manager Server does look a
lot like Norton’s Partition
Magic. Security is checked by
a password that can be set
once the application is instal-
lation. All future running of
the software requires the
user to enter a password. 

Help for the software is
provided through a PDF doc-
ument and also a Windows
help file. All the features are
explained in detail with a
few scattered screenshots. 

Norton’s Partition Magic
and Paragon Partition
Manager are some of the
more well known parti-
tioning tools and EASEUS
Partition Manager is direct
competition to them. The
EASEUS Partition Manager
Server comes with a price
tag of $99.95 (Rs 4,250) and
the big different is support
for more operating systems.

As just a partitioning tool,
most users do not need one
and need for one would
only be larger companies
with multiple computers.
For home users, there are a
few products on the
Internet which can do the
same job for free.

Requirements 
500 MHz processor, 256 MB
RAM, Windows 2000 SP4,
Windows XP, Windows 2003,
Windows Vista.

Contact: EASEUS
E-mail: sales@easeus.com
Web site: www.easeus.com
Price: $99.95 (Rs 4,250)

EASEUS Partition Manager Server
Basic Partitioning Utility

Features
Performance 
Build Quality
Value for Money
Overall 

RATINGS

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Features 
Performance  
Ease of use
Value for Money
Overall 

RATINGS

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

Motorola MotoYUVA W230
For Someone Who Just Wants To Talk
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2.1 Speaker Sets
Altec Lansing MX5021

Excellent performance
Some minor vibrations in woofer

Contact Rashi Peripherals Pvt.Ltd
Phone +91-22-67090909
E-mail altec@rptechindia.com
Price Rs 7,600

5.1 Speaker Sets
Logitech Z-5500 Digital

Explosive power
Too expensive

Contact Logitech
Phone +91-22-26571160
E-mail kavita_nath@logitech.com
Price Rs 27,995

Projectors
NEC VT800

Excellent performer
Slightly pricey

Contact NEC India Pvt. Ltd.
Phone +91-11-4657 0000
E-mail enquiries@necindia.in 
Price Rs 92,000

MP3 Player above Rs
10,000
Cowon D2

Very good performance
Slightly bulky 

Contact Lipap Systems P. Ltd
Phone +91-9819917440
E-mail iaudio@lipap.com
Price Rs 11,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance

Contact Canon India Pvt Ltd
Phone 1-800-345-3366
E-mail info@canon.co.in
Price Rs 13,995

MP3 Players up to Rs 5,000
Apacer Steno A4351

Good performence
Tacky build, Screen quality

Contact Apacer Technology
Phone +91-80-25702208
E-mail suraj_raina@apacer.com
Price Rs 1,720

MP3 Players up to Rs 10,000
Samsung T10

Good music quality, nice
screen
Tacky exterior

Contact Samsung India Ltd
Phone +91-11-41511234
E-mail jitendra.c@samsung.com
Price Rs 6,600

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India Electronics
Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

Internal Hard Drives
Seagate 7200.11 750GB
ST3750330AS

Class leading performance
None as such

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 8,900

Digital Tools l A-List

Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up

Contact Technology and Gadgets
Phone +91-22-23823331
Web site technologyandgadgets 

.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular

Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers Pvt Ltd
Phone +91-11-26214751
Web site www.championindia.com
Price Rs 6,500

Internal Hard Drives
Seagate 7200.11 500GB
ST3500320AS

Value for money, performance
None in particular

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 4,900

Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Great all round performance
Slightly bulky

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Below Rs 20,000
Sony-Ericsson W910i 

Great sound
Flat and clumsy keypad

Contact Sony Ericsson Mobile 
Comm. India Pvt Ltd

Web site www.sonyericsson.com
Price Rs 19,000

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

WiFi Routers
D-link DIR-655

Excellent signal coverage
Expensive

Contact D-Link India Ltd. 
Phone +91-22-3061 6666
E-mail sales@dlink.co.in 
Price Rs 13,500

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800-222-422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India) Pvt
Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Laptops
Dell XPS 1530

Well built, powerful
Heavy

Contact Dell India
Phone +1-800-4254026 
E-mail Online_India@dell.com
Price Rs 49,900

The best products tested so far in different 
hardware and software categoriesThe A-List
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Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt. Ltd.
Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

DVD/DivX Players

Samsung DVD-1080P7
Great looks and perform-

ance
No 5.1 channel RCA

Contact Samsung India Electronics
Pvt. Ltd.

Phone +91-11-41511234
E-mail shailja.m@ samsung.com 
Price Rs 2,990

DIGIT JULY 2008

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive

Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

LCD Monitor
LG 246Wp

Great performance and Build
Bulky, Slightly expensive

Contact LG Electronics India Pvt. Ltd.
Phone +91-120-2560900 / 940
E-mail sanjoyb@lgindia.com
Price Rs 28,000
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Bhaskar Sarma

How does e-mail really work? What pathways are
followed, which protocols are used and how it gets
delivered to joe@domain.com and not to

jon@domain.com is not really understood, despite millions e-
mailing everyday. 

Local Deliveries
Let’s assume that your e-mail address is
name@domain.com and you are using an e-mail
client like Outlook or Thunderbird to send and
receive e-mails. This is known as Mail User
Agent (MUA). For sending mails, the MUA uses
Simple Mail Transfer Protocol (SMTP) to a Mail
Transfer Agent (MTA) like Gmail. In some cases,
if the user is directly using the Web mail inter-
face, the MUA does not come in the picture. 

If the address in the “to” field has the same
domain, then the MTA does a search in the local
mailboxes (each user has their own mailbox,
much like in the real world) and then delivers
the mail. The receiver’s Mail Delivery Agent
(MDA) (Outlook or a server) retrieves this mail
either using the Post Office Protocol (POP3) or
Internet Message Access Protocol (IMAP4). If POP3 is used, the
message is copied to the local e-mail client and a copy is or
isn’t retained on the server depending on the client settings.
On the other hand, if IMAP4 is used, then a copy of the
message is always retained on the server. However, this
system works only for small networks. In case the domains
are different, or the sender and the receiver are both using e-
mail services like Gmail or Hotmail, an entirely different and
complicated process takes place. 

DNS And MX
In this case the MUA or Web mail connects to the local
MTA, which is operated by the ISP. SMTP is used in this
connection through port number 25. In case of heavy load,
an e-mail queue is formed, while the MTA processes each
e-mail. Rarely does the e-mail go directly to the receiver’s
inbox when it has entered the cloud (Internet). Instead, it
is accordingly routed, depending upon the availability or
non-availability of MTAs. MTAs use the data in the headers
of the e-mail to ask the Domain Name Servers (DNS) for the
route. Typically, a single message would be routed across
multiple MTAs before it’s delivered. Since IP addresses are
the only thing that computers understand, the MTA typi-
cally looks at the domain name (the part after @) in the

DNS to find the Mail Exchange (MX) record for that
domain. Before this, domain name resolution has to be
done, starting with the top level domains like .org, .edu,
.net, .gov (there are 13 of them). 

Consider that the e-mail address of the recipient is
x@otherdomain.com. The MX record that is obtained from the
DNS is actually a prioritised list of servers for otherdo-
main.com. The mail is progressively channelled through the
different MX servers in a decreasing order of priority, until

the designated host for the domain is found. MX
servers are actually another name for MTAs that
receive email. The last MTA then transfers the
mail to the host and it is retrieved by the recipi-
ent using their MDA, or accessed through Web
mail using either POP3 or IMAP4 protocols. 

Spam, Relays, Firewalls
Spam is unsolicited e-mail which is recognised
as the biggest disadvantage of e-mail. To
prevent spam from clogging up inboxes, spam
filters are used. Then there are firewalls and
anti-virus filters that the e-mail must pass
through. The anti-virus program resides at the
firewall and checks all incoming mail and
attachments for malicious code. If spyware or

malware is found, then the message is quarantined. 

Format And Security
The format of e-mail messages is called MIME (Multipurpose
Internet Mail Extensions). Before MIME, only plain Roman
text could be sent. MIME specified how other types of infor-
mation are to be formatted so that they can be sent along
with e-mails. The mapping between MIME and other formats
are automatically done by MDAs and mail servers.

E-mail is usually sent over open channels, which made it
open to interception. Nowadays, mechanisms like digital
signature and PGP (Pretty Good Privacy) are used so that e-
mail is reasonably secure. However, the way e-mail is deliv-
ered and stored leaves it open to privacy issues.

Pushmail
Pushmail is the type of e-mail found on handhelds and
smart phones. In this type, the Internet connection is always
“on” and the e-mail is immediately delivered to the device,
the instant it arrives on the server. In many cases only the
header may be retrieved to the handheld so that bandwidth
is not wasted. IMAP4 supports pushmail, while Blackberry
uses its proprietary push mail protocol in its devices. 

bhaskar.sarma@thinkdigit.com

What do MUA, MX and POP3 mean? How is your e-mail delivered? More on these...

Email Architecture
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cinematic HD movie and gaming 
experience at the same colossal 
screen size. A very good screen 
would set you back by another 
Rs 20,000. Now, blowing just over 
Rs 1 lakh may seem expensive 
right? It is—but not when you 
consider what you’re getting 
in return. Consider that a good 
42-inch LCD TV (one third the 
screen size) costs around Rs 1 
lakh as well. A 55-inch plasma 
panel would cost well over a lakh. 
Anyone who has ever watched 
movies, presentations, or even 
played games on such a large 
screen area will tell you the bigger 
the better. So get rid of the notion 
that projectors are expensive. 

Rs 50,000 To 
Rs 1 Lakh
A Cinematic Experience

NEC VT595
The smaller brother of the VT700 
and a good looking projector 
sporting a curved body design 
and a glossy white finish that 
combine to get it looking as 
slick as it is classy. The remote 
control isn’t as smart looking, 
but the keys impart good feed-
back. The VT595 has somewhat 
decent connectivity options with 
VGA, DVI, S-Video and Composite 
connectivity on the video front. 
USB and RJ45 connects have also 
been provided. It’s obvious the 
VT595 is aimed at the household 
audience looking for a projec-
tor that’s both feature-rich and 
performs decently. A price tag of 
Rs 54,000 isn’t too steep for its 
audience either.

DisplayMate spoke volumes 
about its lacking contrast ratio. 
In the colour tests, we found 
no serious issues—but felt there 
was scope for improvement in 
the colour rendition and quality. 
Also, the clarity of this projector 
wasn’t really as impressive as 
we’d initially expected.

It didn’t do a lot in the text 
tests also, so its use in presen-
tations should be very limited. 
In the movie tests however, we 
experienced a small turnaround. 
Game quality was also pretty 
good, but not what we’d clas-

sify as very good, so gam-
ers looking for a projector 
should look elsewhere.

For its price, the NEC 
VT595 offers a good feature 
set, it’s easy to use, and 
most of all performs above 
what is acceptable for a 
device of its price. If you’re 
serious about movies and / 
or gaming, then you need 
to look elsewhere.

NEC VT800
The bigger brother to 
both, the VT595 and the 
VT700, the VT800 is both 
bigger and better look-
ing than both its smaller 
siblings. It’s got an even 
higher quality piano-
white finish and the body 
shape is attractively ver-
satile—equally suitable for 
living room and board 
room alike. It’s rich in 
connectivity options with 
an HDMI port to go with 
the VGA, Composite, and S-Video 
connects. RJ45 and USB connects 
are also available. With such 
connectivity options, this pro-
jector will suit both corporate 
and home users. The settings are 
very transparent and the menu 
layout excellent. It’s even got set-
tings for adjusting the aspect 
ratio and the options are boun-
tiful. Choose between 4:3, 5:4, 
16:9, 16:10, a wide enough array 
of aspect ratios for almost every 
usage pattern.

Calibrating this projector was 
a snap courtesy the excellently 
laid out menu. It performed well 
in DisplayMate with very good 
contrast and colour. Text qual-
ity is sharp and precise. The dis-
play on-screen is very sharp. Our 
movie tests were a lot of fun 
and we actually ran some of our 
favourite clips a number of times 
—amazing contrast, very sharp 
and accurate colours, and great 
brightness levels.

The only thing even better 
than watching movies on the 
VT800 was playing games on it. 
And this we all did, for at least 
half an hour per person!–after 
which we had to get on with 

the test. Crysis comes to life with 
some amazing brightness, clarity, 
contrast and detailing. The price, 
not withstanding, if you need a 
projector for gaming, buy this 
one—you won’t regret a whit.

At Rs 92,000, it’s a little expen-
sive, but it’s a brilliant multi-
media projector that excels at 
text and presentations. Although 
corporates may not need such 
extensive performance across the 
board and they certainly won’t 
like the price, this projector is a 
must have for serious movie and 
game junkies, and is a superb 
all-rounder.

NEC VT700
The smaller compatriot of the 
VT800 is a smaller clone to it in 
the looks department. It gives up 
an HDMI port for the more com-
mon DVI connect. Remember that 
HDMI is nothing but a newer stan-
dard for DVI video plus an audio 
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devices that are better able to 
withstood the onslaught of large 
screen flat panels. 

That being said projectors 
don’t really compete with flat 
panels across the board. There 
are certain circumstances where 
a projector will be more benefi-
cial and vice versa.

A projector scores big when 
it comes to size of the image 
displayed, and if you need a huge 
display for presentations, mov-
ies, or any content that you wish 
to be viewed by a roomful of peo-
ple, then congratulations–you’re 
barking up the right tree. With 
an image size that can exceed 120 
inches from a distance of around 
20 feet we’re not joking about the 
size part. Consider that most pro-
jectors in the range of Rs 60,000 
can easily manage an image of 
this size and with acceptable 
clarity, and a projector in the 
price range of Rs 90,000 would 
give you an even better and more 
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Michael Browne

The last time we reviewed 
projectors was in March last 
year. A lot has changed over 

the past 15 months or so. For one, 
LCD and Plasma TVs, which are 
the projectors main competition 
have gotten bigger, and cheaper. 
Projectors have also evolved, albeit 
at a slower rate. The whole move 
by nearly all projector manufactur-
ers towards a more jack-of-all-trades 
approach—when it comes to per-
formance—is a recently surfacing 
trend. We assume this is done to 
ensure easier market acceptance 
of their products—an important 
criteria for a product like a pro-
jector whose sales can hardly be 
compared to hot cakes.

Courtesy this all-rounder 
approach, nearly all our test can-
didates were able to do better in 
a wide variety of tests instead 
of just excelling in a couple of 
tests. Although certain audienc-
es may complain, we feel more 
users may be attracted to these 

Projectors are more 
affordable than ever 
before and offer 
unmatchable value per 
inch of display size. 
Select one from the 
bunch we’ve tested...

Digital Tools l Projectors Test

NEC VT800

NEC VT595

Shrikrishna Patkar, Jiten Gandhi
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stream, so there’s nothing much 
that’s different here, although 
movie junkies would give HDMI 
a nod over DVI anyday.

It doesn’t possess as good 
a contrast ratio as the VT800, 
although the colour and geom-
etry was as good as its larger sib-
ling. Text clarity is good, and so 
is the performance in presenta-
tions and animations, although 
it trails its sibling by a hairs-
breadth. The same phenomenon 
occurs in the movie and gaming 
tests where the VT800 is slightly 
better. This is enough for us to 
recommend the VT800 over the 
VT700, especially, when you con-
sider that the VT700 is actually 
Rs 3,000 costlier in India, that is, 
Rs 95,000. For all your needs, the 
VT800 is a much better choice as 
it’s cheaper and performs bet-
ter. However, the VT700 is an 
excellent projector in its own 

right, but its pricing needs some 
adjustment.
 
Sony VPL-EX5
Sony’s design department has 
come up with a winner as far as 
looks go. The VPL-EX5 is a beauti-
ful looking projector finished in 
glossy white. The top body curves 
down the sides and this tapered 
shape looks refreshingly different. 
The remote control is small, and 
very slim. Aesthetics aside the but-
tons are the hard-to-press variety, 
and they’re very tiny—all large-
handed blokes beware! The zoom 
and focus adjustments are on 
the left side of the body and you 
might miss them (we did initially!) 
unless you look hard. Sony’s menu 
is well laid out, and everything 
is easily accessible, although the 
options aren’t as bountiful as the 
NEC projectors, where you can 
tinker around more.

This projector is no slouch 
when performance is the crite-
ria. DisplayMate threw up some 
good results, very good contrast 
and colour, but we noted that 
the reds and greens seem a little 
too vivid—almost as if these hues 
are being heightened. This is also 
typical to Sony digital cameras 
(pardon the correlation) and we 
feel that Sony prefers rich, vibrant 
colours over tonal balance. Photos 
looked splendid when viewed on 
this projector—very good colour, 
and the detail was amazing. 
Not surprisingly, this is good for 
watching movies with great detail 
and crispness. It’s a great projec-
tor to game on as well. Crysis and 
F.E.A.R both looked amazing, and 
the HDR effects in Crysis in par-
ticular were beautiful.

Although behind the excel-
lent NEC VT800 in performance, 
this projector costs a whopping 

Rs 37,010 less! When you’re 
looking at 95 per cent the 
performance at 60 per cent 
the price, you just know 
you’ve found something spe-
cial, and such excellent bang 
for buck is as rare an occur-
rence as spotting a dodo. A 
must buy! We know an amaz-
ing deal when we see one!

Sony VPL-EX50
Designed to look identical to 
the VPL-EX5, the VPL-EX50 
adds an extra zero as a suffix 
to its sibling’s name and a 
slightly brighter bulb (2,500 
lumens opposed to 2,000 
lumens). Once again, build 
quality is excellent, and the 
merits and demerits of the 
VPL-EX50 are also present.

In terms of performance, the 
VPL-EX50 is a solid extension 
on its already excellent sibling. 
Whatever the VPL-EX5 does, this 
bad boy does a little better. Once 
again the issue with over-saturat-
ed, over-rich colours arises, but 
this can be toned down with a lit-
tle calibration. Contrast is excel-
lent and the VPL EX-50 performs 
very well, be it text, presenta-
tion or DisplayMate. Likewise, 
the movie performance was 
stellar, and while the difference 
between the two siblings isn’t 
much, you’ll notice it. In games, 
we were greeted with the kind 
of clarity that does justice to fast 
and expensive SLI or Crossfire 
multi-GPU systems.

For Rs 79,990, the VPL-EX50 
isn’t expensive for what it offers, 
unless you consider its cheaper 
sibling. If you want the best, 
then ditch this in favour of the 
NEC VT800, but you’ll have to 
spend more. If you are OK with 
the performance of the VPL 
EX50, but want to spend less, 
then you should look at the Sony 
VPL EX5. Remember that the law 
of diminishing returns is firmly 
in place here—the extra five per 
cent of performance between 
the two siblings costs a whole 
lot more.

Sony VPL-CX21
The VPL-CX21 is a very compact 
projector with a fully metallic 
body. It’s built extremely well 
unfortunately we received this 
projector without any remote 
control unit, and minus all the 
cables. Such exclusions are shock-
ing from Sony. Nonetheless, con-
nectivity options are pretty limit-
ed with only D-Sub and Composite 
as your options. A mini-USB con-
nect acts as an audio / video 
connect and this is hidden away 
under a latch, in a small recess, 
which opens to reveal the menu 
buttons and a 4-way joystick. 
Using the menu is a pain, 
because all the controls are 
on the side of the projector 
and not very accessible. With 
your VGA cable plugged in, 
it’s also difficult to reach the 
menu buttons.

In DisplayMate, we ran 
into some minor issues with 
contrast. Also noticeable were 
some issues with changes in hue 
in the White Shift and Black Shift 
tests, this shows a phase issue. 
There were issues with grey ren-
dition, which we weren’t able to 
fix with calibration.

In the text tests, we weren’t 
convinced with quality, sharp-
ness or clarity of alphabets and 

there seemed to be some hazi-
ness around the edges of fonts. 
The movie tests were kinder to 
this projector, and we couldn’t 
find a lot to complain about, 
although, it’s not as good as 
some of the other projectors in 
this test. Games were a mixed 
bag. While we couldn’t find 
anything to complain about, we 
also couldn’t find a lot to praise. 
Crysis was clear and with good 
lighting and colour, but it lacked 
a little extra sparkle that some of 
the other projectors were able to 
display, and clarity was also an 
issue. At Rs 99,990, the VPL-CX21 
is pricey.

Up To Rs 50,000
For Modest Movie Buffs

BenQ MP612c
The MP612c is a navy blue (alter-
nating between matte and gloss) 
finished projector that is more 
planes and angles, than curves. 
Yet the design has something of 
a futuristic look that most of us 

found pleasing, if not desirable 
or even appeasing. The remote 
unit is very small, compact, yet 
usable. One of the complaints we 
have with the connectivity is the 
inclusion of a single 3.5-mm jack 
to serve as an input, although 
considering that most users will 
have discrete speakers, but maybe 
we shouldn’t complain. Note that 
all the NEC projectors have mul-
tiple 3.5-mm audio inputs, usu-
ally one for each video connect. 
DVI connectivity has been missed 
out on, as is the Component con-
nect, a de facto for high-end video 
devices. A mini-USB connect has 

Sony VPL-CX21
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also been provided, and the de 
facto RS232 interface to connect 
to a PC is also present.

In DisplayMate, we noticed a 
slight deficit in contrast where 
this projector lost out on about 
six cards in the gray scale inten-
sity check, where the objective 
is for the projector to display 
as many gray cards (that range 
in intensities from less to very 
intense) as possible on a pitch 
black background. This test is a 
very good indication of contrast 
ratio, and we’ve learnt to respect 
the results it throw up, as they’re 
very indicative of performance 
in movies and games. Geometry 
was OK, with some aberrations 
visible in the left corners, which 
couldn’t be removed by calibra-
tion. The colours are good, but 
seem a little dim or muted, and 
once we calibrate the projec-
tor using DisplayMate, we don’t 
interfere with settings, so this 
continues throughout the other 
tests as well. Movie and game 
tests showed more loss of clarity 
and colours, which was evident 
in Crysis and a lack of contrast 
visible in the darker, atmospher-
ic scenes in F.E.A.R. The rather 
soft colours, like watching tele-
vision with your TV set to soft 
picture mode also detracted from 
the experience.

At a price of Rs 40,000, the 
MP612c is nice and cheap, and 
makes an attractive buy. We sug-
gest you stave off the temptation, 
and take a look at its slighter 
costlier sibling featured next.

BenQ MP620c
The bigger brother of the MP612c 
is a slightly better looking pro-
jector. They share a remote unit 
in common and their menus are 
not too bad. The build quality, 
and the navy blue finish is 
as good as its small-
er sibling. The part 
matte part glossy 
finish is quite well 
done and adds 
character to the 
product.

In the DisplayMate 
tests, we found a result 
similar to the MP612c—a 

deficit in contrast, which caused 
it lose out on quite a few grey 
cards—eight of them in all were 
indiscernible from the black back-
ground. The colour tests proved 
that BenQ does indeed have softer 
colours, but the word dim seems 
more apt. We hope BenQ addresses 
this issue, as it’s not really resolv-
able through calibration and real-
ly detracts from any colour related 
activities like movie watching and 
gaming. In the text tests, once 
again some of the text appeared 
to be a little blurry and the edges 
of the fonts were once again (sigh!) 
not clearly defined. The MP620c a 
slightly better projector than its 
sibling at gaming and Crysis was 
enjoyable, but not as immersive as 
hardcore gamers would like.

Aimed at the household who 
wants to upgrade from a large 
screen TV to a real home cin-
ema experience—the MP620c 
is decent value at Rs 44,000. 
However, there are better per-

forming options avail-
able for nearly the 

same price 
point.

Epson EMP-S5
Epson’s EMP-S5 is an attrac-
tive looking projector finished 
in (now familiar) glossy white. 
The front tapers forward, so the 
device looks rather soft nosed, 
and the lens is accessible via 
a slider-type flap mechanism, 
which when closed, mutes the 
video and audio signal, in addi-
tion to protecting the lens. Epson 
bundles a small, compact remote 
unit with this projector with tiny 
buttons that are surprisingly 
easy-to-use. On the connectivity 
front, DVI and Component con-
nects are missing, although USB 
connectivity is there. The EMP-S5 
wireless connectivity, which isn’t 
really significant, as this projec-
tor is obviously aimed at home 
audiences.

In DisplayMate, this projec-
tor had minor issues with con-
trast and also with geometry in 
the bar resolution tests. In the 
gray-scale intensity and contrast 
test, we missed out on eight gray 
cards, which is a little below our 
expectations. It performs ade-
quately in the text, animation 
and photograph tests, no serious 
complaints here.

We had some great hopes 
in the movie tests after our last 
impressions with still images. 
How wrong we were! The let 
down is the combination of 
contrast, brightness and even 
lack of detail, which leaves a 

somewhat grainy impression 
noticeable in movies, not some-
thing you want when you’re 
shelling out nearly half a lakh 
for an entertainment system. 
This graininess also spoils the 
game test results, and F.E.A.R 
isn’t as fearful as we like it to be. 
Crysis is slightly better mainly 
because its not as dark a game. 
At Rs 40,100 the Epson EMP-
S5 has a better price to perfor-
mance ratio than either BenQ 
projectors, and can be recom-
mended over both of them.

NEC NP200G
This was NEC’s only DLP offering 
in our test. The remote control is 
small, slim and fits into a recess 
on the top of the body. Despite its 
tiny size, the remote works beau-
tifully and the buttons are soft-
touch—flawless design here. The 
finish is an off-white satin, which 
looks smart and feels durable. 
Connectivity options are restrict-
ed to D-Sub, Composite and S-
Video, no USB or RJ45 goodness 
here. This is a projector obviously 
intended for home users primar-
ily, and the small footprint will 
be an advantage to this audience. 
Another factor which is useful for 
its intended audience, especially 
those with cramped dwellings, is 
the nature of its lamp—very short 
throw. This makes it immensely 
useful if you have very little space 

between your projector and your 
screen and still want to project a 
relatively larger image than what 
would be possible using a regular 
lamp.

The NP200G did decent-
ly well in DisplayMate, with 
good performance in the con-
trast and colour tests. It also 
does very well at text and 
presentations, although 
the slight softness accom-
panied by loss of detail 
upon zooming in on pho-
tographs is undesirable, 
and adversely affected 
its score in our 
image quality 
test. It’s a good 
movie projec-
tor, and suitable 
for HD movie 
watching, thanks 
to spot-on contrast 
and colours, and good 
brightness levels. The gam-
ing tests were a little harsher 
on this projector and we felt 
both Crysis and F.E.A.R could 
look much better. Basically, the 
colours didn’t seem as vivid 
as we’d like, and more impor-
tantly, the games didn’t seem 
as detailed—some textures 
looked slightly dull and lifeless. 
Casual gamers would probably 
be pleased with the results, but 
to choose this projector solely 
for its gaming performance if 

you’re a hardcore gamer would 
be a folly.

At Rs 48,000, the NEC NP200G 
is a very good projector for its 
price. Although its siblings, 
the VT800 and VT700 trounce 
it soundly, they also command 
double the price. Hardly any 
similarly priced projectors come 
close to its performance and this 
makes the NP200G somewhat of a 
golden product in this category...
Right? The next product featured 
may change that impression.

Sharp XR-30X
The XR-30X is a lovely looking 
conglomerate of plastic and 
metal livered in dark gray and 
black. A strong profile and dark 
good looks coupled with the fact 
that this projector is built like a 
tank. Sharp has done an excellent 
job of the remote control unit. 

The menu system, however, is 
not intuitive and the back-

ground colour used 
for the menu is 

very distracting from the colour 
of the text. Perhaps if the guys 
at Sharp read this, a revision 
may sort out this issue which is 
admittedly minor. Connectivity 
is good with RJ45 making an 
appearance along with both VGA 
and DVI connects. 

On to DisplayMate’s suite, the 
XR-30X’s contrast is pretty good, 
as is its ability to work with 
colours. With great performance 
in the resolution and geometry 
tests, it was understandable that 
text quality would be good, but 
the XR-30X was absolutely excel-
lent! Sharp, clear and precise 
text with no visible aliasing or 
anomalies, the clarity was amaz-
ing. The quality of photographs 
was also very good—as good as 
we’ve seen from many of the sub 
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1-lakh rupee projectors, and 
this is amazing considering 
this one is present in a lower 
category. It did very well in 
F.E.A.R thanks to its ability to 
work with very dark scenes 
easily and with great detail 
(a healthy contrast ratio at 
work here), but we felt there 
was room for improvement 
in Crysis. The environments 
looked lovely and so were 
the effects, but somehow, 
the NEC VT800 in particular, 
makes such scenes look much 
more lifelike, crisp, and the 
foliage and outdoors look so 
much more resplendent. To 
be fair, at Rs 49,000, the XR-
30X is nearly half the NEC 
VT800’s price, and for half a 
lakh rupees, this is the best 
performing projector we’ve seen 
by yards.

Above 1 Lakh
Going To The Movies Will Be 
Cheaper, But Not As Much Fun

Epson EMP 1715
The EMP 1715 is the smaller alter-
native to the EMP 1815 and much 
lighter and compact than its 
larger sibling. It sports a superb 
finish and an even better build 
quality, something we expected 
from a device in this price cat-
egory, but it’s good to see prod-
ucts live up to their  pedigree. 
At first glance, it seems like a 
business oriented device with its 
boxy looks, and the inclusion 
of wireless LAN and USB con-
nectivity reiterate this fact. RJ45 
is missed, as is the inclusion of 
a card reader, which the elder 
sibling sports. A shutter system 
hides and protects the lens and 
acts as an A/V mute system when 
closed. It has a small, fat remote 

unit that works very well. It has a 
wide angle of functionality from 
the front and the rear, better 
than the other projectors in test.

We fired up DisplayMate first. 
After calibration, a deficient con-
trast ratio was noticeable. It per-
formed well in the geometry tests 
and the reverse text tests. Text, 
although readable, has smudgy, 
blurry edges, that we didn’t like. 
Although not usually an issue for 
a multimedia projector, a device 
aimed at the corporate world, 
should do well at any sort of 
text test. Colour quality is quite 
good with excellent rendition of 
reds and greens, crisp, vibrant 
and normal saturation. Although 
nearly all the mid-range and 
high-end NEC models do better, 
we have no complaints.

In our movie tests, we noticed 
some minor issues with con-
trast. Other issues existed with 
clarity of the picture, although 
brightness and detail levels 
were quite good. One thing to 
note about the EMP 1715 is that 

it doesn’t like to work with con-
tent that is non-native in terms 
of resolution. Most projectors 
don’t, but the problem was 
a little more noticeable with 
this model. This was most obvi-
ous in our gaming and movie 
tests, due to which gamers and 
movie junkies may steer clear of 
this model. At Rs 1,16,600, this 
projector is certainly expen-
sive enough, not to have such 
niggling issues! It’s clearly a 
business oriented device. The 
problem that we have with this, 
is that a much cheaper model—
the XR-30X from Sharp, outper-
forms it in the text and presen-
tation tests, of importance to 
corporates, which is why Epson 
doesn’t earn a recommendation 
from us here.

Epson EMP 1815
Another boxy looking projector 
and one that immediately fits 
the corporate image. It’s very 
well built, and the materials 
used are top class, although the 
finish is somewhat uninspiring 
if not downright unattractive. A 
large footprint means you bet-
ter make some serious room for 
this projector. With both WiFi 
and RJ45 connectivity, and the 
inclusion of a Compact Flash (CF) 
memory slot, the EMP 1815 is 
very much a corporate projector. 
USB ‘A’ and ‘B’ type connects are 
also provided. Once again, like its 

smaller sibling the lens protector 
doubles as an A/V on-off switch.

DisplayMate showed some 
issues with resolution, not a good 
sign for such a high-end projec-
tor, although the rest of the tests 
passed uneventfully. Text wasn’t 
as sharp as we’d like it to be, and 
this is our major gripe with a cor-
porate product—at least perform 
in the realm of your expertise 
for heaven’s sake! The same issue 
the EMP 1715 had crops up here 
—problems when working with 
non-native resolutions. Movie 
junkies and gamers will probably 
stop reading this review here and 
jump ahead. Nevertheless, there 
was also the presence of phase 
disturbances and moiré in the hor-
izontal and vertical bar and line 
tests to contend with. Thankfully, 
it has a good contrast ratio.

The movie and game tests were 
pretty much identical in terms of 

results to its alternative (the EMP 
1715) and for this price, all gamers 
will jump ship. For Rs 1,42,000, the 
Epson 1815 is a large projector that 
does quite a few things well, some 
decently, and fails to deliver on one 
or two fronts. At this price point, 
however, it’s perfection you’re after, 
and you won’t find it here.

Sony VPL-CX125
A very large and bulky projector 
to look at, with a superb finish 
—dark grey looks classy and suave 
and the quality of materials used 
by Sony is top class. It’s got a large 
remote control unit that’s equally 
well built and works wonderfully 
well. For such a high-end device, 
we bemoan the lack of DVI and 
component connectivity. Even 
USB connects have been shocking-
ly omitted, although RJ45 connec-
tivity is present. Also, this device 
doesn’t have any WiFi capabili-

ties, so corporates who use such 
connectivity options will need to 
look elsewhere. The menu system 
with its very slick and ultra usable 
4-way joystick is a pleasure to use. 
In fact, both the options and the 
ability to control them is so seam-
less, it’s like an iPod Touch as far 
as human interfacing goes.

The VPL-CX125 handled 
DisplayMate rather well and 
besides the presence of some 
moiré and issues with colour 
shifting, the White Shift and Black 
Shift part of the tests, this pro-
jector did rather well. It scores 
well when working with text, 
and the reverse text performance 
was also good. No surprise, that 
photographs look clear and crisp 
on this projector, ditto presenta-
tions. We also enjoyed the movie 
tests. It does hold its own in 
any sort of video playback test. 
In gaming, F.E.A.R did well as 
expected, although there were 
slight flaws with the contrast 
and detailing at lower light 
intensities. In Crysis we couldn’t 
spot any flaws. Note that while 
some NEC projectors did a better 
job, the VPL-CX 125 isn’t bad at 
gaming. This projector is there-
fore suitable for multimedia use, 
but at Rs 1,39,900, the question 
of investing such a large sum 
for mediocre performance raises 
its ugly head. There are better 
performing, cheaper projectors 
out there—no offence to the VPL-
CX125’s great capabilities.

NEC LT380
One of the best looking projec-
tors in test, the LT380, has a 
rounded, contoured body fin-
ished in a satin smooth mate-
rial with an attractive off-white 
colour. The front part that houses 
the lens, protrudes outwards in a 
curvy manner, giving this projec-
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Above Rs 1 Lakh

We divided our lot of projectors on the 
basis of prices:
1. Up to Rs 50,000
2. Rs 50,000 to Rs 1 Lakh
3. Above Rs 1 Lakh

Features
Here we looked at the basic features 
that anyone would expect a projector 
to have. All its specifications are noted 
by us, but we don’t rate them, as they 
reflect in the performance scores. We 
did rate features like the presence of optical 
zoom, and the connectivity options were 
graded. We gave a lot of importance to the 
menu layout, as some of you may have to 
frequently tune your projector for different 
usage patterns such as movie watching, text 
presentations, Internet surfing and gaming.

Performance
We calibrated these projectors using 
DisplayMate Video Edition. After calibrating, 
we ran Display Mate’s own suite through 

them to test various parameters. For our text 
and presentation tests, we used MS Word 
and PowerPoint 2007. For our movie tests, 
we used at least ten different clips, half of 
which were native 720p and the others were 
1080p clips. We also used two DVD movies.

For our gaming tests, we used three 
games, although we only rated two of 
them—Crysis and F.E.A.R. to avoid making 
the  test game heavy. The third game we 
used was S.T.A.L.K.E.R., because it mixes 
gloomy outdoors with some great environ-
ment effects.

  How We Tested

 Test Rig Configuration

Processor Intel Core 2 Duo E6700

Motherboard Gigabyte P965 DQ6

RAM Kingston 3GB DDR2 800 MHz

Graphics Card NVIDIA GeForce 8800GTX

OS Windows XP Professional SP3

Epson EMP 1715
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       Projectors Projectors Up To Rs 50,000 Projectors Under Rs 1 Lakh
Brand 
Model

BenQ
MP612c

BenQ
MP620c

Epson
EMP-S5

NEC
NP200G

Sharp
XR-30X

             NEC
           VT595

NEC
VT800

NEC
VT700

Sony
VPL-EX5

Sony
VPL-EX50

Sony
VPL-CX21

Price (Rs) Rs 40,000 Rs 44,000 Rs 40,100 Rs 48,000 Rs 49,000 Rs 54,000 Rs 92,000 Rs 95,000 Rs 54,990 Rs 79,990 Rs 99,990

Plus (+) Compact Well built Well built Very compact Good performer Good looks Excellent performer Good performer Looks good Looks good Well Built

Minus (-) Lacks performance Lacks performance Boxy look Lacks performance Slightly bulky Lacks performance Slightly pricey Overpriced None in particular Slightly costly Very Bulky

Grand Totals (Out of 100) 62.03 67.72 67.96 67.42 69.34 70.09 84.34 73.17 73.12 69.13 47.30

Features (Out of 45) 26.48 30.26 33.12 28.73 26.78 31.39 40.34 30.71 31.32 26.82 8.06

Performance (Out of 55) 35.54 37.45 34.84 38.69 42.57 38.71 44.00 42.46 41.80 42.31 39.24

Features

Projection System (DLP / LCD / LCOS / CRT) DLP DLP LCD DLP DLP LCD LCD LCD LCD LCD LCD

Native Resolution (Pixels) 800 x 600 1024 x 768 800 x 600 1024 x 768 1024 x 768 1024 x 768 1024 x 768 1024 x 768 1024 x 768 1024 x 768 1024 x 768

Brightness (ANSI Lumens) 2200 lumens 2000 lumens 2000 lumens 2100 lumens 2300 lumens 2000 lumens 2700 lumens 3000 lumens 2000 lumens 2500 lumens 2100 lumens

Contrast Ratio 2000:1 700:1 400:1 1300:1 2200:1 600:1 500:1 500:1 300:1 300:1 300:1

Optical Zoom (Y / N) 6 / 1.15x 6 / 1.15 6 / 1.35x 4 / 1.3x 6 / 1.15x 4 / 1.2x 4 / 1.2x 4 / 1.2x 6 / 1.2x 6 / 12.x 6 / 1.16x

Image Size (Max-Min) (Inches) 24 - 300 inches 31 - 300 inches 30 - 300 inches 27.5 - 302.8 inches 40 - 200 inches 21 - 300 inches 43.5 - 305.5 21 - 300 inches 40 - 300 inches 40 - 300 inches 40 - 300 inches

Throw Distance (Min-Max) (metres) 1 - 10 metres 1 - 10 metres 0.9 - 10.4 metres 1.2 - 12 metres 1.7 - 7.5 metres 0.7 - 11.1 metres 1.5 - 9.1 metres 0.7 - 10.7 metres 1.4 - 8.8 metres 1.4 - 8.8 metres 1.22 - 10.67 metres

Lamp (Hours) (Normal / Eco mode) 3000 / 4000 hrs 3000 / 4000 hours 3000 / 4000 hrs 3500 / 4000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs

Horizontal Frequency (KHz) 31 - 82 KHz 31 - 82 KHz 15 - 92 KHz 31.35 - 80 KHz 15 - 70 KHz 15 - 100 KHz 15 - 108 KHz 15 - 100 KHz 19 - 92 KHz 19 - 92 KHz 19 - 92 KHz

Vertical Scan Rate (Hz) 48 - 85 Hz 48 - 85 Hz 50 Hz - 80 Hz 56 - 85 Hz 45 - 85 Hz 50 - 120 Hz 48 - 120 Hz 50 - 120 Hz 48 - 92 Hz 48 - 92 Hz 48 - 92 Hz

Video Input (S-video, Composite, Component, D-Sub, DVI, HDMI) 4 / 4 / 6 / 4 / 
6 / 6

4 / 4 / 6 / 4 / 
4 / 6

4 / 4 / 6 / 4 / 
6 / 6

4 / 4 / 6 / 4 / 
6 / 6

4 / 4 / 6 / 4 / 4 / 6 4 / 4 / 6 / 4 / 4 / 6 4 / 4 / 6 / 4 / 6 / 4 4 / 4 / 6 / 4 / 4 / 6 4 / 4 / 6 / 4 / 6 / 6 4 / 4 / 6 / 4 / 6 / 6 6 / 4 / 6 / 4 / 6 / 6

USB Connectivity (Y / N) 6 4 4 6 4 6 4 6 6 6 6

Audio Inputs (PC Stereo, RCA L/R) / Speakers (Mono / Stereo) 4 , 6 / Mono 4 , 6 / Mono 4 , 4 / Mono 4 , 6 / Mono 4 , 4 / Mono 4 , 4 / Mono 4 , 4 / Mono 4 , 4 / Mono 4 , 6 / Mono 4 , 6 / Mono 6 , 6 / Mono

PC Control Terminal (Y / N) 4 4 4 4 4 4 4 6 4 4 6

Maximum Power Consumption 285 watts 285 watts 231 watts 228 watts 283 watts 255 watts 310 watts 295 watts 225 watts 260 watts 220 watts

Rated Noise (dB) (Max) 31 dB 28 dB 31 dB 36 dB 33 dB 34 dB 36 dB 35 dB 33 dB 33 dB 41 dB

Weight (kgs) 2.5 kgs 2.67 kgs 2.6 kgs 2.3 kgs 2.9 kgs 3 kgs 3.7 kgs 3.1 kgs 2.9 kgs 3 kgs 1.87 kgs

OSD Menu Layout And Usability (Scale Of 10) 7.5 7.5 7 7.5 6 7.5 8.5 8.5 8 8 NA

Digital Keystone 6 6 4 6 6 6 4 6 4 6 6

Remote Control 4 4 4 4 4 4 4 4 4 4 6

Performance

Display Mate Video Edition (Scale Of 10)

Sharpness And Resolution

Horizontal / Vertical Bar Resolution 6.5 / 6.5 6.5 / 6.5 6.5 / 6.5 7.5 / 7 7.5 / 7.25 6.75 / 7 7.5 / 7.5 7.5 / 7.5 7.25 / 7 7.25 / 7.25 6.25 / 7

Corner Resolution 6.5 6.25 7 7.25 7.5 7 7.5 7.25 7 7.25 7

Focus / Fine Focus / Diagonal Focus Matrix 6.25 / 6.25 / 6.5 6.25 / 6.5 / 6.75 6.5 / 6.75 / 6.75 7 / 7.25 / 7.25 7.25 / 7.25 / 7.5 6.75 / 7 / 6.5 7.75 / 7.5 / 7.5 7.5 / 7.5 / 7.5 7.25 / 7.25 / 7.5 7.5 / 7.5 / 7.25 7 / 7 / 7

Moire Pattern 5.5 5.75 6.25 7.75 7 7 8 8 7 7 6.75

Screen Pixel Resolution 6 6.5 7 7.25 7.5 6.75 7.5 7.5 7.5 7.5 7.25

Color And Gray Scale Tests

Streaking And Ghosting / Colour Streaking 6.5 / 6.25 6.25 / 6.5 6.75 / 6.75 7.5 / 7.25 7.5 / 7.5 6.5 / 7 7.5 / 7.5 7.25 / 7.25 6.75 / 7 6.75 / 7 7.25 / 7

16-intensity Levels 6 6 6.5 7.75 7.75 6.75 7.75 7.25 8 7.75 7.5

White / Black Level Shift 6.5 / 6.25 6.25 / 6.25 6.5 / 6.5 7.5 / 7.5 7.5 / 7.5 7 / 6.75 7.5 / 7.5 7.5 / 7.5 6.25 / 5.5 6.25 / 6.25 6.5 / 6.5

Red / Green / Blue Colour Purity 6 / 6 / 6 6 / 6.5 / 6.75 6.25 / 6.5 / 6.25 7.5 / 7.5 / 7.5 7.5 / 7.5 / 7.75 7.25 / 7 / 7 7.75 / 7.75 / 7.5 7.5 / 7.5 / 7.5 7.75 / 7.75 / 7.75 7.75 / 7.75 / 7.5 6.75 / 6.5 / 6.75

Miscellaneous Effects (Scale Of 10)

Screen Uniformity / Flicker / ANSI Brightness, Contrast 6.25 / 6 / 6 6 / 6.5 / 6.25 6.75 / 6.75 / 6.5 7.25 / 7.25 / 7.25 7.5 / 7.25 / 7 7.5 / 7.25 / 6.75 7.75 / 7 / 7.25 7 / 6.75 / 6.75 6.5 / 6.25 / 6.5 6.75 / 6.5 / 6.5 6.25 / 6 / 7

Defocusing, Blooming And Halos 6 6.5 6 7 7 6.75 7 7 6.5 6.5 7

Presentation Tests (Scale Of 10)

Text / Reverse Text Quality (P Mode) 6.5 / 6 6.75 / 6 5.75 / 6 7.25 / 7.5 8.75 / 7.75 6.75 / 6.75 8.5 / 7 8 / 7 7.75 / 7.25 8 / 6 6.5 / 6.5

Quality Of Photographs / Animation 6.5 / 6.5 6.75 / 6.5 6.25 / 6.25 6.5 / 6.75 8.25 / 7.75 7.5 / 7.5 8.25 / 7.5 8 / 7.5 8.25 / 7.25 8.25 / 7.75 7.5 / 6.75

Movie Tests (Scale Of 10)

Brightness And Contrast / Crispness, Detail 6.5 / 7 6.75 / 7.5 6.5 / 6.5 7.5 / 7.5 7.75 / 8 7 / 7.25 8.25 / 8.5 8 / 8 8 / 8.25 8 / 8.25 7.5 / 7.5

Game Quality Tests

F.E.A.R.

Effects Quality / Sharpness And Detail 6.75 / 6 7.25 / 7 6.5 / 6.25 6.75 / 6.5 7.75 / 7.5 7 / 7 8 / 7.75 7.75 / 7.5 7.5 / 7.5 7.75 / 7.5 7.5 / 7.25

Crysis

Effects Quality / Sharpness & Detail 6.75 / 6.5 7.25 / 6.75 6.25 / 6.25 6.75 / 6.75 7.25 / 7.5 7 / 7 8.25 / 8.25 7.75 / 8 7.75 / 7.5 8 / 7.75 7.5 / 7

Warranty 2 years 2 years 2 years 2 years 2 years 2 years 2 years 2 years 1 year 1 year 1 year

Digital Tools l Projectors Test
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tor a distinct look, that is both 
muscular and stylish. PC card 
connectivity is something we’re 
seeing for the first time. The de 
facto, (for a high-end projector), 
USB and RJ45 connects are pro-
vided. Component connectivity 
is another plus for video enthu-
siasts who usually hate low qual-
ity Composite connects. S-Video, 
VGA and DVI connectivity is also 
present, and the fully functional 
and stylishly contoured remote 
control gives the impression of 
this being a packed-to-the-gills 
solution. For PC control, a serial 
interface has been provided.

This projector trounced 
DisplayMate and chalked up some 
scores for which nobody had any 
criticism. Text quality is sharp, 
clear and precise with well defined 
fonts. Movie quality is simply 
mind-blowing—neck and neck 
with the VT800, and HD movies 
are a ton of fun on this projector. 
Likewise, gaming is immersive, 
and if you’re a hardcore gamer 
who wants something feature-
rich, then the LT380 is highly 
recommended. Crysis comes to 
life with simply amazing detail-
ing, colour and contrast.

At Rs 1,24,000, the NEC LT380 is 
the upper echelon of home enter-
tainment. It’s a more balanced 
solution than NEC’s own VT800 
with an additional connectivity 
option at the loss of an HDMI port, 
which at this price point, should 
be included. Sorry to complain 
NEC, but you’ve slipped up here. 

tal coaxial input that’s labelled 
“For Computer”. These five BNC 
connects can also be used with 
Component connectivity. USB 
and RJ45 connects are also pro-
vided. Finally, this projector fea-
tures stereo speakers, and the vol-
ume output is pretty impressive 
for a projector. 

DisplayMate was a breeze, with 
the large NP1150G just warming 
up to the challenge. It’s got bril-
liant image quality with photos, 
animations and presentations 
looking amazing. Text quality is 
good, and is only surpassed by the 
excellent Sharp XR-30X. Fire up a 
movie, and you can really relax in 
front of this beauty. With a 3700-
lumen brightness rating and a 
contrast of 600:1, the NP1150G is 
special when it comes to deliver-
ing cinematic-like quality inside 
your living room, or wherever you 
choose to place it.

For games, it’s a mixed bag. 
Sure it was excellent, but there 
were places when we felt its cheap-
er siblings, the LT380 and VT800 
outdo it. However, for the most, it 
was a much better performer, and 
we spent hours playing Crysis and 
S.T.A.L.K.E.R. on this one. F.E.A.R. 
comes to life, replete with scary 
effects, realistic shadows, and 
some amazing weapon detail-
ing. The atmospheric essence of 

this game is exception-
ally well captured.

For its versatili-
ty, connectivity 
options, build 
quality, and per-
formance, the 

NP1150G is an amazing projector. 
No wonder then, that its price 
also brings with it the most audi-
ble “Ouch!”. At Rs 1,58,000, we 
figure this beauty is a beast that 
faces serious threat from its lean-
er, meaner siblings—but nobody 
else. If you are intent on cough-
ing up this much dough for a 
home entertainment system, we 
advise you to buy one of its 
cheaper siblings mentioned 
above, and invest in a better set 
of surround sound speakers than 
the ones you have planned. Spend 
wisely, don’t just spend. 

michael.browne@thinkdigit.com

We can’t recommend the LT380 
over its sibling for a home the-
atre system, as there’s nothing to 
choose from on the performance 
front, though there’s a rather 
large price difference of Rs 30,000 
between them.

NEC NP1150G
The colossal NP1150G is being 
reviewed last, not because it’s the 
costliest projector on test, but 
because it is by far the heaviest 
(7.3 kgs), with no one wanting to 
heft it out of its packaging! It’s 
got a mock metallic finish on the 
sides with piano white plastic on 
the top part of the body and gray 
and a glossy white splashed every 

where else. Needless to say, it’s 
huge, but it’s still well shaped. 
The sheer bulk won’t please 
many. The body shape is reminis-
cent of the VT800—only larger. 
Display Connectivity includes 
D-Sub, DVI, Composite, 
Component, S-Video and a (hard-
ly used) five connector BNC digi-

NEC NP1150G

       Contact Sheet                 Projectors

Brand Company Phone No E-mail Web site
BenQ BenQ India +91-11-43531700 sales.enquiry.in@benq.com www.benq.co.in

Epson Epson India Pvt. Ltd. +91-80-30515023 emp@eid.epson.co.in www.epson.co.in 

NEC NEC India Pvt. Ltd. +91-11-46570000 enquiries@necindia.in www.nec-display.com/ap

Sharp Sharp Business Systems (I) Ltd +91-9821067901 dhiren@mum.sharp-oa.com www.sbsil.com 

Sony Sony India Pvt Ltd 1-800-11-11-88 sonyindia.care@ap.sony.com www.sony.co.in 

       Projectors Projectors Above Rs 1 Lakh
Brand 
Model

Epson
EMP 1715

Epson
EMP-1815

NEC
LT380

NEC
NP1150G

Sony
VPL-CX125

Price (Rs) Rs 1,16,600 Rs 1,42,000 Rs 1,24,000 Rs 1,58,000 Rs 1,39,900

Plus (+) Well Built Well Built Great Performance Great Connectivity Well Built

Minus (-) Lacks Performance Very Expensive Slightly Overpriced Bulky and Heavy Very Bulky

Grand Totals (Out of 100) 71.06 75.61 83.90 81.15 73.89

Features (Out of 45) 33.12 36.43 40.17 37.87 31.32

Performance (Out of 55) 37.94 39.19 43.73 43.29 42.57

Features

Projection System (DLP / LCD / LCOS / CRT) LCD LCD LCD LCD LCD

Native Resolution (Pixels) 1024 x 768 1024 x 768 1024 x 768 1024 x 768 1024 x 768

Brightness (ANSI Lumens) 2700 lumens 3500 lumens 3000 lumens 3700 lumens 3000 lumens

Contrast Ratio 400:1 500:1 600:1 600:1 650:1

Optical Zoom (Y / N) 6 / 1.2x 6 / 1.6x 4 / 1.2x 4 / 1.2x 6 / 1.16x

Image Size (Max - Min) (Inches) 30 - 300 inches 30 - 300 inches 21 - 300 inches 30 - 500 inches 40 - 300 inches

Throw Distance (Min - Max metres) 1 - 12.1 metres 0.8 - 14.7 metres 0.53 7.62 metres 0.76 - 12.7 metres 1.4 - 9.1 metres

Lamp (Hours) (Normal / Eco mode) 2000 / 3000 hrs 2500 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs 2000 / 3000 hrs

Horizontal Frequency (Khz) 15 - 92 KHz 15 - 99 KHz 15 - 100 KHz 15 - 108 KHz 19 - 92 KHz

Vertical Scan Rate (Hz) 50 - 85 Hz 50 - 120 Hz 48 - 120 Hz 48 - 120 Hz 48 - 92 Hz

Video Input (S-video, Composite, Component, D-Sub, DVI, HDMI) 4 / 4 / 6 / 4 / 
6 / 6

4 / 4 / 6 / 4 / 
6 / 4

4 / 4 / 4 / 4 / 
4 / 6

4 / 4 / 4 / 4 / 
4 / 6

4 / 4 / 6 / 4 / 6 / 6

USB Connectivity (Y / N) 4 4 4 4 6

Audio Inputs (PC Stereo, RCA L/R) / Speakers (Mono / Stereo) 4 , 6 / Mono 4 , 4 / Mono 4 , 4 / Mono 4 , 4 / Stereo 4 , 6 / Mono

PC Control Terminal (Y / N) 4 4 4 4 4

Maximum Power Consumption 228 watts 286 watts 292 watts 460 watts 285 watts

Rated Noise (dB) (Max) 38 dB 36 dB 35 dB 33 dB 32 dB

Weight (kgs) 1.7 kgs 3.1 kgs 3.5 kgs 7.3 kgs 4.1 kgs

OSD Menu layout and Usability (Scale of 10) 8 7.5 8.25 8.5 9

Digital Keystone 4 (Vertical Only) 4 4 4 4

Remote Control 4 4 4 4 4

Performance

Display Mate Video Edition (Scale Of 10)

Sharpness And Resolution

Horizontal / Vertical Bar Resolution 6.5 / 6.5 6.75 / 6.75 7.5 / 7.5 7.75 / 7.5 7.5 / 7.5

Corner Resolution 6.75 7 7.5 7.75 7.5

Focus / Fine Focus / Diagonal Focus Matrix 6.5 / 6.5 / 6.5 7 / 7 / 7 7.5 / 7.5 / 7.5 7.5 / 7.5 / 7.75 7 / 7 / 7

Moire Pattern 6.5 6 7.25 8 6.75

Screen Pixel Resolution 7 7.75 7.25 7.75 7.5

Color And Gray Scale Tests

Streaking And Ghosting / Colour Streaking 6.5 / 6.5 7 / 7.25 7.5 / 7.5 7.5 / 7.5 7 / 7

16-intensity Levels 7.25 7.75 7.75 7.25 8

White / Black Level Shift 7 / 7 7 / 7 7.5 / 7.5 7.5 / 7.5 6.5 / 6.25

Red / Green / Blue Colour Purity 7.5 / 7.25 / 7 7.75 / 7.5 / 7.75 8 / 7.75 / 7.5 7.25 / 7.75 / 7.5 7.75 / 7.75 / 7.5

Miscellaneous Effects (Scale Of 10)

Screen Uniformity / Flicker / ANSI Brightness, Contrast 6.75 / 6 / 6.25 7.5 / 7.25 / 7.25 7.75 / 7.25 / 7.25 7.75 / 7 / 7.5 7 / 6.5 / 7

Defocusing, Blooming And Halos 6.5 6.5 7 7 7

Presentation Tests (Scale Of 10)

Text / Reverse Text Quality (P Mode) 7 / 7 7 / 7.25 8.5 / 7.5 8.25 / 7.5 8 / 7.5

Quality Of Photographs / Animation 7 / 7 8 / 7.5 8.25 / 7.75 8.25 / 8 8 / 7.5

Movie Tests (Scale Of 10)

Brightness And Contrast / Crispness, Detail 7.25 / 7.25 7.5 / 7.5 8.25 / 8.25 8.25 / 8.5 8 / 8

Game Quality Tests

F.E.A.R.

Effects Quality / Sharpness And Detail 7 / 7 7 / 7 7.75 / 8 8 / 8.25 7.75 / 7.75

Crysis

Effects Quality / Sharpness And Detail 6.75 / 6.25 6.75 / 6 8 / 8.25 8.25 / 8.25 8 / 8

Warranty 2 years 2 years 2 years 2 years 1 year

NEC LT380
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court where the forensic expert would be called
either as a witness for prosecution or defence.
Again, cyber forensics does not necessarily
mean that its practitioners would have to deal
with computers and servers all the time.
Depending on cases, mobile phones, pen drives
and in some cases, even personal media players
have come under the scanner of the e-sleuths. 

Cyber Crime And Legal Aspects
Before we proceed deeper into the
subject, there is an urgent need to
know what cyber crime actually is.
The United Nations defines cyber
crime as illegal electronic opera-
tions that target the security of
computer systems and data
processed by them, or illegal
behaviour that uses computers
and networks.

In India, the primary
statute is the IT Act 2000,
although some sections of
other laws like the Indian
Penal Code can be applied to
digital crime. We are not

Bhaskar Sarma

Mention crime, and we think of rob-
beries, murders and detectives examin-
ing the scene, interrogating witnesses

and finally nailing the guilty.
There is, however, another kind of crime,

where traditional methods of criminal investi-
gation fall flat on its face. Instances like hack
attacks, cyber fraud, phishing, identity and
data theft, all account as cyber crime. Even
though it may appear that the effects of digital
crime are not life threatening, they have the
potential to disrupt life, as well as tamper with
property. Just imagine, a situation if Indian
Railway’s ticket reservation system goes down
for even a day? In fact, a survey in UK conclud-
ed that people were more scared of their bank
accounts being hacked or credit card details
stolen over the Internet, than they were of mug-
gings and robberies.  

We could go on and on about different sce-
narios, but the point is, digital crime occurs.
While better information security would cer-
tainly act as a deterrent, crime can never be
totally eradicated. So, the next best thing to do,
is to find out the culprit. When the crime com-
mitted is related to the Internet and computers,
then cyber forensic expert enter the scene, and
try to sniff out the clues, and trace the byte-trail
that can help in catching the perpetrators.

On The Job
Digital forensics, of which cyber forensics is
one facet, is a vast discipline, which encom-
passes several other fields. A digital forensic
expert is supposed to be adept in network secu-
rity, because most cyber crimes take place over
networks. He / she needs to be good at encryp-
tion and data recovery too, because passwords
and data are always inevitably involved in theft
of information. Awareness of cyber laws are
also important, as most of these cases can go to

Tech Careers

Trail of Bytes
While instances
of crime in the
cyber space
shoot up,
demand for
forensic experts
also increase. We
explore the
options
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going to list out the provisions of the IT Act that
are concerned with cyber crime. However, acts
like hacking, identity theft, phishing and spam-
ming all become cognizable offences, punish-
able by fine and prison terms.

Understandably concerned, the govern-
ment and the private sector have done their
bit in trying to educate police and judiciary in
new paradigms and technologies. NASSCOM
has four cyber labs across the country, and is
involved in a government project to train
state police departments in state-of-the-art
digital investigation techniques. However,
with crime rates soaring, these efforts may
not be sufficient. The Indian IT and ITeS sec-
tors urgently need solutions to these prob-
lems, as the industry deals with highly sensi-
tive, and often, personal data.

Skills And Tools
When it comes to corporate houses, they don’t
really tend to trust cops a lot. They guard their
data fiercely and don’t like others messing up
on their turf. Also, the process of recording evi-
dence after a digital crime has been committed
is a lot like walking on eggshells without mak-
ing a sound—a single data packet missing out of
millions, one electron with a magnetic pole
askew, and the data would not stand up to legal
scrutiny. To recover data from the crime scene,
to analyse and map the course of events to non-
technical persons, including your bosses and
maybe a judge, is the daily job description of a
digital forensic expert.

Every job has its tools and the job of a digi-
tal detective is no exception. Cyber forensic
tools are software packages that can be used to
preserve the state of hard disks and storage
devices, extract data from mobile phones and
sniff out network packets. As with other kinds
of software, there is both open source as well as
proprietary software. Many companies also use
tools that are tailor-made to their specific
needs. Some types of tools are En-Case, X-Ways
Forensics and Cyber Examiner. In India, the
Resource Centre for Cyber Forensics (RCCF), a
part of C-DAC (Centre for Development of
Advanced Computing) is in charge of develop-
ing tools used by police departments and cyber
crime cells. Professionals in this field are
expected to be proficient in usage of more than
one of these tools.

Degrees And Colleges
As mentioned earlier, the field of cyber foren-
sics is still evolving. Hence, there is a lot of
confusion on the part of students who are
interested in pursuing this particular career
option. To be good, students in digital investi-
gation need to master various disciplines. Not
only should they be comfortable with run-
ning a hash analysis of files, they would also
need to know the legal procedures of present-
ing evidence in court. It’s a mixture of being a
cop and a geek, which is challenging and fun
to interested and committed professionals.
Jaya Narayanan, from the security consulting
firm NJY hits the bull’s eye, “What we would
like to suggest to those individuals who have
done, and are currently doing, a course in
Cyber Forensics is to also do other various IT
courses to support their career and to give
their career a strong foundation”.

For instance, a cyber forensic individual
would always invariably have to work on com-
puter networks, as well as network security.
This means that network security certifica-
tions are essential for the candidate to be con-
sidered for this post. As a representative of
Valiant Technologies, a Chennai-based infor-
mation security-consulting firm affirms, certi-
fications like CCNA (Cisco Certified Network
Associate) Security and CCSP (Cisco Certified
Security Professional) are good starting points. 

Knowledge of networking is also stressed a
lot by Dr R. Thilagaraj, head of department of
Criminology at University of Madras. This
department runs two popular courses related
to cyber forensics. One is MSc in Cyber
Forensics and Information Security (two
years) and the other is Diploma in Cyber
Crime and Information Security (one year).
Started in 2004, with financial aid from the
University Grants Commission, the Masters
courses are open to candidates having BSc
degrees in maths, physics, statistics, comput-
er science or BE / BTech degrees. Apart from
this, it is mandatory to clear a qualifying test.
Further information about the course can be
obtained from the University of Madras home-
page (http://www. unom.ac.in/). It might be
tough to get admission in the course, as the
number of seats is only 20.

Another reputed institute that has been at
the forefront of training newbies in cyber foren-
sics is C-DAC. However, most of its teaching
efforts are focussed on the government sector,
as it is one of the agencies entrusted with bring-
ing the law enforcement authorities up to
speed with the latest in cyber crime. However, C
Balan, deputy director, RCCF says, “We have
plans to start cyber forensic courses for stu-
dents in the near future. Initially they will start
out of Trivandrum, but later will be rolled out
across the country.” 

In the private sector, there are institutions that
offer courses in cyber forensics along with informa-
tion security. Some others also specialise in giving
short terms courses in cyber law with emphasis on
information security. Asian School of Cyber Laws at
Pune is one, Cyber Law College Chennai is another. As
of today, there is hardly any industry standard certifi-
cation or standards in the field of digital forensics.
Before they decide to spend their money and time,
they should do a thorough research on the back-
ground. In particular, they should check the employ-
ability status of the alumni and decide whether the
training provided is good enough for the industry.
Look at the box on the previous page for a list of insti-
tutions that offer courses related to cyber forensics.

Career Paths
A career in cyber forensics can be sought both in pub-
lic, as well as in the private sector. In the public sec-
tor, people are mostly absorbed into law enforcement
agencies like the cyber crime cells, state forensic
departments and central agencies like the CBI.
However, regular and mass recruitment of freshers
may not be possible, because government depart-
ments focus more on training existing employees
rather than hiring new people. 

However, the scope for employment in private
sector is immense. According to a NASSCOM report,
20,000 cyber security professionals would be need-
ed to detect and solve cyber crimes. A bulk of these
people would be needed by banks, financial institu-
tions, consulting companies—basically any entity
that has valuable data. “In India most banks have
their own Fraud Management Cells, which is where
people with these skills are the most needed,” says
Dr Sachin Pandey, CEO of Agape Inc—the company
that runs NIeF. 

Besides, all the big IT companies have their own
computer emergency response teams (CERT) who are
responsible for internal IT security and usually the
first line of defence against any external attack.
Additionally, there are specialist companies that
work on ethical hacking, cyber forensics and IT secu-
rity. The career path is usually from engineer to prin-
cipal or lead security consultant. In terms of salaries,
freshers get about Rs 30,000 to Rs 50,000 more per
annum than other entry-level positions. As with
other positions in the IT industry, there are plenty of
overseas opportunities. After sufficient experience,
professionals can branch out into freelancing and
become independent security consultants. 

A cyber forensic professional’s job is very impor-
tant. It’s also very challenging, and provides enor-
mous scope for learning new technologies. The secu-
rity landscape is changing continuously and unlike
traditional crime busting, something happening
thousands of miles away can have immediate impact
on IT security parameters at your office or company.
Only someone who has an active and alert mind with
an attitude to constantly learn new things can suc-
ceed in this field.

bhaskar.sarma@thinkdigit.com

A certified Cyber
Forensics expert can
work as a Cyber
Forensics expert in
Cyber Crime
Investigation (CCI)
and also as a Data
Recovery expert”

Jaya Narayanan
VP, NJY

Dept of Criminology, University of Madras (http://www.unom.ac.in/
Indian Institute of Information Technology, http://www.iiita.ac.in/
Allahabad
C- DAC, Trivandrum http://www.cyberforensics.in/
Cyber Law College, Chennai http://www.cyberlawcollege.com/
National Institute of e-Forensics, Mumbai http://www.nief.in/
Asian School of Cyber Laws Pune http://www.asianlaws.org/

Institutes Offering Courses In Cyber Forensics
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Nash David 

Actions speak louder than words, or so they
say—precisely what the trio from our very
own IIT Bombay believes. We all know of

the implications of energy resources getting
exhausted and the resultant rise in electricity
costs. Most of us, wish we had better ways to
stay live and kicking with our gadgets, without
the need to constantly plug them into the AC
mains sockets. There’s now reason to smile,
there’s hope coming our way.

Making A Difference
We met Ankit Mehta (25), Ashish Bhat (24) and
Rahul Singh (24), who have come together to
form a start up focussing on energy solutions
for your gadgets. “Our aim is to be a company
that gives the consumer the freedom of walls-
free charging”, according to Mehta, Managing
Director of ideaForge, who heads the firm’s
attempt to provide a typical user like you, the
freedom to charge your mobile phone, anytime,
anywhere—be it in office, sitting idle in a park
or even while travelling on your bike. 

The Company
As we caught up with the team incubated at the
Kanwal Rekhi School of Information
Technology in the IIT Bombay campus, Mehta
shed light on the way the team met, came
together, got organised and managed the
design and launch of their products. It all
started somewhere in 2004, in IIT Bombay,
where they casually interacted among them-
selves. The initial plan to work on energy solu-

tions, was conceived a couple of years later, in
2006. As the drive to innovate got the better of
them, they decided to get their acts together
and in the summer of 2007, formed ideaForge
in its current form. 

Finances came in the form of Technopreneur
Promotion Programme (TePP), a government
body that promotes innovative technology start-
ups. Other than that, there were personal funds
in addition to an angel investor.

Their Products
ideaForge has developed three useful products
for the Indian market. A USB-powered mobile
charger, a hand-cranking or mechanical phone
charger and a two-wheeler solution for mobile
phone charging. They have profiled their
market into two segments—urban and rural. As
per their study, the penetration of Nokia, Sony
Ericsson and Motorola is higher in the urban
areas, while that of LG and Samsung is higher in
the rural areas. Accordingly, they have packaged
their chargers with adapters for phones depend-
ing on the market they will be shipped to. With
the adapters that they provide in their packag-
ing, you are able to charge 90 per cent of mobile
phones commercially available in the market,
without any additional accessories. In the event
that your phone’s adapter is not available, they
are open to helping you out in that area too.

We checked out their USB chargers back in
our office for the whole month while we were
working on this article, and it worked really
well. While in office, all you need to do is plug
in the phone to the USB charger with the other
end plugged in to the USB port of your laptop or

No more struggles in charging
your mobile phone while on the
go… sounds interesting. We met
some guys, who are bringing this

task to practical reach.
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Bike charger in use. Now
get your phone charged
even while travelling
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PC. The second product was
fun playing with. Priced at
Rs 450, the hand-cranking
charger is what caught our
attention the most. It has a
comfortable rubber grip
and a smooth crank wheel,
which isn’t cranky to use.
Alternatively, you can also
rotate the wheel by drag-
ging the charger across any even surface. With
all its mechanism, it weighs a modest 110
grams—we had it weighed out of our curiosity.

We asked them about the mechanism of the
hand-cranking charger, so that you could under-
stand it better. Well, it’s not rocket science, but
simplified engineering at work. The handle of
the charger connects to a gear train, which
drives a generator system. The output of the
generator is passed through a conditioning
circuit. After going through the voltage
regulator, you get pure DC at the specified
voltage and current ratings.

The mechanical charger has two modes
of operation—one is the Wind-up mode
and the other is the Roll-on mode. With
the roll-on mode, you can roll the charger
wheel to and fro on any surface, such as
your thigh while sitting and having a
conversation over your mobile phone. This
feature enables single hand operation to
charge mobile phones—no more fishing for
battery power!

Their third product—the bike-powered
charger, is another innovative idea. All you
need to do is to connect the two wires at the
end of the charger’s cable to a connector pres-
ent after the ignition of your bike. On the other

end is the jack with the
adapter for your phone,
and you are ready to
charge while travelling to
and fro your home, office
or college.

Company Plans
ideaForge seem focussed
on reaching the extended

rural Indian market. They claim to be on the
verge of some strategic tie-ups with leading
cellular operators of India, so that they have a
wide distribution network. Further, their prod-
ucts are also available in major outlets such as
RPG Cellucom, Hot Spot, the Mobile Store,
Indiatimes shopping, eBay and Storrz. Our first
apprehension, when we heard of their products
was their Chinese counterparts. But as they
believe, they are not here to compete with

Chinese products. They believe in qual-
ity, which is visible from their replace-
ment guarantee. If you find manufac-
turing defect in your product, it is
replaced straightaway. They also have
plans to improve their design in future
models. “We plan to include options
for storage of charge, and reducing the
required effort, so that the consumer
can get maximum charge with mini-
mal cranking,” according to Ashish
Bhat, who handles the electronic
design, as well as the research and

development initiatives at ideaForge.

Initiatives For The Environment
If that’s not all, they also are responsible in their
conduct towards the environment. Talk of global
warming and hazardous materials, and they say
they’re already getting their company on track.

ideaForge is en route to compliance with the
required quality certifications. In addition to
this, they also plan to comply and achieve certi-
fication in certain crucial environment-specific
standards—the primary being RoHS compli-
ance. Although ideaForge doesn’t directly
manufacture the chargers, they are still doing
their bit by ensuring that the manufacturer
that does the job also has the required certifi-
cation. According to Rahul Singh, who looks
after the manufacturing, production and other
ancillary responsibilities, “We have outsourced
this work to several manufacturers and we
ensure that they are RoHS compliant, espe-
cially, the Chinese source of some raw materi-
als. Other than that, the paper that is used for
packaging are from wood-free sustainable
forest resources. Even the ink used for printing
on their products is “heavy metal-free”. 

If you too, would like to do more than just
talk, and make a difference to our society like
ideaForge, write in to us...

nash.david@thinkdigit.com

Don’t have to carry bulky chargers to work
anymore

Joydeep

Rahul

Ankit

Vipul

A very simple mechanism
at your aid
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Then comes the risk assessment—figuring out how important a
security issue is. Consider the scenario that a laptop is stolen. On a
scale of 0 to 10, the probability of this scenario is, say, 3. Now, on a
scale of 0 to 10 again, the damage this scenario could cause is, say, 8.
The risk of a particular scenario is the product of the probability that
it occurs and the damage it could cause if it did. The higher the risk,
the more measures you’ll need to take to bring it down. The numbers
expressed here are random—you’ll have to assess your own situation
(how scatterbrained is the employee with the laptop, and so on) and
arrive at your own values. There’s no formula involved here, and it’s
far from an exact science. The idea of the risk assessment is more to
help you prioritise tasks. 

But we get ahead of ourselves here. First, we need to prepare for
the audit.

Groundwork
This is where we prepare our checklists, starting with the company’s
assets—PCs, printers, laptops, cameras, e-mails, passwords and so on—
pretty much anything that can be threatened by unnamed malicious
forces. This list should be detailed—model numbers, serial numbers,
and so on.

Once you’re done cataloguing your assets, it’s time to assess the
threats you might face. Common threats are stolen passwords, falling
prey to a phishing e-mail, stolen or misplaced laptops and PDAs, and so
on. If you can think of a threat, put it on the list—no matter how silly
it sounds (once you start calculating risks, the less likely threats will
find themselves low on your priority list anyway). 

You should also know your security history—when was the last time
you faced a security issue? How much damage did it do? Have you taken
appropriate measures to ensure it doesn’t happen again? Keep tabs on
security trends in the small business / SoHo sector as well—they’ll give
you an idea of currently prevalent threats, and will likely lengthen
your threat list. 

Finally, take your threat list and calculate the risk of each threat.
Now, you can begin your audit. We’ll only go through some of the more
common threats here. 

Auditing Access
When you’re not controlling who has access to what data, you’ve got
yourself a problem. A visitor could walk away with your list of
clients, for example, and you’d be none the wiser. An ideal situation
would be to set up a domain controller (Digit February 2007). Failing
that, you should ensure that all shared folders are password protect-
ed, and are accessible only by specific users—this means turning on
Advanced Folder Sharing under Tools > Folder Options > View
in Windows Explorer, and editing the permissions on shared fold-
ers. Furthermore, use dollar-shares—append a “$” at the end of the
share name. 

Another thing you want to look out for is automatic logins—while
convenient, it’s more than unadvisable to allow a PC to automatically
log in to a user’s account. Should the wrong person be seated in front
of that PC, it could possibly give him administrative access. In the same
vein, network passwords shouldn’t be saved on a PC—go to Start >
Run. Type control userpasswords2 and press [Enter]. In the
Manage Passwords tab, make sure the list is empty. Ditto e-mail pass-
words—both in the e-mail client and on the Web. Finally, ensure that
when a PC is left unattended, it’s screen is locked ([Windows] + [L]).

Auditing Applications
The next threat comes from installed applications that shouldn’t
really be installed. Most often, these are instant messaging (IM)
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the term, but like any other audit, the basic
idea is to examine the truth of a claim—the
claim, in this case, being that you’re safe from
security threats. You might think that “Security
Audit” is just a glorified term for sitting with a
checklist—to a certain extent, it is. However, the
seemingly mundane task of checking items off
your list will let you know where you’re going
wrong with security, and help you formulate a
better solution. 

In the corporate world, security audits are
carried out by a crack team of experts, who usu-
ally come at a fee that can run close to a lakh
for a single consultancy. While some aspects of
an audit can only be performed by security
experts, you can do a fairly effective—and very
cheap—audit yourself, too. 

The Elements
So how does one go about a security audit, any-
way? Simply put, it’s like we mentioned—know-
ing how your security solution should work,
and checking to see if that’s how its working.
It’s very important, then, to put your security
policy down on paper—which programs are
allowed to run on PCs, which users get access to
which resources on your network, and so on. 

Sh
ri

kr
is

hn
a

Pa
tk

ar

Think you've
secured your

office well? Time
to put your

money where
your mouth is

Nimish Chandiramani

If you’ve been following these pages closely
(and we hope you have), you’ll have noticed
that we’ve talked a lot about security—it’s a

huge concern for any organisation, and it’s
something that requires constant attention. If
you’ve been taking our advice then, you ought
to have an effective security solution in place
for your office. Or do you?

You see, implementing security solutions
and policies is only the first step. Every once in
a while, you need to verify that you’re security
solution is doing what it’s supposed to. Perhaps
more importantly, you also need to know
whether everyone in your team is following the
security policies you’ve so lovingly prepared.

Check-up Time
To ensure that everything’s all right with your
security arrangements, you need to conduct a
security audit. There’s no strict definition for

Looking 
For Trouble
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clients, and should be uninstalled. These pro-
grams run services that are prime targets for
malicious code, which usually hijacks the
service to wreak all sorts of havoc on your net-
work. And, of course, there’s the lack of pro-
ductivity that IM clients encourage so much. 

Bottom line: if you don’t need it for work, it
shouldn’t be installed.

Auditing The Network
Here’s where things get tricky. Network secu-
rity isn’t something you can learn very easily,
so you might have to spend a lot of time read-
ing up on the Internet, or solicit the help of
an expert. But first, let’s get the easy stuff
done with...

If you use the Squid proxy server to control
access to the Internet (and you should), you
can start with blocking social networking
sites, among others that could affect produc-
tivity. You can also block most popular banner
advertisement servers and replace the ads
with a message. 

Now comes the tricky part—scanning the
computers on your network for open ports.
Network Ports let PCs—more specifically, serv-
ices running on PCs—access the network and
the Internet, and also act as ways into your
PC. Usually, most ports on your PC are closed,
and don’t accept incoming connections. That
doesn’t really mean that open ports are an
invitation to hackers—they just accept incom-
ing requests for data. Running a port scan on
a PC (using a tool called nmap, which has
Windows-based GUIs too) gives you an idea of
which services are using which ports. You can
then go about disabling services that could
potentially be exploited—like those pesky IM
services. If you’ve been compromised before, a
port scan is essential, but if you’ve had no
security problems thus far, you could just
install firewall software on each PC and be
done with it.

Other Audits
You also need to check up on your backup solu-
tion—the frequency of backups, and so on, and
perhaps build some redundancy by storing
some critical data on an online backup solution
—just in case. 

Your e-mail server needs to have proper anti-
spam and anti-phishing measures built into it—
just one successful phishing attack can become
a slap in the face of all you’ve done so far. 

Failing An Audit
If you’re done with an audit and have passed
with flying colours, chances are you didn’t do it
right. Around 99 per cent of companies who
undergo a security audit fail, but it’s a part of
life. What you need to do now is start addressing

issues immediately. Based on your audit, you’ll
be able to figure out the probability of a scenario
more accurately, so you need to make your risk
assessment calculations with new values. Once
that’s done, you’ve got yourself a prioritised list
of the problems you should be attacking. 

With the laptop problem we saw before,
there’s plenty of potential for damage if it
were to get stolen or misplaced. To mitigate
this risk, encrypt the laptop’s hard disks. This
way, even if the laptop does fall into the wrong
hands, it’s virtually useless in them, and more
importantly, none of your data can be read.

The Aftermath
Once you’re finished with a security audit,
make sure you keep the results handy for your
next audit. The results of the audit will give you
enough food for thought, and will help you cor-
rect flaws in your security policy. Share an
overview of the audit with your team, so they
too can know what they can do to reduce your
risks. If you found a lot of critical flaws in this
audit, make sure you schedule a new audit as
soon as you’ve addressed these flaws. If this is
your first audit, schedule another one very
soon, and ensure that you’re auditing your
security at least thrice a year.

Finally—and we’ve mentioned this many
times in these pages—there is no substitute for
an informed and educated team. Therefore,
security shouldn’t be just your concern—it
should be everyone’s.

nimish.chandiramani@thinkdigit.com

nmap is the tool of choice
when it comes to scan-
ning PCs on your network
or open ports
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You see them everywhere. These horrid num-
bers and graphs that claim to say something,
but always in gibberish or double-Dutch.

From Google’s Zeitgeist to your company’s finance
department, and your personal Web site’s visitor
data to numbers thrown at you in advertising-sta-
tistics, they say, never lie. Take, for example, the
fact (so says The World Bank) that on average every
woman in India gives birth to 2.9 children in their
lifetime. What does 0.9 of a baby look like anyway?
Is that code for short people, or a baby that’s miss-
ing a toe? Anyway, jokes apart, we’re talking about
statistics here because we’re looking at all of us
Indian Internet users out there. What’s the most
popular browser? Which sites do we prefer to visit?
What does India do online? If you have such ques-
tions, we’re here to give you some answers, and a
little bit of insight.

When it comes to the Internet, it’s hard to
ignore what Alexa.com has to say. Although the list
changes often, depending on what’s hot at the
moment, we’re taking a snapshot
at the end of June to try and fig-
ure out what we’re doing online
as a country.

The Front Runners
The top three sites for Indians are
Google.co.in, Yahoo.com and
Google.com-weird because
Google figures twice in the top
three. Orkut India comes in a
close fourth, and solidifies its
position as India’s most popular
social networking site. YouTube
is fifth, and here we begin to
wonder. The average Net access
speeds that Indians get certainly
doesn’t justify a bandwidth
heavy site like YouTube being in
the top five. Of course, thanks to
the Mahatma and Munna Bhai,

maybe we’re just doing some Gandhi-giri with our
miserly Internet service providers and being more
patient while pages load. Although, whether we
need to start our own version of Satyagraha to get
more bandwidth without limits is another discus-
sion altogether.

Moving on, we find Blogger at 7, which means
we Indians are an expressive bunch. Rapidshare
rears its ugly head at 8, making all of us here at
Digit go “Ah! There it is!” Apparently, all our anti-
piracy articles haven’t really had too much of an
effect on the masses. And no, we don’t believe
you’re actually using RapidShare’s services to
upload and download “legal stuff”. Wikipedia at
10 is something we expected to see when we have
Google at 1 and 3, since most of the information
seekers that Google-up stuff, usually end up at
Wikipedia. Orkut.com at 12, just ahead of
Facebook just concretizes the fact that we love
Google products.

After Dark
After rank 15, we start getting into the darker alley-

ways of the Indian mind. So far
we’ve been seeing what most of
us Indians do when working-with
the exception of some social net-
working and YouTube-ing. Once
the sun sets, we Indians cease to
be G Rated, and end up scratch-
ing that itch. Coming in at 17 is a
site that’s notorious for adult-ori-
ented and quite illegal content-
XBoard.us. Between the next such
site, at 18 and 19, come IMDB and
CricInfo, which reinforces the
fact that we Indians love our
movies and cricket. Then at 20,
comes Debonairblog.com, which
is another adult site that special-
izes in MMS-scandals—need we say
more? Adult FriendFinder—are
there any “real” Indian profiles
on it?—finds itself at 24,
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An example of a typical post on DebonairBlog, where innocent
women are exploited while going about regular life, yet the site
stays afloat! 
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quite obvious that India is obsessed with adult
content. Even if you’re not addicted to it, you just
can’t seem to stop yourself from clicking on that
suggestive, naughty-looking link and getting an
eyeful. Although sites like YouPorn are on and off
the top 100 list, voyeurism, it seems, is the order of
the day. No one wants firangi porn any more, that’s
just boring… Indians would rather look for scan-
dals, and play peeping tom with other Indians.
Whether the poor state of sex education, our
repressive laws, the so called moral-police, or even
the media are responsible for causing this craving
for titillation is beyond the scope of this article.
The fact remains that it is true, because remem-
ber, statistics don’t lie.

Based on data from various torrent watchers,
the most popular file formats on the network are
AVI and MP3. And it’s not just the MPAA and RIAA
that we’re ripping off—because a lot of the content
being downloaded is made by the adult film indus-
try. More porn. Sigh!

When we compare this data to the rest of the
world, we find that the first adult site comes in at
rank 35, with the big guys (Google, Yahoo! and
Microsoft) ruling the roost. There’s also more in
terms of constructive usage, though, and sites like
Flickr, Craigslist, BBC, Adobe, DeviantArt, and more
actually featuring in the list. Obviously porn and

torrent sites feature too, but they don’t seem to be
too much of a priority for the rest of the world.

What Does It Mean?
With all that data being torrent-ed, and ISPs buck-
ling under massive amounts of data transfer, who
do you think suffers? If there’s one big reason why
you cannot spend all your free time on YouTube,
it’s the BitTorrent network! It’s gotten so bad that
ISPs, even in bandwidth heavens like the US and
Japan, are starting to impose data transfer limits on
their customers. So what makes you think that ISPs
here are ever going to let us click-happy Indians get
in on any of the 10 Mbps unlimited goodness?

As far as adult oriented content goes, what you
do in your home is your business. But if you start
clicking pictures of un-suspecting people, violat-
ing their privacy and sharing the pictures in order
to become popular on a stupid forum… you’ve just
digressed to a lower life form. Sadly, the Internet
has become just another Window to peep through
and satiate our various fetishes. Hopefully, this is
all just a phase, and we will all outgrow this crim-
inal behaviour. Until then, we’re going to have to
make do with bandwidth limitations, and protect
our loved ones from voyeurs. We can all start with
leading by example…

agent001@thinkdigit.com
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reinforcing the fact that
we’re probably using the
Net to vent repressed frus-
trations.

After that, we have a
lot of scattered “porn
sites” (for lack of a better
way of categorising them)
in the top 100. You have
PicsCrazy at 50 (popular
for hosting adult still
images that are linked to

from forums like
XBoard.us), Savita Bhabi at

59, Indian Sex Stories at 64, YourFileHost at 70, and
Free Sexy Indian forum at 84. 

Torrents Of Data
Mininova.org and Torrentz.com are the top Bit
Torrent sites at 29 and 33, respectively. Though
The Pirate Bay is also popular, it’s a distant third
at 51, with ISOHunt fourth at 60. What this means
is that although the majority of bandwidth is
used up torrenting, this is not so for us Indians.
Again, this is an expected phenomenon because of
the scarcity of broadband connections, and
absolutely no unlimited broadband schemes worth
talking about.

Save The Best For Last
IRCTC.co.in (used to book rail tickets online) is at
25, and this tells us that the Government hit the
jackpot with that site at least. The Indian Railways
site at 30 is the next government site in the list, so
other government agencies should take a leaf out
of the railways’ book to start offering more impor-
tant e-services. Understandably, Microsoft.com
comes in at 14, because we all use their products—
paid for or otherwise. Naukri.com at 15, Monster
India at 23 and Times Jobs at 38, are interesting,
because that tells us that most of us Indians seem
to always be on the lookout for bigger and better
opportunities—as we should be! 

ICICI Bank is the most popular online, ranked
at 32, followed by HDFC at 40. Download.com is
our preferred software source at 36, and Reliance
makes its presence felt with broadband services at
45 and Zapak at 39. BSNL comes in at 48, and
rounds up all the noteworthy sites. You can of
course check for changes in the pecking order at
Alexa, to keep yourself abreast of the changes.

What Does It Mean?
Now that we’re done with telling you what ranks
where, let’s try and make some sense out of the
madness that is the Internet. For one thing, we’ve
been following the list for some time now, and it’s

IRCTC is the railways pride and joy, and is the
most popular government site on the list
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Team Ninja is at it once again with
the sequel to arguably the best
action game on the old Xbox

system, promising to deliver fast paced
action that’ll test your reflexes to the
limits and perhaps result in numerous
shattered controllers (and egos) across
the world. The player will get to reprise
the role of the young but ruthless ninja
named Ryu Hayabusa—the last
descendant of the dragon lineage and
son of Joe Hayabusa, from the original
Ninja Gaiden games. 

Fans of the series will not find too
many new elements in the game,
especially if you have played Ninja
Gaiden Sigma on the PlayStation 3. To
help Ryu fend off the fiends, there are
three classes of weapons—melee,
ranged and nimpo (magic)—with
bracelets being dropped out this time.
There are weapons that do slashing,
piercing or bludgeoning damage, and
each of them can be upgraded to
increase their power and unlock more
devastating combos... And it is here
where I think the game really shines.
The animation (and decapitation) in the

game are a joy to watch, and to the
spectator, the game may look like an
ordinary button-masher. However, the
one behind the controller knows that
what one sees on the screen is carefully
thought out sequence of combos,
counter attacks and ultimate
techniques. As some of you may already
know, this game can be pretty
unforgiving when it comes to mistakes
as hordes of enemies are rallied against
you. To make matters worse, the
camera control system has not seen any
improvements and this can be very
frustrating at times. 

However, to make the game more
accessible, the developers have tweaked
some of the game elements. The most
notable change is the healing system,

where after an encounter you may find
some of your health restored. Also,
there are several save points scattered
throughout the game and they have an
added benefit of completely refilling
your health bar the first time you use

one. Ranged weapons, especially the
bow have been reworked making it more
useful in combat, and not just useful for
solving puzzles. 

For those of you who look for a deep
story line in every game, will be sorely
disappointed. The plot of the game and
its characters are inconsequential and
the only thing that matters is killing
everything that moves till there are
none left. The fun of the game lies in
felling your opponents in the most
stylish and gruesome way to rack up
Karma points and aspire to see your
name high up on the XBL leader boards.
This does not mean the game is shallow
and unfulfilling—it's just that combat
mechanics more than make up for the
lack of depth and sense in the game plot.

Additionally, there are a few un-lockable
things, like costumes, difficulty levels
and challenges, enough to keep you
engaged for days and even months.

After all is said and done, we would
say this is one of those games that
you'd either absolutely love and never
set it down till you've mastered every
bit of it or you'll throw the game away
in one of those boxes labeled ‘oh, why
did I ever buy this', never to set eyes on
it again.  The game may seem very
daunting at first; however after you've
got the hang of it, you'll rarely find a
game with more fulfilling combat
system. What you may need though, is
the persistence and resilience of a true
Ninja to pull this one off. 

agent001@thinkdigit.com

Ninja Gaiden II
Rating: 7/10

Developer: Team Ninja/Tecmo
Publisher:

Microsoft Game Studios
Distributor: Redington
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Most of us were introduced to Conan
the Barbarian through the ridicu-
lously cool Arnold Schwarzenegger

flick, released in 1982. The movie is famous
more for its over-the-top dialogues than
its action (which is amazing in its own
right), and lets not forget its soundtrack—
one of the finest to come out of cinema.

But Conan is older than the movie,
older than most of us. The character was
created by Robert E. Howard back in the
1930s as an amalgamation of “the dom-
inant characteristics of various prize-
fighters, gunmen, bootleggers, oil field
bullies, gamblers, and honest workmen
I had come in contact with”. Here we are
then, almost 80 years later with an
MMORPG set in the lands and characters
created by Robert E. Howard.

Age of Conan (AoC) is a barbaric game,
much like the world and the character that
it draws from. It is ruthless in its system
requirements, unforgiving with its bugs,
alluring with its splendid vistas, sprawling
cities and naked women (yes, the game
has nudity), and is thoroughly captivating.
Fittingly perhaps, it is the game’s combat
engine which will grab you by the throat
and keep you enthralled. AoC’s combat
elevates the morbid boredom inherent in
MMORPG-combat to a level of sheer fun
and visceral delight. Heads will roll and
you will love the game for it.

The combat engine is the best part
about the game. The first innovation it
introduces is the concept of combos—
much like in a game such as God of War—
where you are asked to hit keys in a
certain order to execute amazing moves
and feats. This immediately connects you
to the character and acts as a glue which

marries your skills as the person behind
the keyboard to the performance of your
on-screen persona. Combat now isn’t just
about knowing the numbers that go
behind an MMORPG and playing to your
character’s strength; it is also directly
affected by how well you execute to your
potential. This added layer upon the tra-
ditional MMORPG combat system goes a
long way to making the experience so
much more satisfying and immediate. 

Much like combo systems in other
games, you are rewarded for successfully
completing combos, or for chaining
combos, or for picking the right combo
for the situation. Successful combos do
more damage than regular combat,
goading you to make more use of the fea-
ture. Spamming of the combos is avoided
by use of a stamina system—the more
devastating the combo, the more
stamina it takes, pacing yourself is thus
essential as well. The ultimate reward
though is the fatality system that suc-
cessful combos have a chance to trigger.
While the combat keeps you glued behind
the monitor, punching keys away, the
fatalities will get your blood pumping
and will often have you shouting mani-
cally at the butchering you have just
wrought. Much like Mortal Kombat, fatal-
ities in AoC are over-the-top: thrust your
broadsword into the opponents eyes,
chop off his limbs and then his head, cut
him into two, bash his skull in using your
club, cut his throat and hear him gurgle
in pain, and so on. It’s brutal stuff,
accompanied by painful screams, chop-
ping sounds and satisfying animations.
AoC is rated Mature, not just for its vio-
lence but also for the nudity and lan-
guage that it often parades bravely and
perhaps for some, unnecessarily. 

The beauty of the game though is that
nothing seems out of place, not even the
violence. The world created almost seems
to demand the blood and the guts. The art
direction is brilliant and consistent, with
splendid architecture and grand level
design, as is the detailed character creation
tool. Very rarely will you come across
another player that looks like you, or even
similar to you—the options here are as deep
as those used in single player RPGs such as
Morrowind. Adding to the visual appeal and
world immersion is the use of mounts: you
can choose from a war rhino, a mammoth
and various types of horses when you hit
level 40 (the level cap is at 80). And yes,
the game has mounted combat. Some
mounts will allow you to swing your sword
as you gallop through your enemies, while
others will acts as weapons themselves.
There is nothing as satisfying as swaying
through throngs of people in a teeming city,
mounted on your very own mammoth. The
game also adds player-versus-player
combat, with the added layer of guild-
versus-guild combat. Guild-versus-guild
leverages upon the guild-cities that you can
build along with your friends, which allow
you to take part in unique quests, unlock
guild achievements and manufacture siege
weapons to bring down rival guilds! The

depth and quality of combat in AoC will
constantly delight you.

Locales vary from sprawling capital
cities to corpse-ridden battlefields, to pyr-
amids sitting on desert sands, to swamps.
Set against such a backdrop, it comes as
little surprise when your character lops
off a head, or cuts someone up in two—it
all fits. AoC is a great package tied up
together nicely with a musical score that
does the aforementioned movie proud…
the game is almost perfect.

Where it succeeds, it succeeds mag-
nificently, but the game also falters, and
when it fails, it does so with equal
grandeur, no half-measures here. The
game is quite buggy, and has obviously
been released a few months before it
should have been. Forgive its high system
requirements (you will need an 8800GT-
class card if you want to play it with all
bells and whistles, even so, it can run at
a low frame-rate inside some packed
cities), but you can hardly forgive its fre-
quent crashes, or its gameplay bugs—
which include the most fundamental
oversights such as strength and dexterity

not having any effect on combat! To be
fair to the game though, most of the prob-
lems mentioned have happened to “other
people”, our experience with this title has
been headache-free, barring the occa-
sional crash. Also to note is that the
developers, Funcom, are on top of the
problems for the most part. They might
not be very active on the community
forums, but they are keeping a healthy
and needed, two-patch per week
schedule. These patches not only fix
issues but also add new content such as
new quests, and new armour sets.

Ultimately, as with all MMORPG
titles, it comes down to this: is it worth
spending the monthly cash? Our sugges-
tion would be to pick up the title and play
the game for the first free month—if you
have bad experience with its bugs, drop
out, otherwise continue to play, what is
an amazing title to hit the MMO scene.

If you do decide to get in, ping this
author and we can perhaps quest
together: character name of Harami, a
Barbarian on the non-PvP UK server
Crom. See you in Hyboria!

agent001@thinkdigit.com

Heads Will
ROLL!

Score: 8/10
Developer: Funcom

Publisher: Eidos Interactive
Distributor: NA

What do I know of cultured ways,
The gilt, the craft and the lie?

I, who was born in a naked land
And bred in the open sky.

The subtle tongue, the sophist guile,
They fail when the broadswords sing;

Rush in and die, dogs
I was a man before I was a king

The Phoenix on the Sword
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Agent 001

Check this—I get out of my room, grab
my HellFury bike and head out for a
spin. Thought I’d like to really test

the power of this machine so I head out to
the airport runways for a test drive. Just
then the men in blue make an appearance
to spoil the fun. My outing pisses them off
so much that they come down on me guns
blazing, with their armored vehicles,
motorboats and even a helicopter. I give
them quite the run for a while. However,
I get overwhelmed by the firepower of
this city’s finest and the only way out
looks like the blue skies. So I ditch my
bike, grab the nearest helicopter and take
off. But the persistence of the lawmen
force me to ditch the chopper on the
subway tracks, jump the fence, carjack an
SUV and make a final attempt at freedom.
Alas, this spirit is strong but the body
finally gives way to the constant fire and
I fall dead—to wake up at the nearest hos-
pital in perfect health and only a few
bucks short in my pocket!

If this is your idea of fun, then head to
your nearest peddler of good times, grab a
copy of GTA IV and join me in Liberty City.
The mother of all action-based sandbox

style game, Grand Theft Auto is back again
with a story to tell of a yet another guy and
his ‘ascent’ into the criminal under belly of
the city. This time around, the protagonist
is an eastern-European war veteran who’s
been lured to the city of dreams by his
cousin, only to inevitably find out that it’s
not going to as easy as it seemed. 

Rockstar North has once again stuck
to what they do best and as they’ve done
with this series in the past, they’ve simply
added a few layers complexities over what
essentially remains a typical GTA game.
You start off a shady apartment in less-
than-affluent neighbourhood as you
realise that your cousin Roman hasn’t
exactly been accurate with his story. All is
not lost though, as the world of near lim-
itless possibilities lies outside your broken
window. As you soon find out, there are a
myriad ways of fattening your wallet in
Liberty City—from carjacking and drug
dealing to carrying out a hit on a rival
gang member.  If you are looking for some-
thing less violent (sigh!) you can earn cash
by driving the denizens of the city to their
destination. Liberty City also offers its fair
share of distractions—just call-up one of
your buddies and head to the nearest bar,
strip club or watch a Russian cabaret show
or take your girlfriend out on a date to a

neighborhood diner for a warm and cosy
meal. Who knows, if you play your cards
right, she might even invite you in for the
proverbial ‘coffee’.

The beloved radio stations retain their
charm and humor and play critic to the
decadence of modern society with issues
like global warming, ‘war on terror’, prop-
aganda through media and the old chest
nut called obesity. Significant changes have
been made to the combat system with an
improved aiming system and the ability to
duck and take cover. What hasn’t changed,
however, is the save system, much to the
dismay of gamers like me. If you fail the
mission for one reason of the other, the
game forces you to start all over gain,
which can be pretty annoying in the long
missions. In an apparent attempt to make
the game play more solid, the developers
have reduced some of the options available
in the previous GTA titles, like rigging a car
with a bomb, prior to undertaking a mis-
sion. All in all though, the game feels much
tighter and more fulfilling than the pre-
vious iterations. To those of who are unini-
tiated to the world of GTA, this game comes
highly recommended. I mean where else
will you find a bunch of police car chasing
after another police car?

agent001@thinkdigit.com

Grand Theft Awesome
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Score: 9/10
Developer:

Rockstar North
Publisher:

Take 2/Rockstar
Distributor: e-Xpress
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Michael Browne

D
esigning games for a console and
porting them to a PC hasn’t been
much of a success. Mass Effect was

birthed as an X360-only title developed
by hallowed RPG demigods BioWare.
The merits as well as shortcomings of
the console version are the prime bina-
ries behind this port, and I feel the PC
version is better!

The success behind Mass Effect across
platforms, lies in the epic proportions

of its plot, and the way the story
unwinds as you play. From your rise
from a mere grunt in the armies of the
Human Alliance Military to Commander
Shepard (you can’t change your surname
in the character customisation!), and
the acquisition of Spectre status, to the
commanding of your very own state-of-
the-art vessel the Normandy, the promise
of a juicy plot rife with surprises and
ripe with opportunity is just too good
to pass up.

Here’s a plot summary—Several hun-
dred years in the future, mankind has

discovered alien technology on Mars
that open up possibilities of interstellar
travel. We humans are the youngest
members of the Galactic Council, a UN-
like organisation populated by dozens of
other more advanced alien species. Per-
ceived as ambitious upstarts, humani-
ties first great achievement as a member
of the council is your admission into the
spectres, a highly elite group of individ-
uals who operate independently, and
often outside the bounds of the law, to
protect the council’s interests. When a
spectre named Sarin goes rogue,

The Stars Hold All The Answers
Mute Testament To Mankinds Foray Into The Unknown...
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destroying a peaceful colony of humans
on Eden Prime, you’re tasked with
bringing him to justice. What starts as a
routine capture mission soon becomes
a lot more as you and Sarin indulge in a
game of hide and seek spanning the
Milky Way. As the pursuit heats up you
will gradually discover he’s got some-
thing more than hatred for your species
up his sleeve. Your elusive quarry will
lead you to alien worlds which you will
explore often getting side missions from

other characters you encounter.
Throughout the game Sarin’s allies will
challenge you to high-tech firefights.
Your aim besides his capture now being
to aid hapless innocents left in his wake,
and to discover why is Sarin intent on
bringing back the Reapers—a mechanical
race that wiped out the Protheans, (a pow-
erful, technologically advanced civilisa-
tion), some 50,000 years ago, only to
vanish into the mists of time.

Being a BioWare game, there’s a
strong character development system in
place, and varied classes to choose from.
You will also be joined on your travails
across space with a team, consisting of a
bunch of followers. Each of these charac-
ters have quirks and attitudes as different
as night from day. The good VS evil judge-
ment call is omnipresent, and underlies

everything you do. Will you be a ruthless
renegade, or a benevolent paragon? Your
attitude with innocents you come across
throughout the game will not only affect
your character but also affect your team
mates’ attitudes towards you. Mass Effect
offers a plethora of exploration opportu-
nities and perennial background quests
like discovering mineral resources, or
unearthing artefacts will have you
scouring planets on foot or via Mako, your
own six-wheel, all-terrain buggy. The

nature of the story and quests are such
that you’ll find yourself thoroughly
engaged throughout your gaming session.

Improved from the X360 version
are better character controls, a quick
slot toolbar that you can add and drag
special abilities (yep...you get those!) to,
and a new tactical combat interface
from where you can give quick orders
to your team. The controls work beau-
tifully. In fact, so beautifully that you
will sometimes forget that this is an
RPG, where your character stats matter
more than the accuracy of your tar-
geting reticule, and actually play like

a third person shooter. The PC version
also seems a little easier to play than
the X360 version, but this could well
be due to my preference of the PC con-
trols and the ease of access of many of
the in-game options.

Your weapons range from space-age
assault rifles, shotguns, sniper rifles and
sidearms to biotic and tech powers.
These powers are even more impressive,
letting you toss enemies into the air,
hurl them at walls and let the law of

momentum do its job. The intricate
weapon and armour upgrade system lets
you slot upgrades into virtually every
weapon, including grenades.

The graphics aren’t superb, but
they’re not bad at all. The big plus being
this game won’t kill your system, and a
fair amount of eye-candy is available to
even modest setups. One minus point is
that any [Alt] + [Tab]-like action
crashes the game—look for patches.

You know you’ve come across some-
thing exceptional when this is one of the
only complaints you can come up with.
Another is the repetitiveness of the explo-
ration system. And that’s it. Mass Effect is
absolutely superb. An adventure ride
nobody ought to miss.

michael.browne@thinkdigit.com
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Rating: 9.5/10
Developer: BioWare and Demiurge

Developer: EA Games

Stop bugging me you lousy mosquito! Ah! Got the irritating sucker...

Geth in my way? Polonium rounds will
turn you into green goo boy...

The man...the machine. You posing beside
your ride - Mako

The Stats screen, typically BioWare replete
with customisation options

The Milky Way, your playground for the
next 30 hours or so...
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there will not be any
degradation in service and
all features would be
supported in the German
version of Gmail. 

That should give the
Germans some consolation,
after they have gotten used
to the new URL.

STEAL ALL

I Kid You Not

W ith all the heat
and dust over
illegal filesharing

issue people would expect
musicians to zealously guard
their share of royalties and
milk each and every compact
disc for all its worth. There
have been notable
exceptions, with bands like
Nine Inch Nails and artists
like Radiohead giving away
music for free. However Kid
Rock has gone into entirely
different territory by
recommending fans that
they steal his music!

In a “public service
announcement” that was
posted to YouTube (you can

watch it here:
http://tinyurl.com/59ofda in
case you are interested) by
Kid Rock he announced that
since he was so stinking rich
it didn’t matter if people
illegally downloaded his
songs. He probably
gladdened the hearts of
anarchists and anti
establishment types when he
said that big corporations
were evil. His advice to
viewers was to steal anything
that caught their fancy. From
laptops to iPods to cars to oil,
everything was fair game.
His contention is that since
big corporations were sitting
on billions of dollars of cash
they would not miss the one
or two missing items on
their inventory. Bill Gates
and Steve Jobs were
particularly picked on as
people to target, on account
of their vast “fortunes”.  

Kid Rock, unlike many
artists doesn’t sell his music
on iTunes as he feels the
system is biased against the
artists. The rap rocker also
says that the Internet is a
way to settle scores with

record companies who have
been ripping off both
performers and customers
with ridiculous prices. 

While most people would
dismiss the video as
harmless comedy there is a
danger that some idiots
might really believe what
their idol said and attempt a
spree of shopliftings and car-
jackings across the world. We
hope that Kid Rock has a
plan in hand when these
luckless sods are chucked
into the penitentiary. 

ENGLISH LESSONS

Fun With
Nintendo

Now your parents
won’t crib any more
when they see you

glued to the addictive hand-
held gaming console:
Nitendo DS or popularly
abbreviated as NDS or simply
DS. As the doctor always
ordered, fun and games
should always be a proper
decoction and it’s not long
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In the world of business,
names are everything,
especially trademarks.

Companies go through a lot
of trouble to safeguard their
identity from unscrupulous
operators who want to
piggyback on the hard
earned reputation.
However in this case the
tables were turned, with
a small time guy taking
successfully on the giant
search giant Google.

If you are a German,
or was passing through
Germany these days you
would not be able to
access Gmail by typing
www.gmail.com. Instead of
having to type in their
user name and password,
users were greeted by a
message that apologised
for not letting users to
log in and check their

mail the usual way. No
hackers had broken into the
homepage, in case fearful
and cautious users were
pressing alarm bells. The
apparent disfigurement was
done by Google, that

recommended users to use
www.mail.google.com. Here
also, Google had no right to
link to the Gmail page and
the hapless users were forced
to copy-paste the URL into
the address bar to access
their mails.

Google had a long
standing feud with a local
venture capitalist named

Daniel Giersch, who owns
the trademark to a paid e-
mail service called GMail.
This was registered years
before Google dreamed
up the name for its e-mail
service, so nobody could
accuse him of being a
copycat. Google had
already lost the case that
Giersch had brought
against it and was fined
for illegally using a
trademark. 

Google has no plans
on what steps it will take
in the future to resolve
this unsightly mess.
However, it has said that

File sharing and P2P may
be pretty common now,
but back in the day when
Napster was launched, the
idea was pretty
revolutionary. 

Born in 1980, Fanning
was a computer freshman
student at Northeastern

University, when he
conceived the idea of
Napster. By his own
admission Napster’s
inspiration came from his
dorm mate who had
trouble finding MP3s of
his favourite songs on
different Web sites. The
program consisted of two
parts: server and client,
with the server containing
indexed list of files
available for sharing by
users. Napster went prime
time in 1999. 

The file sharing service
was free and news spread
by word of mouth to
become a huge hit. In a
short time Napster grew to
a user-base of millions of
people, with hundreds of
thousands simultaneously
using the service. 

Later, Fanning
founded a company that
focussed on the
distribution of legal
music called Snocap.
However the company was
not a success and was
bought by imeem. 

No Winner!
Better luck next time!

People Who
Changed

Computing

Power of Touch
The popularity of the iPhone has provided impetus to an entirely
new breed of pornography—one that is optimised for iPhones.
The Web sites that host smut are made looking at the touch
screen capability of the device. And with the 3G iPhone hitting
the shelves, the scene seems to get more steamier.

NAME GAME

Mail Without G

Shawn Fanning

My Desktop

Whatever 
Happened To…

Second Life

Avirtual world might be
a dream come true for
many people.  

Second Life is still very
active today. The claims of
its popularity are still highly
doubtful. There was a
sudden influx of companies
starting up their online
stores on Second Life, but
there are some that have
started turning their backs
to them. Pontiac and Wells
Fargo are just some of these
companies. AOL too left, but
it hasn’t given up on the
idea of marketing and
economics in a virtual
world. It decided to join a
Second Life competitor—
www.there.com. There were
even incidences of
properties being bought and
sold. Virtual real estate
prices came crashing down.

A parallel universe is the
MMORPG market, where the
younger audience prefers to
play with others. Besides,
many have found Second
Life to be a very harrowing
experience. In India,
anyway, staying online
continuously on a fast
connection is quite difficult. 

Another major concern
is the kind of prohibited
content that is posted, and
the happenings in the
virtual world. To tackle this
problem, users under the
age of 18 prohibited from
joining. Today, most of
Second Life’s income comes
from the larger companies,
rather than the low paid
user group. 

We wonder if Second
Life will shut shop soon.

Size Does Matter
Some Age of Conan players were in for a rude shock of
sorts when their female character’s bust sizes decreased
from buxom to run of the mill. Due to the public outcry that
followed, the games developers announced that they were
working on a fix to restore the sizes to the previous
dimensions

The age of the Terabyte!

WIN!
Send in your entry and you could win an exciting gift by
sharing an amusing picture with a tech angle to it. The
picture should have been shot by you, and should not have
been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line,
mentioning your postal address, oonn oorr bbeeffoorree tthhee 2200tthh ooff
tthhiiss mmoonntthh to digipick@thinkdigit.com. One prize-
winning picture will be published each month.

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

.net Interview 
Questions
by Nagaraju B

Published by

Participate and 
win next month:
The Essential Guide to User
Interface Design
by Wilbert O. Galitz

Published by

Last month’s winner:
Jerin Pallipeedikayil
Kerala

Shawn Fanning

n Man auctions his soul on Ebay, another auctions life: disappointed by low prices n  Google hires corporate concierge to pamper staff n Texas law requires private investigator license to repair computers n  14 year boy breaks into house and orders $100 of pay per view porn
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contain inaccurate or
deliberately misleading
information and there is no
second thought (was there
ever a first thought in place?)
before implementing copy-
paste and proposing it as
their own work. 

Eleanor Coner, the SPTC’s
information officer,
acknowledges that Internet
plagiarism is a problem.
Pupils seem to believe that
they won’t be caught.
However the Scottish
Qualifications Authority has
robust ways of checking for
plagiarism and parents are
worried their children will
fail their exams. 

Amassing information
online is no-brain task now,
but what is more important
is to develop the skill of
challenging what was
presented as ‘fact’. It is a skill
that has to be learnt, and
which many internet users
won’t have. Next time you
thing of using Google or
Wikipedia or for that matter
any online resource, think of
the authenticity before
relying. Or better go back to
libraries and surf the pages! 

JOGGER POWER

Power
Dancing

Imagine this—You are in
the middle of a very
important call, and your

mobile battery is about to
run out juice. Worse still,
there is no charging socket
around. Well, no need to
pull your hair out anymore,
just tap your toes and talk
through. Thanks to a new
gizmo, you now just need to
face the music and dance.
Quite a perfect way to
charge up your device.

Mobile phone operator
Orange said on Tuesday it
had teamed up with
GotWind, a firm
specialising in renewable
energy, to produce a
recharger powered by
movements alone. This is a
good excuse for toe-tappers
to dance their way through
the streets to build up juice
for their cellphones.

The device is very
portable and can be just
worn like an armband. It
employs a weight and
magnet to harness kinetic
energy and covert it into an
electric current to top up
charge in a storage battery. 

The product is fun,
engaging and interactive that
would encourage users to
have a laugh while charging
their mobile phone and at
the same time test out a new
energy-efficient prototype in
these ecologically conscious
times believes Hattie Magee,
Head of Partnerships at
Orange UK. 

Now don’t be surprised to
have free dance shows on
our streets, restaurants and
almost anywhere! 

In the meantime,
researchers have now
focussed their attention on
the female breast motion.
When a woman jogs, the
three dimensional
movement of her “assets” is
thought to generate
sufficient energy to power
an iPod or a mobile phone.
Though there are some
issues like size and the
quality of fabric covering the
chest, the intrepid scientists
believe that a solution will
soon be available. We wait,
with bated breath for this
innovation that will lead the
world nearer to eco
friendliness.

All Swell, That End Swell
A month of sickness again:
Vijay’s swollen belly was
replaced with swollen feet;
Rossi got swollen fingers
from the Fast Track; Michael
has a permanent swollen
head; Nash had swollen
eyes from issue closing; and
our mailboxes were swollen
with contest entries—too
many thousands
to count...

Uncle Chandiramani’s
university application
finally came through, and
he’s off to Amreeca for
further studies. At least
there will be more food for
us now, but one less person
to frag in Quake 3. He
promises to come back after
his degree—providing he can

come back as
Raaabo’s boss!

akshayy
http://tinyurl.com/6m793j
http://www.akshayy.com/sonyericsson/others/v
ideo-encoding/

Video encoding
This is not really a flashing subject, though many
people would like to know how to do it. So convert
your SE phone to a media center where you can
watch movies!! Or at least watch video clips.

The application I suggest using has the
slogan “does for FREE what other encoders
CAN’T do for money”. It’s worth a try.

It is SUPER Simplified Universal Player
Encoder & Renderer, the best you can find. A
very nice application, with very frequent
updates. That is the main reason why I’m not
uploading it to the download site….go to this
site: http://www.erightsoft.net/SUPER.html.Then
Scroll down to the bottom where you can see
this link “Start Downloading SUPER ©”……

Sony Ericsson phones support 3GP and MP4
formats, camera records in 3GP. So choose 3gp
(Sony Ericsson) as Output Container at the top.

According to my tests, Video Codec should be
MPEG-4, and Audio Codec should be AAC. These
are compatible with SE video player.

Binoy Xavier Joy
http://tinyurl.com/5o9ppa
http://tec-talkz.blogspot.com/2008/07/
google-adsense-referrals-retiring.html

Google withdraws Adsense Referrals
Earlier today, Google launched an affiliate ad
network. Or, rather, it rebranded Performics,
the affiliate ad network that came along with
its purchase of DoubleClick, as the “Google
Affiliate Network.” As with other affiliate
networks such as Amazon’s, participating
Website publishers get paid a fee for each
referral that results in a sale. Existing
advertisers include Bank of America, Barnes &
Noble, Citi, Target, and Verizon.

Google is also insisting you to update your
Adsense account to Google account as a
compulsory step…

Pointless Web
Zillions of new Web pages

crop up and crowd the filled-
to-the-brim beaker of the
World Wide Web. 

In case you were curious
to skim the dregs of the
Internet barrel, you’ll find the
most obnoxious sites at
www.pointlesssites.com. Just
skim through the numerous
pointless sites that are
frequently featured here.

It lists only pointless and
useless sites that don’t have
pop-up ads or too many ads in
general. They are original,
useless, are not offensive and
most of all make you smile—
family friendly fun! Well, we
hope that you smile. The
homepage rakes up the

newest pointless sites that
pop up and allow you to be
updated with all the latest
crap happening around in the
World Wide Web.

You are likely to waste
more time here that ever...
don’t sue us for that though.

No More Monday Blues
You think you have a heavy
workload? Try working 16
hour days, 7 days a week, in a
poorly ventilated ambience?
Hours of daily commute?
Difficult co-workers? Poor
pay? Well hold on, there must
be an end to this. Alas, Your
job isn’t as bad as you think.
Not completely crap; not yet!
You always hear about
people with jobs worse than

yours, but where are these
people? At www.worst-jobs.
com, that’s where!

This site is meant to make
you sigh with relief, after you
find out that no matter how
awful your boss is, at least he
doesn’t chop off your head
when you do something
wrong. Nor does he ask you to
wade through the sewers,
handle entrails and excreta,
or stick your arm into the
warm, cavernous bowels of
large farm animals.

If your job is crappier,
more dangerous or more
poorly paid than the ones
listed in there, let them know
and you could win the Worst
Jobs Trophy—which is given
away at regular intervals.

before the Joshi Gakuen all-
girls junior high school in
Tokyo realised this. 

Imagine this: a giggly
gaggle of 32 seventh-graders
merrily glued to their DS
with the teacher
applauding! The students
are now on a fun-learning
course with the novel idea
of using the popularity of
the handheld console to
learn basic English lessons.
The enthusiastic students
gleefully engage themselves
in spelling words like
“hamburger” and “cola” on
the touch panel screen of
DS following an electronic
voice from the machine.
Judging from the popularity
it seems the DS will make
has made a breakthrough
entry into classrooms. 

Japanese education has
long been infamous for
failing to develop English
conversation skills and
instead focus on rote
memorization and
grammar. However,
Yasuhiro Yamamoto,
manager at software maker
Paon Corp. believed that it
is time to bring in some
element of fun in to
learning and came out with
the DS English program. 

With it, learning
grammar and spelling had
never been so much fun.
When the students got the
spelling right, the word
“good” popped up on the
screen, and the student
went on to the next
exercise. The first five
students to complete the
drills were awarded
colourful stickers.

While the students have
given an enthusiastic
thumbs up to the new
experiment Principal Tsuneo
Saneyoshi revealed that the
initiative is still in its trial
stages and have received
mixed response from the
teachers. The school is
getting 40 DS machines and
free software for agreeing to
be part of a test in a real
classroom.

WIKI TRAP

Research In
Ignorance

W hat does the
Internet
generation do

when they need to find
something out? Like
something for a research

project or an examination.
Going to the libraries and
reading through zillions of
pages of voluminous text in
black and white—naah that’s
for the ancients. For students
and other folks in search of
knowledge it’s so very simple
to find out what they want:
Wikipedia. However they
would be advised not to
jump their guns
immediately, because there
is some disconcerting news.
Wikipedia might make you
fail the exams. 

Boasting over two million
articles, Wikipedia is used by
about 6 per cent of internet
users, significantly more
than the traffic to more
authorised sites. However, it
isn’t the most reliable one
owing to the fact that it
allows entries to be logged or
updated by anyone and is not
verified by researchers, as the
main source of information. 

The Scottish Parent
Teacher Council (SPTC) has
rather surprisingly blamed
such Web sites for the falling
passing rates in the state.
(We believe those students
need to get back to the
‘Paathshala way’). Students
rely on Web sites and other
Internet resources that may
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Linux
Mount point: In Unix-like
operating systems,
directories and devices are
organised in the form of a
directory tree. Each file is
logically attached to the
preceding file by a mount
point, while the entire OS is
mounted on /. 
Grub: Acronym for GRand
Unified Bootloader. Grub lets
users choose OSes, in case of
a multi-booted computer.
CLI: Command Line Interface
is the original method of
interacting with the OS,
before point-click and drag-
drop became ubiquitous.
Users typed in various
English-like words to perform
actions like copying, creating
and deleting directories and
running programs.
Root: As root, you have
ultimate administrative
privileges in Linux. The root
user can install software,
delete system files, and if
necessary, crash the OS with
a few well chosen clicks or
commands. 
Shell scripts: Shell scripts are
small snippets of code that
can be typed in CLI, to
perform simple and
complicated system related
tasks like searching and
sorting, finding out patterns
in data and so on. The scripts
are written in a distinctive
programming language.
Swap space: The swap space
in Linux is used in a way
similar to virtual memory on
Windows.
Usage: I had insufficient
swap space, so I logged in as
root and used the CLI to type
out a shell script and
increased it. I also changed
the default OS in Grub and
changed the mount point of
my external hard drive.

Wild Wild Web

n Chinese soldiers morals corrupted by karoake, according to officials  n  IE bug can lead to strange search results spewing porn n Solar Technology used to roast chickens in Thailand n Windows Vista Bonus introduced by Dell, the bonus being Windows XP

Featured here you will
find snippets from
some of the best
bloggers who have
registered at the Blog
Watch section on
thinkdigit.com.

If you wish to be
featured here, head to
www.thinkdigit.com/blo
gger.php and
sign-up.
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What is BREW?
a) A brand of coffee

b) A technology used in the air
interface of mobile phones
c) The name of a software
d) The next Windows version

What’s so special about Andy
Bechtolsheim?

a) Developed Linux as known today
b) Fastest typist in the world
c) He provided the initial
investment to fund Google
d) Nothing special about him

What is Jerry and
David’s guide to the

World Wide Web?
a) Present day Yahoo!
b) A digitised version of the famous
Tom and Jerry animation series
c) A new book on the Internet
d) An online tutorial of the Web

What did William
Higinbotham invent?

a) We just made up this one

b) First official video game—Tennis
c) The first hacking utililty
d) A company that develops
antiviruses

Who is Jon Stephenson von
Tetzchner? 

a) The real name of Jon Bon Jovi
b) The head of Opera Software
c) Head of Microsoft’s intelligence
department
d) Head of Google Norway

What is Avahan? 
a) Indian initiative of the

Bill and Melinda Gates
foundation for HIV/AIDS
prevention
b) Vernacular Indian software
c) Indian Font
d) An early warning system 

How is Blue Origin linked to
Amazon?

a) A brand of liqour sold on
Amazon
b) Both are companies founded by
the same person
c) The old name of Amazon
d) Both are rivals

Which common product is
used in Audi, Chevrolet,

Ferrari, Honda, Hummer,

Maserati, Maybach, Mercedes,
Nissan and Porsche cars?
a) They all officially use Bose for
their audio solutions
b) They use the same tyres
c) They use Intel processors 
d) They all use software developed
by Infosys

Who or what is Gunpei Yokoi?
a) He made a weapon

b) Inventor of the Nintendo
Gameboy
c) Luxury television brand in Japan
d) A popular technical university in
Japan
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ACROSS
1. Small computer programs that are automatically copied
on to a computer when you look at a document (7)
7. Computer interfaces to which you connect  devices (5)
8. Put in a systematic order (7)
9. -------ID-device for identifying incoming numbers (6)
11. Displays the contents of a file or starts an application (5)
13. The command language for Honeywell’s CP-6  operating
system (4)
14. Basic text editor supplied with Microsoft Windows (7)
15. Moving an icon or other image on a display
screen in a GUI (4)
16. Open source NIDS created by Martin Roesch (5)
17. An enlarged photographic print (4,2)
21. Constraint logic programming embedded in an
object-oriented language (7)
22. Sound within the acoustic range available
to humans (5)
23. ----scale- scale of achromatic colours used in television
and photography (4)

DOWN
2. Any device connected to, or part of, a computer (10)
3. Computer Assisted-------- or the use of (personal)
computers for education and training (8)
4. Descriptive formatting codes used in documents
that instruct a web browser how to display text and
graphics (4)
5. Service Oriented Business Applications(abbr) (4)
6. Language in which a web page is written (4)
9. Small pieces of silicon material on which an integrated
circuit is embedded (5)

10. Systems or circuits using valves, transistors, or silicon
chips (10)
12. Magnetic------—material on which information may be
stored by an electromagnetic process (5)
13. The unique name of a person, device or both that is
recognized by a system (8)
18. Octal Program Updating System(abbr) (4)
19. Trademark for a powerful operating system (4)
20. Taiwanese company-third largest computer manufacturer
in the world (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Testing Times...
1. Who is Gene Dolgoff?
a) Started the Human

genome project
b) Michael Dell’s partner
c) Inventor of the LCD projector
d) Was on the board of Microsoft

1

Ray Tomlinson is
credited with

sending the first
official e-mail
message. He started
testing his initial system with
the words “QUERTYIOP” and
“ASDFGHJK”, after which he set
out to demonstrate exchange
of messages over computer
networks in the year 1971.

Did You
Know?

Answers

1. c
2. b
3. c
4.a
5.b

6. b
7. a
8. b
9.a
10.b

Crossword by Nitta Jaggi

Last month’s Winner
No Winner!
Better luck next time!

Send in your entries to
TQ@thinkdigit.com on or by
the 20th of this month. One
lucky participant 
will win 

linux administrator
STREET SMARTS

By Roderick W. Smith
Published by

Win!

May’s Solution



DIGIT JULY 2008 109DIGIT JULY 2008

If you’re referring to the Essentials section in
the CD, it’s there because we have found that
most of us end up formatting and re-
installing quite often, and there are a specific
list of software that we all need immediately
afterwards. The essentials list is software
that Digit feels every Windows user should
have installed, and this is why it repeats on
the CD with the latest versions every month.
As for the rest of the disc contents, we will
try and give you everything you have asked
for in the coming months.

Team Digit

Thanks!
I have been reading Digit for the past 4
years and it’s getting better and better.
I want to inform you that I have got
admission in BCA this month with 298
rank, and I give all the credit to you
guys. Another thing is that some
reader has written you a letter
accusing you for not taking honest
tests. I would like to inform him that I
have been buying products only based
on Digit’s recommendations. I trust you
guys blindly, and everything I have
bought based on your advice has really
worked great. 

I have one complaint: although this
month’s Digit was great and the Jumbo
Fast Tracks even better, the DVD content
was not that great. Like previous years, I
was expecting a blockbuster movie or big
free games. Also, Vista’s Service Pack 1
was corrupted. When I installed it, after 4
hours it threw up and error. When I tried
to copy it, it gave me a “cyclic
redundancy error”. I can’t even download
it because my connection is slow.

Akash Yadav

Congratulations! We’re glad that we were able
to inspire you to get into the tech field, and
wish you all the best for your future. 

If you got a CRC error while copying
contents from the DVD, please write to
help@thinkdigit.com, provide your name,
address and telephone number, state your
problem and we’ll send you a replacement.

As for the movie, we tried to get one, but
the costs associated with it were way too high.
We’re still going to try and get you guys some
blockbusters, as and when we can.

Team Digit

More Q&A Please
I have been a regular “Digitian” for two
years, and this my first letter to you.

Inbox

Destination Dubai
First of all I would like to thank you for
making such an excellent magazine. I am
a 13-year-old reader of your magazine
living in Dubai, UAE. There is some
excellent advice that I get from your
magazine. For example, the 30 Days With
section. I would like to subscribe to your
magazine, but you have no international
subscription offers. I buy it in Dubai for
23 Dirhams, which is approximately Rs
230. I missed the issue with the past
issues and Fast Tracks. Is there a way I can
get it? Again, I thank you for making such
an excellent magazine.

Miqdad Raza Bhurani
Dubai, United Arab Emirates

Unfortunately we have no subscription service
for outside India, but we are working on that.
Licenses and permits to do so take time, but we
will make sure to inform you if we do start such a
service. We also cannot send you our anniversary
issue, but you should keep an eye open for the
December 2008 issue, which should contain all
the past issues of Digit and Fast Track.

Team Digit

Suggestions Galore
These days, almost all techies have a
broadband connection at home, and are
running their own  blogs or sites. Please
give us more things about the Internet,
tutorials about WordPress, maintaining
a server (basics), etc. Also, please
conduct contests in your Web site and
publish the winners in the magazine—
this would encourage more people to
use your site properly, and increase
interactivity.

Also, include more of programming
tips and some sample programs to teach
some of the concepts. Dedicate a section of
the magazine to test our knowledge on
analytical abilities, logical reasoning, etc.
Give us the answers of those questions at
the end of the magazine to correct us.

Please don’t stop the Take a Crack
Section! Also, give us some discounts
every month on some hot gadgets. What I
like most in every Digit issue is its well
structured index page. It really saves me a
lot of time, because I want to try to avoid
games, as far as possible.

Lots of advertisements... thats great.
This shows that you’re number one. I
know the value of Advertisements, as I am
a blogger. I also like the concept of
bundling separate booklets of
advertisements. Digit has taught me to
write in an unbiased fashion. I have also
started concentrating on quality of
articles instead of advertisers, and this has
increased the value of my blog.

Where I stay, at first, only one stall
sold Digit. A few years later, every stall sold
it, but now in 2008, not a single stall in
my area sells it. This is because everyone
in my area has already subscribed! 

When I was in class 12, my teachers
used to ask me how I knew so much about
hardware and the latest technology, and
all I would say is “Digit magazine.” Now I
am in my final year BCA, and I hear that
all those teachers have subscribed to Digit
and are recommending that their
students to subscribe too.

I have only one problem with your
subscription model, the late delivery of
the issues! I wish greater success to Digit
in the coming years. Thanks to all the
members of Digit for the great work.

Satish

That’s a lot of suggestions! Give us a few months
to be able to implement some of them. We
haven’t stopped the Take A Crack section, we’ve
just put it on hold for a bit to see if we can
improve it. However, judging by reader responses
like yours, it’s probably best to re-instate it to its
regular position from the next issue onwards, and
we will. The Jumbo Fast Tracks were a one off for
the anniversary issue, and as you will see the
regular Fast Track is back, but with one major
change—it’s colour from now on. Our apologies
for the tardiness of the delivery.

Team Digit

Update Often
This is my first e-mail to you and I just
wanted to let you know that it’s a hell of
a job that you guys are doing. Digit’s 7th
anniversary issue was terrific, and I was
really impressed by the Fast Tracks paper
quality, and also the contents of the two
DVDs. The ‘Seven Wonders’ story was
brilliant, and I’m waiting for your Tenth
Anniversary—make it the “The Ten Tech-
mandments”. Anyway the test for the
LCDs in the previous issue really helped
me choose one. I’ve been clinging to
Digit for three years now, and you guys
never seem to get old, except for some of
the software on the DVD—I think it
would be a treat if you could provide us
with free versions rather than the
monthly dose of Avast, the same old VLC
player... just a suggestion though. Since
I’m more interested in the DVD and CD,
I’d be more than glad if you could
provide some mobile software in the
next issue. Apart from that, the rest is
just perfect. Thank you once again Digit,
you’re my Tech Bible!

Meren Ozukum
Nagaland

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com
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The June edition was simply great, it
was like a bombshell. The software in
the DVDs was great. The idea of
splitting the Fast Track was better
than splitting the magazine like you
did earlier. I wonder how you guys
guess what the reader wants? The
articles were very nice and
informative as usual...

But I really missed the Q&A
section and the regular contests. I
know you guys tried to fulfil that
need by giving the iPod giveaway
contest and the Fast Track contests,
and even the prizes were far better
than those of regular issues, but I love
the format of old contests as they
tested our knowledge, rather than our
luck. And I would especially like to
congratulate the designers on their
tremendous work in making Digit so
beautiful... My suggestion to you is to
improve the prizes of contests of your
regular issues by providing tech
products and subscriptions.

All in all, your magazine is the
best... keep up the great work.

Anirudh Khanna

As you have probably realised after buying
this month’s issue, the reason we didn’t do
the Q&A section last month and this month
was because we were busy creating a Fast
Track to Troubleshooting Your PC II, which is
basically a very large collection of Q&A.
Hope you’re happy with that!

Team Digit

Where Are The Cell Phones? 
Although my exams are on, I still
can’t part with my Digit! It’s got
everything a tech-hungry person like
me wants. The best part of the
magazine is the Tips & Tricks, and the
A-list sections. Agent001 always does a
praiseworthy job, and his articles are
my favourite.

The first issue that I read had
extensive reviews of the latest cell
phones, but there’s been nothing since. 

That is all, keep up the excellent
work! Cheers Digit!

Ankush Gupta
New Delhi

Keep an eye out for the August 2008 issue
(next month) if you like cell phone reviews!

Team Digit

Seven Up
So its “seven up” for you guys,
and what a welcome! Congrats
fellas. We swear by you even
from this remote part of the
nation (Nagaland). For a guy, who
until three years ago used only MS Paint
on the PC, it’s impossible to describe
what Digit has done for me. Of course, I
still have some complaints.

When I say “remote part of nation,” I
say  that because I celebrated your
seventh anniversary two weeks into this
month, and it spoiled the fun. In
another “marginally” minor issue, I
hated the coloured margins on every
page. I loved the new font spacing
which was much better than the last
anniversary issue—which was really
cramped and unsorted.

I still feel that the magazine lacks the
slick feel of another international
magazine that is available. That
magazine presents the articles in a glossy
iPhone-ish way, and dumbs down the
content. Digit, however, feels plain (yet it
is the most info-taining). For example, PC
World (although a magazine for blondes)
is visually more appealing, and some of
and my ‘tech savvy’ pals buy it for that—I
really pity them. 

No magazine reviews products as
unbiasedly and comprehensively as
Digit. About your DVD, I’d say that its
really confusing to have software
divided between two dics (CD and DVD).
Also your essentials section should
include anti-virus updates. I would
suggest that you convert the CD into an
“Updates” disc.

Can you organise a contest where the
winner gets to go to the famous
“Lamington Road” with Agent001? What
I’d give to go there and see for myself all
the “best buys” (if not buy them). 

The Tech Career articles are very
helpful in creating awareness about
alternate and lesser known career
options. Your writers are certainly
amongst the best and create the perfect
blend of knowledge and fun. Even my
severely tech illiterate sister Chinki loves
to read articles by Nimish and Raaabo,
and of course Digit Diary and Tabloid
Tech. It was a pleasant change to see
proper buying guides this time—unlike
previous anniversaries, this time there
were full blown reviews! I wish you luck
for seventy more years!

Bhupati Baboo
Nagaland

Letter 
of the
Month

June 2008



People And Events That Grabbed The Headlines—For Better Or For Worse

Even the illiterate is
now e-literate! So, why
should celebs not take

a stab at the www? Celeb
blogging is the rage, and
these blogs are keenly fol-
lowed by mass media,
because anything is
“Breaking News” these days.
Aamir, SRK and the Big B
have been in the blogging
circuit for a while now, and
receive thousands of page
hits daily.

Well, however difficult it
may seem to keep their blogs

updated, they manage to do
so with some scuffle with
their schedules. Now it has
become a bit easier, at least
for the Big B. After hosting
his blog site, BigAdda.com
has now introduced Micro
blogging exclusively for AB.

Siddharth Roy, the CEO
of BigAdda.com said that
this new platform will offer
a quicker and more conven-
ient way to blog, and will
help the superstar stay con-
nected with his fans, 24/7,
despite his hectic schedule. 

The Big B’s first post
from his phone was on June
13, and it was just four
words long: “Hello I am
back”. Subsequently, he has
been blogging extensively-
sometimes four times a day.

“Finished rehearsals.
Driving back,” said one post.
“Dinesh Karthik drops in on
set to meet me. The other
day (Vinod) Kambli and
Nikhil Chopra came over.
They and other cricket stars
shoot next door. A delight to
see them,” said another. 

There is, however, a word
constraint, with posts only
as long as an SMS. Not a bad
thing that… the word con-
straint, we mean.

Moblogger!
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Eco friendly technologies
seem to be catching on,
and the royal family has

caught the bug. It wasn’t long
before Prince Charles realised
that there were a number of
bottles of wine lying in his
chalet for ages, and could per-
haps be put to better use. How
many bottles could the Prince
go through anyway?  

He hit upon the novel idea
of using the wine as a fuel to
power his 38-year-old Aston
Martin. The car was a 21st
birthday present from Queen
Elizabeth, and the prince has
converted it to run on 100 per
cent bio-ethanol, as a way to
reduce his carbon emissions.

The biofuels are converted
and provided by Green Fuels
Limited, a British company
that previously provided

biodiesel to power the royal
train. The wine used for the
bioethanol comes from a cur-
rent vintage that remains
after English wine producers
reach the EU limit for annual
wine production.

The prince has also con-
verted his other cars—several
Jaguars, an Audi and a Range
Rover—to run on 100 per cent
biodiesel fuel made from used
cooking oil. Now that’s an eco-
logical commitment!

A Besotted Car!

Even supermodels lose hair! Before all you women out there
start sniggering and pointing fingers, we should tell you

that the hair was fake. 
Moss was in Berlin to promote her perfume Velvet Hour, and

whilst ducking to escape paparazzi, she lost her hair extension.
Photographer John Farr picked it up and posted it on eBay. He
isn’t keeping the money, so all you anti-paparazzi KKK-looka-
likes put down those torches and listen up: the proceeds go to
the German anti-drug charity Keine Macht den Drogen.
However, the auction has only 9 bids, with 56 Euros being the
highest we saw. It’s hard to tell who is most peeved by this: the
charity: at all you miserly Germans smoking pot instead of bid-
ding; Farr: for looking like a fool, making a big deal out of some-
thing and raising a whopping 56 Euros! Or is it Kate Moss? Who
will probably never sleep again, paranoid that the world is for-
getting about her. “56 Euros? Seriously? That’s all I’m worth?”

Hair Loss, Somebody’s Gain
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